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Summary 

Musculoskeletal (MSK) disorders affecting locomotion represent one of the leading causes for 

disability in the developed countries, impacting on the patients’ lifestyle and social inclusion, 

as well as the national healthcare resources. 

Due to the different aetiologies and progression of such diseases, and to the individual needs 

of patients, personalised assessment is currently promoted as the gold standard for the 

diagnosis and treatment of MSK disorders. The introduction of MSK models has recently 

integrated more traditional measurements of gait-related parameters, enabling the 

simulation of clinical scenarios and rehabilitation plans within a computational environment, 

therefore limiting the invasiveness of the experiments. However, the lack of standardised and 

validated procedures currently limits the adoption of these techniques in the clinical practice 

and restricts their shareability across the research community.  

The aim of this PhD thesis was to develop an innovative, robust, and repeatable procedure 

for the definition of MRI-based subject-specific MSKMs of the lower limb. A fully documented 

procedure (and associated methodologies) for producing such models was proposed. The 

final scope of this project is to promote the adoption of personalised modelling in the clinical 

assessment of lower-limb MSK disorders. 

The versatility of the proposed modelling approach was successfully tested by applying it in 

cohorts featured by different age (juvenile and elderly), genders and health conditions 

(juvenile idiopathic arthritis and osteopenia). In particular the model was tested for its ability 

to: discriminate joint kinematics and joint loadings that are typical of different populations; 

identify informative biomechanical parameters to characterise disease and disease 

progression in juvenile idiopathic arthritis; quantify the effect of different physiological 

muscle features, such as volumes and geometry, on the estimate of joint loading. 

As a result of the work carried out as part of the above studies, a significant advance in the 

standardisation and automation of the procedures needed for building fully personalised 

MRI-based models of the MSK system has been achieved. The model outputs were proved to 

have good repeatability and reproducibility and to be informative in all above applications. 

The proposed approach also showed a clear potential toward complementing traditional 
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clinical gait analysis approaches by providing information on the muscle and joint internal 

forces, otherwise not easily accessible in-vivo.  

Future work will aim at reducing the cost, operator time, and errors associated to MRI-based 

MSK modelling by further improving and automating the image processing techniques and 

even replacing the MRI with affordable and portable technologies, such as ultrasound-based 

systems. 
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1. Overview 
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1.1. Introduction 

Musculoskeletal disorders are recognised as one of the first causes for disability in the 

western countries, typically leading to significant pain and joint destruction, and premature 

mortality (Kvien, 2004). For example, worldwide, 10% to 15% of all adults over 60 years of age 

are affected by osteoarthritis, with higher prevalence in women, and The United Nations 

estimate that by 2050 this number will reach the value of 20% due to a growth in population 

and increase in aging (Brennan-Olsen et al., 2017). Other forms of arthritis, such as 

rheumatoid arthritis, are estimated to affect between 0.5 and 1.0% of the adult population 

worldwide. It can develop at any age and therefore most patients require long-life treatment 

to control the progression, or even surgery (Kvien, 2004).  Affecting the mobility and 

locomotion, often causing the inability to work, the social impact of musculoskeletal diseases 

is not negligible and the burden on the healthcare systems is significant (Kvien, 2004).  

The increasing prevalence of these diseases, also associated to longer life expectancy and 

ageing, has raised the interest in individual and specific therapies to help patients with 

customised rehabilitation plans tailored to their lifestyle and activity level (Hedgecoe, 2004, 

Isaacs and Ferraccioli, 2011, Viceconti et al., 2015). Such approaches, of course, require the 

development of more advanced quantitative tools allowing to assess individual cases without 

multiplying the costs in terms of effort and time. In-silico techniques and computational 

methods have therefore been proposed as non-invasive alternatives aiming at reproducing 

virtual patients, or populations of patients, and simulate the effect of different intervention 

plans. The increasing availability of medical data and patients’ information from routine 

examinations is promoting the implementation of these in-silico techniques also in the clinical 

practice other than in the research (Viceconti et al., 2008, Viceconti et al., 2016). 

Locomotion, despite involving extremely complex synchronisation between the neural 

system and the musculoskeletal system and perfect muscles coordination, represents a 

natural and easy task common to animals and humans. Due to the fundamental role of 

walking in everyday life, the biomechanics of human motion has been object of study since 

many years and has become more and more systematic and advanced to enable the 

quantitative understanding of musculoskeletal kinematics and kinetics (Baker, 2007, Whittle, 

1996).  
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Experimental measurements can provide crucial information about the fundamentals of 

human locomotion. For example, gait analysis entails the systematic observation of human 

movement with the support of specific instrumentation, i.e. cameras and sensors, in order to 

measure the mechanics of the body, including kinematics (describing bodies’ motion) and 

kinetics (relating motion to its causes, i.e. forces and torques) (Baker, 2006, Oatis and Craik, 

1994). The external observation of the human motion is then associated to the movement of 

the skeleton thanks to models assuming a rigid relationship between the surface of the body 

and the bones (Lu and O’connor, 1999). This technique finds application in a number of clinical 

settings to support the diagnosis of musculoskeletal alterations, better treatment planning 

and rehabilitation programmes (Gage, 1991, Gage, 1993, Hartmann et al., 2010, Merker et 

al., 2015, Sutherland and Davids, 1993). However, the specific role of the muscle system is 

only partially accounted for in gait analysis, therefore the application is limited to the 

investigation of the joint angles and torques.  A further step is needed if interested in 

understanding the individual contribution of muscles to the generation of these torques and 

the resulting movement. This gap is filled through computational techniques, such as the use 

of musculoskeletal models (MSKMs) who can provide information about those quantities that 

are otherwise not easily accessible experimentally or available in a non-invasive manner (i.e. 

individual muscle forces and forces internal to the joints) (Anderson and Pandy, 1999, Arnold 

et al., 2005, Arnold et al., 2010, Delp et al., 1990).  

The presence of a pathological condition, rising from either skeletal or neurological problems, 

is often the cause for anatomical alterations, such as bone deformities, variations in the 

musculotendon path, or functional impairments, like limited or abnormal joint mobility and 

changes in muscular activity. Especially in these cases, musculoskeletal analysis and modelling 

should aim at developing specific personalised tools for the investigation of the cause-effect 

mechanisms behind these pathologies and the prevention of their progression through the 

planning of individual intervention and rehabilitation programmes (Carbone et al., 2015, 

Hannah et al., 2017, Marra et al., 2015, Montefiori et al., 2019, Prinold et al., 2016). 

Over the past two decades computational modelling techniques have been developed aiming 

at providing the tools and methods for increasing the anatomical resemblance and the model 

personalisation to account for individual characteristics and address specific research/clinical 

questions (Arnold and Delp, 2005, Arnold et al., 2010, Delp et al., 1990). These techniques 
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were found promising in several applications as they have the potential to provide patient-

specific quantifications and predictions to be used in a number of different critical clinical 

scenarios, ranging from orthopaedics (i.e. joint replacement and simulations of intervention 

scenarios) (Delp et al., 1990, Fregly et al., 2012, Steele et al., 2012), to inflammatory (i.e. 

arthritis) (Hannah et al., 2017, Montefiori et al., 2019, Prinold et al., 2016), to neuromotor 

conditions (i.e. cerebral palsy, motor neuron disease, etc. ) (Arnold and Delp, 2005, Thompson 

et al., 1998). However, they are not yet adopted as part of the conventional clinical practice, 

mainly due to the lack of standardised and validated protocols (Hicks et al., 2015) and to the 

costs associated with the procedures. Indeed, the economic factor must be taken into account 

when evaluating the suitability of such a methodology and its application has to be limited to 

those cases that can benefit from the collection of additional anatomical information and 

motion data, i.e. musculoskeletal diseases with associated bone deformities and joint 

misalignments, joint degeneration pathologies, joint replacements.  

Driven by the motivations summarised in the preamble, the overall aim of this PhD thesis was 

that of developing and assessing an innovative, robust, and reliable methodology for the 

definition of MRI-based subject-specific MSKMs of the lower limb in order to foster their 

wider usability and clinical application. Additionally, the personalisation of the MSKMs 

through extracting skeletal and muscular anatomical information from MRI was explored. 

1.2. Thesis outline 

The thesis is divided in eight chapters (Figure 1-1). Chapter 1 presents an overview on the 

topic, setting the framework and the motivation for the study. Chapter 2 defines the 

background, including an introduction to the lower limb anatomy, the basics of 

musculoskeletal modelling and its application, with details on different modelling 

approaches. Chapters 3 to 7 are dedicated to the development and clinical application of MRI-

based personalised MSKMs of the lower limb. More detailly, chapter 3 includes the published 

paper “An image-based kinematic model of the tibiotalar and subtalar joints and its 

application to gait analysis in children with Juvenile Idiopathic Arthritis”, presenting a 

morphology-based semi-automated methodology for producing kinematic MSKMs of the 

ankle and its employment in a clinical scenario, namely Juvenile Idiopathic Arthritis (JIA). 
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Chapter 4 is based on the published paper “Sensitivity of a juvenile subject-specific 

musculoskeletal model of the ankle joint to the variability of operator dependent input”, 

where the repeatability of manually producing patient-specific MSKMs of the ankle is 

assessed. My contribution consisted in the design of the study, implementation of the 

MSKMs, quantification the intra- and inter-operator variability in the input parameters used 

to build the same models, and finally identification of the modelling steps being more 

sensitive to operator error. Chapter 5 describes in brief an optimised and robust pipeline for 

collecting input data and repeatably producing MSKMs presented as additional material to 

the journal publication “Investigation of the dependence of joint contact forces on 

musculotendon parameters using a codified workflow for image-based modelling”. The aim 

of this paper was twofold, with my contribution mainly relating to the second part, i.e. to the 

development of the codified workflow described in the document “Pipeline for building a 

subject-specific MSK model from MRI and motion capture data” (Appendix I of this thesis). 

Chapter 6 is based on the journal publication “Linking joint impairments and gait 

biomechanics in patients with Juvenile Idiopathic Arthritis” where I implemented a lower-limb 

MSKM to investigate alteration of gait biomechanics associated to musculoskeletal 

impairment in a JIA population. Chapter 7 presents a further development of the modelling 

pipeline introducing the MRI-based personalisation of muscle parameters and geometry in 

the context of ageing and elderly population.  This chapter is structured in a publication-like 

fashion as its content is planned to be submitted for publication to the journal IEEE 

Transactions on Biomedical Engineering by October 2019. The last chapter, chapter 8, 

summarises the main findings and contributions to the state of the art gained from the 

current research to draw an overall conclusion of the thesis work and to present a plan for 

future developments. 
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Figure 1-1 – Schematic of the outline of the thesis 
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2.1. Basic concepts 

2.1.1. Anatomical and rotation planes  

The unambiguous definition of movement is crucial to the general understanding and 

discussion of complex motion patterns happening between body parts during human 

locomotion. As the body movements occur in different planes and around different axes, the 

use of a standard terminology avoids confusion. 

Anatomical planes are imaginary planes crossing the body at different levels (Figure 2-1): 

• The sagittal plane runs vertically dividing the body into left and right sides. Flexion and 

extension movement are referred to this plane. 

• The frontal plane divides the body into the front and the back; therefore, abduction 

and adduction movements belong to this plane. 

• The transverse plane cuts the body horizontally into the upper and lower half. 

Rotation movements occur in this plane. 

Additionally, the use of the centre of the body as a reference to identify other anatomical 

parts is commonly used to avoid confusion (Figure 2-1). In fact, we refer to medial (or 

lateral) as we move close (or away) to the centre of the body, we refer to superior (or 

inferior) if we move towards the head (or the feet), we refer to anterior (or posterior) if 

we move towards the front (or the back) of the body. Finally, we define as proximal (or 

distal) the extremity of a body part (i.e. long bones) that is towards (or away) from the 

centre of body. 
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Figure 2-1 – Anatomical planes and terminology 

2.1.2. The lower-limb musculoskeletal system 

In this context, I will refer to the musculoskeletal system as the complex including both the 

skeleton and skeletal muscles. The former, comprehending the bones and the cartilage 

covering the articulating portions of the bone extremity, gives support to the body and 

creates a protective structure for the underlying organs; the latter represents the actuator of 

the body movements. 

The bones of the lower limb 

The main bones of the lower limb are pelvis, including the ilium and sacrum, femur in the 

upper leg, and patella, tibia and fibula in the lower leg (Figure 2-2). The bones forming the 

foot are talus, calcaneus, cuneiforms, cuboid, navicular, metatarsals and phalanges (Gray, 

1918).  

The femur is a long bone, the longest of the body, whose proximal extremity is characterized 

by a spherical head, which articulates with the acetabulum of the pelvis, forming the hip joint. 

The femur head is connected to an upper lateral tuberosity, called great trochanter, by means 

of the femur neck. On the posterior-medial aspect of the bone shaft, a smaller tuberosity is 

projected medially, namely the lesser trochanter. These tuberosities, as most of the 

tuberosities in the lower-limb bones, represents the areas where muscles attach. The distal 
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portion of the femur presents two condyles, the medial and the lateral, forming the knee joint 

together with the tibia and the patella.  

The tibia has a proximal flat surface, known as the tibial plateau, and extends distally to its 

end where an expansion, the tibial dome, takes part into the ankle joint. Parallel to the tibia, 

the fibula is a much thinner long bone that presents two heads, one at each extremity, where 

ligaments and tendons attach to give stability to both the knee and ankle joints. In their distal 

portion both tibia and fibula present a bony tuberosity projected inferiorly on the medial and 

lateral side, respectively, called malleoli.  

The bones composing the foot are usually twenty-six, although anatomical variants exist. The 

tarsal bones are seven irregularly shaped bones located proximally and mostly involved in the 

ankle motion. The talus is primarily involved in the articulation with tibia and fibula; the 

calcaneus, below the talus, presents a posterior aspect where the calf muscles attach. The 

metatarsals, which are five long bones and connect the tarsals to the phalanges, namely the 

bones of the toes. Connected in a complex pattern of articulating surfaces, the foot bones 

give stability to the segment supporting the body weight and their flexible structure absorbs 

the impact when hitting the ground during walking.  

 

Figure 2-2 - The main bones of the lower limb 
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The joints of the lower limb 

The joints are the links between bony segments of our body. In the lower limb, several joints 

exist, with the most important being the hip, the knee and the ankle. These joints enable the 

movement, allowing rotations and/or translations in those directions representing their 

degrees of freedom (DoFs) (Gray, 1918). Together with the ligaments, they represent a 

constraint to the free movement of the lower-limb segments and are classified as hinge, 

ellipsoid, or ball-and-socket, allowing for uniaxial, bi-axial, or three-axial rotations, 

respectively (Figure 2-3). 

The hip is a ball-and-socket joint where pelvis and femur articulate thanks to the contacting 

surfaces of the pelvis acetabulum (a cup-like hollow on the inferolateral aspect of the pelvis) 

and femur head, which fits completely into the cavity of the acetabulum. The hip serves 

primarily as a weight-bearing joint and allows flexion/extension, abduction/adduction, and 

internal/external rotations.  

The knee joint is a bicondylar joint consisting of two articulations, the tibiofemoral (where the 

medial and lateral condyles articulate with the tibia), and the patellofemoral (where the 

femur articulates with the patella). The tibiofemoral joint is responsible for weight-bearing 

and its motion is particularly complex. In fact, despite a main flexion/extension component, 

it also allows for small abduction/adduction, internal/external rotations, and translations 

along the three anatomical axes.  

The ankle joint, also known as tibiotalar joint, articulates between tibia and fibula and the 

talus. It mainly allows for plantar/dorsiflexion of the foot. A further important joint articulates 

between the talus and the calcaneus, the subtalar joint, being involved in the 

inversion/eversion of the foot. A series of other joints between the small bones of the foot 

allows smooth movements and stability within the hind-, mid-, and forefoot.  
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Figure 2-3 – Schematic representation of ball-and socket (left), ellipsoid (middle), and hinge 
(right) ideal joints (adapted from Maik et al. (2010)). 

The muscles of the lower limb 

The skeletal muscles are responsible for the movement of the body by acting on the bone 

through their tendinous connections. When contracting, the muscles shorten the length of 

their fibres and pull adjacent body segment close to each other or release them when the 

fibres relax (Huxley, 1974). 

The muscles of the lower limb can be divided into clusters or groups. From proximal to distal, 

the first muscle group is the glutei, localised posterior to the pelvis. Their origin is in the ilium, 

the uppermost and largest part of the pelvis, and their insertion is on the femur. They give 

stability to the hip joint and are involved in the actuation of the hip movements: abduction, 

extension, and rotation. The glutei muscles are composed of three subgroups, namely the 

gluteus maximum, medius, and minimus. Other small muscles contribute to the hip 

movement, i.e. the piriformis, the gemellus, and the quadratus femoris, all located deeper in 

the lower region of the ilium. Moving distally, in the anterior compartment, the main muscles 

of the tight are the pectineus, the sartorius and the quadriceps femoris, who constitute one 

of the most powerful group in the body. The pectineus contributes to the adduction and 

flexion of the hip; the sartorius to the abduction, extension, and rotation of the hip, and to 

the flexion of the knee; the quadriceps femoris to the extension of the knee and the 

stabilization of the patella. In the medial compartment of the thigh, the gracilis, obturator 

externus, adductor brevis, adductor longus and adductor magnus together contribute to the 

hip adduction. The posterior compartment includes the biceps femoris, the semitendinosus 

and the semimembranosus, also known as hamstrings, acting to extend the hip and to flex 

the knee.  
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The lower leg has its main bulk in the posterior compartment, where the gastrocnemius, 

soleus, and posterior tibialis compose the calf complex, responsible for the plantarflexion of 

the ankle. The anterior part has the tibialis anterior, extensor digitorum longus, extensor 

hallucis longus and peroneus muscles, acting to dorsiflex the foot. The lower leg muscles have 

also a role in the inversion/eversion of the foot.  

In the foot, a group of extensors, which contribute to raise the toes in the first phase of the 

step forward, and a group of flexors, which help stabilize the toes when contacting the 

ground, play a major role.   

2.2. Input data for musculoskeletal modelling 

To be able to produce a musculoskeletal model (MSKM), input data must be collected, i.e. 

information about the anatomy of the subject and her/his locomotion pattern. The 

acquisition of the former is achieved in a variety of manners, ranging from very basic (i.e. 

pictures, height, mass, body segment lengths) to more advanced levels of detail (i.e. medical 

imaging); the latter can be done through instrumented gait analysis.  

2.2.1. Magnetic resonance imaging 

Magnetic resonance imaging (MRI) is an imaging technique that uses strong magnetic fields 

and radio frequency (RF) waves to scan the human body and image the different internal 

tissues. A patient is placed on the MRI bed and surrounded by a uniform magnetic field. A 

source signal generated from the RF coil is transmitted thought the patient’s body to excite 

the protons contained in the water molecules of the body. These hydrogen atoms respond to 

the excitation emitting a RF signal received at the level of the receiving coil.  

Different tissues require different time to return to their original state after excitation. This is 

called relaxation time and its measure allows to discriminate between the tissues of the body 

(Bloch, 1946). If we are interested in the time that protons' spins need to realign with the 

main magnetic field (B0) after put into the transverse plane (longitudinal relaxation), we will 

be acquiring a T1-weighted MRI, otherwise, if interested in the time for the hydrogen dipoles 

to progressively diphase (spin-spin relaxation), we will be collecting T2-weighted MRI (Figure 
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2-4). The former shows bright fat tissue (low relaxation time) and dark bone tissue, water, 

and air (high relaxation time); the latter, associated to the percentage content of water in the 

tissue, exhibits brighter colours when the tissue contains more water (namely when the 

relaxation time is high). 

 

Figure 2-4 – Relaxation curves: T1 relaxation (left) is the process by which the longitudinal 
magnetiztion (Mz) returns to its initial maximum value (M0); T2 relaxaiton (right) is the process 

by which the transverse magnetiztion (Mxy) decays. 

Besides its utility in diagnostic and treatment planning, MRI is used in musculoskeletal 

modelling with the purpose of gaining information about the subject’s anatomy. 

Musculoskeletal imaging focuses on the visualisation of bone and muscle tissue, and less 

frequently of tendons, ligaments and cartilage. It is particularly useful in imaging the soft 

tissue but has been adopted for visualising bones as well, as an alternative to the more 

invasive, due to ionising radiation, Computed tomography (CT) technique. The flexibility of 

the MRI, with its T1- and T2-weighing options allows to optimise the image contrast/grey scale 

to the specific tissue of interest, or to find the best compromise for imaging more tissues as 

the same time. In particular, the 3D geometry of the different tissues can be extracted via 

image segmentation techniques. 

Image segmentation 

Image segmentation is a technique used to process medical images in order to extract the 3D 

shape of the various anatomical structures forming the body, i.e. bones, muscles, ligaments, 

etc..., (Figure 2-5). It can be either manual, semi-automatic, or automatic. The former entails 

manually drawing the contour of the region/tissue/organ of interest on a 2D cross-section of 

the object visible on a single image slice. This procedure is obviously dependent on the ability 

and expertise of the operator performing the manual drawing, and potentially affected by the 

poor image quality. However, it is considered the gold standard when pathology-related 
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abnormal anatomical structures impede the use of automatic algorithm to identify the 

different structures.  

A 3D object is then reconstructed interpolating the 2D segmentations on the different image 

slices. Mesh-processing algorithms, such as smoothing and repairing filters, can be used to 

improve the visual quality of the object.   

 

Figure 2-5 – Example of segmentation of the muscles of the lower limb form different views: 
transverse (top left), sagittal (top right), frontal (bottom right), and 3D perspective (bottom left).  

2.2.2. Marker-based gait analysis  

Gait analysis provides a quantitative investigation of several aspects of human locomotion, 

from spatio-temporal parameters, such as step length, width, speed, to kinematic 

information, i.e. joint angles, to kinetic quantities, like the force exchanged with the ground 

(ground reaction force, GRF) and the moments generated at the joints (Oatis and Craik, 1994, 

Whittle, 1996). 

The analysis of healthy gait has improved understanding of the biomechanical and 

physiological mechanisms behind locomotion and set the basis for the application of gait 

analysis in pathological scenarios. In this context it supports the identification of movement-

related problems, such as alterations in the biomechanics of walking, or impairments being 

cause or effect of musculoskeletal diseases. Clinical gait analysis allows diagnoses and is used 

in clinical practice to assess, plan, and treat individuals with conditions affecting their ability 

to walk (Baker, 2006).   
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A typical gait analysis laboratory (Figure 2-6) has several cameras (video and/or infrared) 

placed around a walkway and connected to an acquisition system. The minimum number of 

cameras for acquiring 3D information from the lab is three, however a higher number is 

recommended to increase the resolution of the data. The lab floor is usually equipped with 

force platforms, synchronised with the motion capture system and embedded in the ground, 

used to measure the GRF. In order to acquire walking trials from a subject, reflective markers 

are placed on the subject’s body segments, according to the marker placement protocol 

chosen for the specific application (Figure 2-7).  

 

Figure 2-6 - Gait analysis laboratory (http://www.qualisys.com) 

The marker placement is a very delicate task, requiring the lab technician to accurately 

palpate points on the skin in correspondence to meaningful anatomical bony landmarks. The 

operator-dependency implies that the procedure is likely to introduce errors and 

uncertainties, therefore the operator ability and experience is crucial to the success of the 

marker placement (Baker, 2006, Whittle, 1996). Additionally, the markers’ position is 

susceptible to soft tissue artefact due to the presence of a layer of skin which impedes to 

rigidly fixing the markers to the underlying bone and introduces a relative movement 

between the two (Baker, 2006).  

http://www/#.qualisys.com
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Figure 2-7 – Example of full-body marker placement (Plug-in Gait) and corresponding skeletal 
model with highlighted body segments and joints. Adapted from Plug-in Gait Reference Guide 

(Vicon Motion System, Oxford, UK) 

During the acquisition of a trial, the subject walks back and forth along a straight walkway in 

the centre of the lab, where the cameras can track the location of each marker (see colourful 

dots in Figure 2-8, top). Additional dedicated tasks can be acquired, i.e. joint flexion/extension 

movements aiming at more accurately identify the relative orientation of the various body 

segments and the functional centre of the joints (Besier et al., 2003, Donnelly et al., 2012). If 

the lab is equipped with force plates, the external forces (i.e. GRF) are simultaneously 

collected (Figure 2-8, middle) during the trials and used for a complete dynamic description 

of the system. Electromyography (EMG) signals (Figure 2-8, bottom) can also be acquired 

thanks to the placement of EMG transducers on the surface of the skin, in correspondence to 

the belly of certain superficial muscles (Whittle, 1996).  
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Figure 2-8 – Example of data collected during a gait analysis session. (top) Perspective of the 
walking showing the markers on the various segments of the lower limbs, with highlighted 

trajectories of the pelvis markers (red), and ground reaction force (GRF, yellow vector) measured 
by the force plates. (middle) Analog graphs showing the magnitude of the three components of the 

GRF. (bottom) Signals recorded by the electromyography sensors.  

2.3. Musculoskeletal models and simulations 

Among all the possible parallels between the human body and a mechanical system, the 

perspective of human movement analysis is that of comparing the musculoskeletal complex 

to a multibody structure, including segments linked through joints, and moving one relative 

to the others. The framework in which multibody MSKMs are adopted denotes the complexity 

of their representation. 

2.3.1. Skeletal models 

Simple 2D inverted pendulum, either single and double, can be implemented for 

understanding the dynamic equations of walking (Pandy, 2003). Other planar systems with 

limited DoFs can be implemented to explore the rational mechanics behind the locomotion 

and interaction of the model with the environment (Kuo, 2007). For these applications, a non-

muscular model is preferred, as it simplifies the understanding of the relationship between 

cause and effect of motion (Pandy, 2003). If the purpose of the investigation is to fully 
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characterise the motion of the different parts of the lower-limb multibody system, joint 

angles and segmental orientations are to be estimated by solving the motion of a skeletal 

model through the solution of Direct Kinematics (DK) or Inverse Kinematics (IK) problems. Lu 

and O’connor (1999) highlight how the former treats each body segment independently 

without imposing constraints to the joints, whereas the latter describes the various joints 

connecting the links as ideal joints, whose degree of complexity and resemblance is dictated 

by the level of detail of the analysis. In simple 2D models of the lower limb, pin joints are used 

to describe planar rotations of the segments with respect to each other, whereas in 3D 

representation ideal hinges, ball-and-socket, ellipsoid, or more elaborate joints might be 

implemented.  

The definition of joint’s axes of rotation in MSKMs generally follows the recommendation 

proposed by the International Society of Biomechanics (ISB) standards (Wu et al., 2002), or 

other alternative proposals, and is typically based on one of the following approaches:  

• Manual/virtual palpation (Figure 2-9): the identification of meaningful anatomical 

landmarks on the skin (or on the bone surface, if medical imaging is available) of the 

subject in proximity of the joint (Van Alsenoy et al., 2014, van Sint Jan, 2007).  

• Functional method: identifies the joint centre as the centre of rotation of the distal 

segment relative to the distal segment while performing a prescribed movement 

recorded by motion capture cameras (Camomilla et al., 2006). The axes of rotation of 

a joint can be identified through dynamic optimisation algorithms based on the 

minimisation of the squared differences between the model estimated motion and 

the measured motion (Leitch et al., 2010, van den Bogert et al., 1994) 

• Morphologic fitting (Figure 2-9): the alignment of analytical shapes, representing the 

ideal joint to model (i.e. cylinder for hinges or sphere for ball-and-sockets), to the 

articular region of interest, with the intent of fitting the shape’s surface to the bony 

surface (Ding et al., 2019, Prinold et al., 2016). 

With respect to this, a debate is still open in the literature concerning the best approach to 

model the axes of the ankle. This is explained by the fact that the ankle presents multiple 

anatomical structures and bones articulating between each other. The main joints of the ankle 
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are the tibiotalar and the subtalar, constraining the movement between tibia and talus (the 

former) and talus and calcaneus (the latter) (Isman et al., 1969). The complexity of the 

structure, and associated movements, challenges the research to understand which 

modelling approach can better perform in investigating the biomechanics of the ankle. 

Besides this, an accurate measure of the in-vivo kinematics and kinetics of the tibiotalar and 

subtalar joints is limited by inadequate instrumentations (Di Marco et al., 2016, Nichols et al., 

2017, Westblad et al., 2002) and costly or invasive experimental protocols (i.e. fluoroscopy or 

intracortical bone pins). This considered, a simple approach to the ankle modelling, where 

tibiotalar and subtalar joints are schematised as idealised hinges, is often preferred and 

widely adopted in modelling (Arnold et al., 2010, Delp et al., 1990, Dul and Johnson, 1985, 

Modenese et al., 2018, Montefiori et al., 2019, Siegler et al., 1988). The tibiotalar axis of 

rotation is commonly associated to the axis connecting the lateral and medial malleoli (Wu et 

al., 2002), often relaying on the position of gait markers in order to locate these anatomical 

points. In this proposal, the tibiotalar joint origins in the inter-malleolar point (midway 

between the tips of the lateral and medial malleoli, LM and MM, respectively) and the 

rotational axis is that connecting LM and MM (Figure 2-9).  

Alternatively, the tibiotalar axis can be derived from fitting of the talar dome with a cylindrical 

shape (Hannah et al., 2017, Prinold et al., 2016) aiming at identifying the axis and centre of 

rotation of the joint as that of the cylinder (Figure 2-9). This procedure is performed manually 

and, although accounting for the individual morphology of the talus, is still unreliable as 

dependent on the judgement and ability of the operator. The subtalar joint is often neglected, 

or scaled from generic models (Arnold et al., 2010, Delp et al., 1990)  where this axis has been 

identified on an average geometry, derived from cadaveric data, on the basis of functional 

anatomy indications (Isman et al., 1969). In other cases the flexion/extension and 

inversion/eversion components of the ankle are coupled together in a ball-and-socket joint, 

centred in the correspondence to the inter-malleolar point (Ding et al., 2019). 
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Figure 2-9 – Definition of the tibiotalar joint according to anatomical landmarks (i.e. the lateral 
and medial malleoli, LM and MM, respectively, red) and manual fitting of a cylinder to the talar 

dome (blue) and comparison of the two methods. 

2.3.2. Muscular models 

When exploring the forces within the bodies of the lower-limb chain, or when interested in 

the contribution of individual muscles to actuate the locomotion, the model needs to carry 

information on the inertial properties of the segments and a geometrical and architectural 

description of the musculotendon unit, namely a representation of the muscle structure at 

the fibre/molecule level. 

Musculotendon unit 

Musculotendon units represent the skeletal muscles and their function of actuating the 

movement producing force. In MSKMs, they are schematised as straight lines, connecting two 

attachment points, the origin and the insertion, or turning around the joints by means of via 

points. This schematisation is considered acceptable for fusiform muscles, however, larger 

muscles with wide attachment area may be split into multiple bundles with different origins 

or insertions Figure 2-10. These bundles can contribute to different movement directions. 

Assuming that this representation of the muscles provides a good approximation of their 

geometry, the description of their behaviour requires the introduction of a number of 

parameters, i.e. mechanical elements, that mimic the force-generating capacity of the system 

(Yamaguchi, 2005). 
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Figure 2-10 – Representation of the Gluteus maximum large muscle belly and attachment region 
by means of three bundles connecting three origin points to three insertion points and passing 

through one via point each.  

Muscles are composed by many muscle tissues organised in fibres. The elemental part or 

these fibres is the sarcomere, where myosin and actin proteins bridge together during the 

muscle contraction and causing the shortening of the fibres. This process is regulated by 

electric and chemical stimuli from the central neural control involving the brain and the motor 

neuron. Given its complexity, a realistic representation of these complex mechanisms is still 

far-off being available for integration in MSKMs. However, in the 20th century researchers 

began to produce simplified muscle models, including a representation of the different 

molecular structures composing the sarcomeres, under the hypothesis of isolated fibres 

under prolonged maximal stimulation (tetanic contraction). The most commonly adopted 

model is that proposed by Hill (Hill, 1938) where the muscle sarcomere is schematised as 

series between a passive elastic serial element (SE), representing the tendon, and a parallel 

between an active contractile element (CE) and a passive damping element (DE), representing 

the viscoelasticity of the structure (Figure 2-11). 
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Figure 2-11 – (top) Hill-type representation of the musculotendon unit adapted from Thelen 
(2003) including the active contractile element (CE) and the two passive elastic elements, DE and 

SE. (a) Description of the active (and passive) force-length relationship of muscles; (b) Force-
velocity relationship curve presented as a function of the muscle activation; (c) Passive tendon 

force increasing with strain. 

The overall description of the muscle force relies on the definition of three curves (Arnold et 

al., 2013): the active and passive normalised force-length relationship of the muscle fibre, 

suggesting that there is an optimal fibre length at which the muscle can produce maximal 

isometric force; the normalised force-velocity relationship, adding a dynamic connotation to 

the system and showing that when the muscle reaches its maximum shortening velocity, the 

capacity of generating force is minimal, and progressively increased up to a maximum when 

maximally elongated (Zajac, 1989); the normalised force-length relationship of the tendon. 

To integrate this system in MSKMs, the following essential parameters need to be defined 

(Zajac, 1989):  

• maximal isometric force of a muscle;  

• optimal fibre length; 

• the tendon slack length;  

• pennation angle; 

• contraction velocity. 
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The concept of maximal isometric force is linked to the geometry of the muscle, in fact it is 

proportional to the physiological cross-sectional area, (namely the cross-section of the muscle 

perpendicular to the fibres) and represents the maximal force that a muscle can generate in 

isometric conditions (namely without changing its length during contraction) (Sacks and Roy, 

1982). The optimal fibre length is the length at which fibres can exert the maximal force in 

isometric conditions. The tendon slack length is the resting length of the tendon; the 

pennation angle is the angle between the tendon and the muscle fibres at optimal fibre 

length; the maximum contraction velocity is the maximum velocity at which fibres can 

contract. 

2.3.3. Scaled-generic and subject-specific musculoskeletal 

models 

In this thesis MSKMs are intended as computational tools adopted for the simulation of 

locomotion. Several MSKMs are available in the literature, from full-body to lower-limb to 

shoulder models (Arnold et al., 2010, Damsgaard et al., 2006, Delp et al., 1990, Holzbaur et 

al., 2005). The majority of these models, so called “generic”, are the result of averaged 

anatomical and anthropometric measurements on cadavers or ex-vivo samples.  

The development of musculoskeletal modelling benefited from the advances in the fields of 

biomechanics, physiology, anatomy, but also from the progress in computer science 

promoting the advent of several commercial and open-source software packages, like 

Anybody (Damsgaard et al., 2006) and OpenSim (Figure 2-12) (Delp et al., 2007), employed 

for solving the complex equations of motion of the multibody systems.  

OpenSim is widely adopted among the researchers in the field of musculoskeletal modelling 

and computational biomechanics as it is open-source and represents a state-of-the art tool in 

multibody dynamics and simulations, as described in Section 2.3.4. Additionally it comes with 

a detailed documentation and examples/tutorials are available through the platform SimTK 

(https://simtk-confluence.stanford.edu), together with a database of generic MSKMs being 

published in the past thirty years. This data repository and exchange made available to science 

and industry promotes circulation of the models and tools and their adoption into clinical 

practice.  

https://simtk-confluence.stanford.edu/
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Figure 2-12 - OpenSim environment and generic model “gait2392” (https://simtk-
confluence.stanford.edu). 

Scaled models are generic MSKMs whose segments’ dimension (such as bones and muscles 

lengths) has been scaled to match the real anthropometry of the subject to be modelled. The 

procedure to scale a model requires the use of so-called “scaling factors” which represent the 

ratio between measurements in the models and in the body of the subject. In fact, to get the 

scaled size (Si
SM) of a segment i of the model, its dimension before scaling (Si

M) is to be 

multiplied by the ratio between a certain measure (Mi
S), taken on the subject, and 

representative of the segment, and a measure (Mi
M), taken on the original model before 

scaling,  representative of the same segment, according to the following equation: 

𝑆𝑖
𝑆𝑀 = 𝑆𝑖

𝑀 ∗
𝑀𝑖

𝑆

𝑀𝑖
𝑀

 

The measures (Mi
S and Mi

M) can be estimated in various fashions, i.e. using anthropometric 

measurements, referred to easily identifiable bony landmarks in the body, or using the 

distance between couples of gait markers placed both on the subject (during the 

experimental acquisition) and on the model (virtually palpated in the locations corresponding 

to the experimental markers). These operations are usually carried out using data from a 

static collection where the subject is asked to stand still in neutral position. The result of the 

scaling is a model, so called “scaled-generic” whose size matches the size of the subject for 

whom experimental data were collected. The scaled-generic model is therefore a copy of the 
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original model with increased or reduced (depending on the scaling factors) segments’ size 

and updated muscle geometry and length-dependent musculotendon parameters (i.e. 

optimal fibre length and tendon slack length), according to the new dimension. Additionally, 

a list of “residual errors”, for each couple of markers included in the scaling, gives a 

quantification of the success of the procedure. The lower the residual error, the better the 

registration of the virtual markers onto the experimental markers in the standing position.  

The OpenSim scaling tool also allows the scaling of the masses and inertial parameters. The 

scaled mass (mi
SM) of each segment i is obtained by multiplying the mass of each segment 

(mi
M) of the model by the ratio between the mass of the subject (mS) and the mass of the 

model (mM): 

𝑚𝑖
𝑆𝑀 = 𝑚𝑖

𝑀 ∗
𝑚𝑆

𝑚𝑀
 

Muscle maximal isometric force is not scaled within the tool; therefore, a further step of 

scaling should be performed outside OpenSim, i.e. in MATLAB (The MathWorks, Inc., USA). 

Various scaling approaches have been proposed in the literature for this parameter, either 

based on the ratio between subject and model mass (Modenese et al., 2018) or its powers 

(van der Krogt et al., 2016), or introducing more complicated scaling factors including subject 

height (Steele et al., 2012b) or individual musculotendon lengths (Correa and Pandy, 2011). 

The accuracy of scaled-generic models is being increasingly questioned, since it unavoidably 

introduces errors and uncertainties due to the assumptions made on the geometry and 

morphology of the bony structures. In fact, scaled models neglect any natural variability or 

pathology-related alterations in the anatomy of the subject. Scaling can therefore affect the 

kinematic and kinetic output of the model simulations, as the definition of the joint axes 

depends on this step.  Furthermore, even small uncertainties in the description of the 

musculotendon geometry can have a substantial impact on the estimate of muscle forces and 

joint internal forces calculated between adjacent body segments (Ackland et al., 2012, Bahl 

et al., 2019, Scheys et al., 2011, Scheys et al., 2008). 

Aiming at improving the accuracy and reliability of the models, an alternative to scaled-

generic models is subject-specific models, where medical data from a specific individual are 

used to gain a better representation of the anatomy and anthropometry. In this context 



47 
 

medical images, such as MRI and CT, are collected and registered to motion capture data 

thanks to the use of visible markers present in both data acquisitions. However, considering 

the burden of medical imaging on the health service and on the patients, their application is 

often limited to those cases where a higher level of anatomical accuracy is beneficial, i.e. 

pathological scenarios or musculoskeletal alterations. On the contrary, when interested in the 

locomotion of healthy, able subjects, then scaled-generic models may suffice. 

In fact, whereas healthy subjects often share common anatomical features (except for 

differences due to sex, age and ethnicity), pathologic subjects can exhibit bone deformities 

and joint misalignments, affecting the movement and the flexibility, and causing altered 

locomotion. Personalisation of the models from medical imaging allows to account for these 

alterations. In particular, although CT scans represent the gold standard for imaging the 

bones, MRI ensures a good visualisation of both bone and soft tissue (i.e. muscles and 

tendons, ligaments, cartilage) with a lower level of invasiveness for the subject. 

2.3.4. Musculoskeletal simulations 

Inverse kinematics 

Kinematics is the branch of mechanics related to the study of movement in terms of 

trajectories, angles and velocities of bodies or segments of a multibody system. In human 

motion analysis, segmental kinematics aims at reconstructing the movement of single bodies 

within the musculoskeletal chain during the execution of a motor task, which can be walking, 

running, jumping, etc...  

When the geometry of the system is known, the position and orientation of the various 

segments can be identified by tracking the trajectories of the skin markers located onto the 

different body segments at each time frame. The relative movement (i.e. rotations and 

translations) between two adjacent segments of the chain is estimated through inverse 

kinematics, under the assumption that the bodies are rigid, therefore neglecting any 

deformation. Inverse kinematics is based on the concept of global optimisation, first proposed 

by Lu & O’connor in 1999, that minimises the difference between the location of the virtual 

(on the model) and experimental (on the subject) markers. This approach allows to minimise 

the global error reducing the sensitivity of the system to experimental errors due to skin 
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movement artefact (Lu and O’connor, 1999), improving the model estimates with respect to 

the direct kinematic method. The optimisation algorithm allows to identify the generalised 

coordinates describing the position and orientation of the segments of the musculoskeletal 

chain, under the assumption that the joints are mechanically constrained by idealised joints. 

In fact, an accurate definition of the joints is required, to limit their DoFs to a subset of 

rotations and translations, avoiding displacements and co-penetrations between segments 

(Lu and O’connor, 1999). 

Inverse dynamics 

Dynamics is the branch of mechanics interested in investigating what causes the movement, 

namely forces. Therefore, the inertial properties of the multibody system, neglected during 

the inverse kinematics, should be accounted in this step. The output of the inverse kinematics 

step, namely the generalised coordinates of the joints in time, are here integrated to extract 

the generalised velocities and accelerations. These quantities, together with the external 

forces acting on the system (the GRF collected by the force platforms in the case of gait 

analysis), are the input to estimate the net torques about the joints for each instant of time. 

The Newton-Euler equation (Eq. 2.3.4.1) of motion is recursively solved for each body 

segment, from distal to proximal, to compute the joint torques (i.e. the net forces and net 

moments): 

 𝑀(𝑞⃗)𝑞⃗̈ + 𝐶(𝑞⃗, 𝑞⃗̇)  +  𝐺⃗(𝑞⃗)  +  𝐸⃗⃗(𝑞⃗, 𝑞⃗̇)  =  𝜏 (2.3.4.2) 

 

where 𝑞⃗(𝑡), 𝑞⃗̇(𝑡), and 𝑞⃗̈(𝑡) are the generalised angular positions, velocities, and accelerations 

of the joints; 𝑀(𝑞⃗) is the matrix of the masses in the system, 𝐶(𝑞⃗, 𝑞⃗̇) represents the 

centrifugal and Coriolis forces and torques, 𝐺⃗(𝑞⃗) is the gravitational component, 

𝐸⃗⃗(𝑞⃗, 𝑞⃗̇) contains the external forces, and 𝜏 is the unknown vector of forces and moments 

acting at the generalized coordinates. These forces and moments include the residuals acting 

on the most proximal segment of the musculoskeletal chain to compensate for the 

inconsistency between the acceleration computed at the various joints and the external 

forces measured by the force plates, and also for the forces and moments due to the body 

segments ignored in the system (i.e. the upper body when studying the lower limb).  
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Static optimisation 

As muscles are the actuators responsible for generating the torques at the joints, static 

optimisation is used to further extend the inverse dynamic approach to the calculation of the 

individual muscle forces contributing to the total joint moments. The estimate of the muscle 

forces represents one of the biggest challenges of musculoskeletal modelling, due to the 

complexity of the system constituted by a redundant number of actuators synergically 

contributing to the movement. This implies that for each estimated joint torque, there are 

multiple combinations of muscle activations and forces representing a possible solution of 

the equations. To solve the problem, the musculotendon properties (chapter 2.3.2) must be 

considered, as well as the activation-contraction dynamics of the unit, describing the 

dependency between the force generated within the muscle fibre and its length and 

contracting velocity. 

Static optimisation relies on the formulation of cost functions to minimise certain 

performance criterion, i.e. the muscle force, activation, energy, metabolic consumption 

(Anderson and Pandy, 2001, Crowninshield, 1978, Crowninshield and Brand, 1981, 

Rasmussen et al., 2001), in order to solve the redundancy problem and provide a unique 

solution that satisfies both the cost function minimisation and the relations: 

 
𝜏  = 𝑅(𝑞⃗)𝐹⃗

0⃗⃗ ≤  𝐹⃗  ≤  𝐹⃗𝑚𝑎𝑥

 (2.3.4.3) 

 

where 𝑅(𝑞⃗) is the matrix of the moment arms (i.e. the perpendicular distances from the line 

of action of a muscle to the center of rotation of the joints the muscle is crossing), 𝐹⃗ is the 

vector of muscle forces, and  𝐹⃗𝑚𝑎𝑥  is the vector of maximal muscle forces according to the 

musculotendon dynamics relationship. A common choice for the cost function, also 

implemented in OpenSim, is the minimisation of the sum of the muscle activations squared: 

 𝐽(𝐹⃗)  = ∑ (
𝐹𝑖
⃗⃗⃗

 𝐹⃗𝑚𝑎𝑥,𝑖

)

2𝑛

𝑖=1

 (2.3.4.4) 

 

where n is the number of muscles in the system. 
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Static optimisation solves the equations using a quasi-static approach, therefore there is no 

integration between subsequent instance in time, allowing for the solver to quickly reach a 

solution.  

Joint reaction analysis 

When interested in understanding and quantifying the forces acting on the articular surface 

of the bones, the Joint Reaction Analysis Tool, first proposed by Steele et al. (2012a), can be 

of help. This tool allows to estimate the so-called joint contact forces (JCFs), assumed acting 

at the joint centre, and calculated solving each segment free body diagram, from distal to 

proximal, including the external forces (i.e. GRF) acting on the system, the inertial forces, and 

the muscle forces. On the adjacent proximal segment, the distal contact force is equal and 

opposite to the one previously calculated on the distal segment. In such a way, all the reaction 

forces can be calculated iteratively, up to the most proximal segment of the chain. 

2.3.5. Limitations of subject-specific musculoskeletal modelling 

The lack of standardised methods and validated procedures still represents a limitation in the 

adoption of MRI-based MSKMs in the clinical practice. In fact, the implementation of such 

models is still highly dependent on the quality of the data collections: experimental 

procedures can represent a significant source of errors and incomplete data (due to either 

availability of the patients, technical limitations, or human errors) often impede the full 

exploitation of the modelling potential.  

As a rule, modellers should be aware of the uncertainty related to input data and ensure to 

limit the sensitivity of the model’s output to such error. In this sense, further errors associated 

to the model definition (including model simplification and assumption) or operator-

dependent procedures should be quantified and minimised, when possible. In order to 

achieve this, models should be tested for repeatability and reproducibility. This would provide 

robust protocols and promote the adoption of unified techniques, facilitating inter-laboratory 

comparisons of the results. When input errors exist, an acceptable model 

repeatability/reproducibility should be set in order to guarantee that the input accuracy is 

preserved, without adding further uncertainty. On the other hand, improving the model 

precision, beyond the resolution of the experimental data would be unnecessary. 
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As the generation of MSKMs implies the tuning of many input parameters, numerous 

sensitivity studies have recently aimed at testing the robustness of the models to several 

input, i.e. the location of virtual markers, the idealisation of the joints, and the identification 

of the their axes, the definition of the musculotendon geometry (Bahl et al., 2019, Carbone 

et al., 2012, Martelli et al., 2015, Navacchia et al., 2016, Wesseling et al., 2016). These studies 

highlighted the criticalities of musculoskeletal modelling through probabilistic approaches, 

but none of them tested the actual variability associated to one (or more) operator manually 

producing the models.   

In this respect, some researchers have questioned on the feasibility of adopting subject-

specific models as part of the clinical practice, especially due to the cost and time, and to the 

required expertise, mostly associated to the imaging acquisition and processing. In fact, the 

cost for one MRI is about £500 in the UK, and the time for extracting anatomical information 

from the images can reach 40 hours of work, depending on the experience of the operator 

and the level of detail required by the study. The use of generic-scaled models is proposed as 

a cheaper alternative, however, this approach proved to be highly inaccurate in the case of 

patients with anatomical or morphological variations (Bahl et al., 2019), or in children (Kainz 

et al., 2017). Indeed, scaling an adult-derived anatomical dataset onto a child is not feasible 

and proved to introduce non-negligible errors in the models’ output (Kainz et al., 2017). A 

generic paediatric model built from children data would be needed to overcome this 

limitation and provide a better template, compared to existing generic models, for adopting 

a scaling approach when medical images are not available, i.e. in retrospective studies or in 

studies where modelling time and costs represent a limitation.    

Otherwise, costs associated to subject-specific modelling could be reduced by introducing 

alternative and cheaper imaging techniques, such as Ultrasound, and improving the image 

processing phase by developing automated procedure to both limit modelling time and 

manual intervention. 

Furthermore, the adoption of MSKMs in the clinical routine is limited by the lack of strong 

evidence supporting their validity. Many studies apply MSKMs to investigate the 

biomechanical features of a disease based on small cohorts due to difficulties in enrolling 

participants or in obtaining ethical permission for conducting certain invasive tests. Limited 

numbers of participants often reduce the statistical strength of the results, i.e. impeding to 
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generalise on the outcome of a study. In fact, large datasets should be analysed in order to 

produce solid conclusions. On the other hand, in comparative studies, the ultimate aim is that 

of discriminating between groups of subjects, i.e. pathological versus healthy controls. In this 

thesis, the validity of the adopted modelling technique, with respect to the specific 

application/research question, was assessed by ensuring that the discriminating power of the 

analysed parameter was above its uncertainty.  

Moreover, some areas are still highly debated among the MSK modelling community, i.e. the 

modelling of the ankle joint. Experimental evidence proved that this is a very complex 

structure, including the tibiotalar and subtalar joints, whose movements are only partially 

described when assuming a hinge-like behaviour. Despite this, the hinge representation is 

commonly adopted in musculoskeletal modelling, especially due to limitations in tracking the 

real movement of these joints in-vivo. In fact, a more complex modelling could not be 

supported by equally accurate input data when simulating walking activities. Additionally, 

current approaches to the identification of the ankle axes resulted very sensitive to 

experimental variability and human error. For example, the ISB (International Society of 

Biomechanics) standards fully rely on the palpation of anatomical points to identify the joint 

axes, being unavoidably affected by landmark placement errors. An alternative method is 

based on the manual location of a cylinder in the correspondence of the talar dome (Prinold 

et al., 2016), however this approach is highly dependent on the operator capabilities. 

Moreover, these two methods provided inconsistent results when compared: Prinold et al. 

(2016) reported up to  83% of difference in the ankle peack JCF when using a landmark-based 

or fitting-based approach. Therefore, the inaccuracy and ambiguity of ankle models (Hannah 

et al., 2017, Leitch et al., 2010, Prinold et al., 2016) restrict their applicability to healthy 

populations where anatomical variability is less remarkable.  

Many authors reported on the anatomical variability between subjects and they assessed the 

sensitivity of the models to variations in the parameters constituting the musculotendon unit 

(Ackland et al., 2012, Carbone et al., 2016, De Groote et al., 2010, Modenese et al., 2018, 

Navacchia et al., 2016, Valente et al., 2014) mostly based on probabilistic analysis varying the 

input parameters within ranges provided by in-vivo or ex-vivo anatomical studies (Handsfield 

et al., 2014, Horsman et al., 2007, Ward et al., 2009). Despite the large amount of literature 

on this topic, no study, to the best of our knowledge, has quantified the model output when 



53 
 

personalising the musculotendon parameters accounting for the actual anatomical variability 

within a certain cohort.  

2.4. Aim and objectives 

This PhD thesis aimed to develop and assess an innovative, robust, and reliable procedure for 

the definition of MRI-based subject-specific MSKMs of the lower limb in order to foster their 

wider usability and clinical application. To achieve all this, several objectives were fulfilled.  

Objective 1: quantify the intra- and inter-operator repeatability of manual steps required for 

the personalisation of MRI-based MSKMs of the foot and ankle complex. The work reported 

in chapters 3 and 4 was intended to investigate this aspect. 

Objective 2: define and validate an innovative approach to personalised modelling of the 

tibiotalar and subtalar joints, compatible with currently available lower limb MSKMs. This led 

to the development of the kinematic model (presented in chapter 3) whose anatomical 

fidelity was verified against ex-vivo literature. 

Objective 3: define the minimum input requirements and set of procedures to implement an 

MRI-based semi-automated lower-limb musculoskeletal modelling pipeline in order to obtain 

an output accuracy in line with equivalent manual modelling approaches in the literature (i.e. 

MRI- or CT-based MSKMs). Such a pipeline, intended as the ensemble of the steps needed to 

produce MSKMs and simulate human gait in a patient-specific manner, would standardise 

models’ output, promoting a wider adoption of the technique. In this sense, part of chapter 

5 aims at providing suggestions for standardising input data and briefly reports general 

guidelines for producing an MSKM (full details are included in Appendix I). 

Objective 4: test the robustness of the lower-limb musculoskeletal modelling pipeline to 

operator-related errors and uncertainties and identify the critical steps aiming at further 

improve the subject-specific estimates. Chapter 6 aimed at achieving this objective. 

Objective 5: account for intra- and inter-subject muscle anatomical variability in MSKMs and 

quantify the effect of muscle personalisation on the estimate of muscle and joint contact 

forces. To fill this gap in the literature, chapter 7 analyses the anatomical variability in a group 

of older women and adjust musculotendon parameters to match the actual values for these 
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subjects. A comparison to less personalised techniques, based on generic-scaled models is 

also pursued. 
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Abstract
Subject-specific musculoskeletal modelling is especially useful in the study of juvenile and pathological subjects. However,
such methodologies typically require a human operator to identify key landmarks from medical imaging data and are thus
affected by unavoidable variability in the parameters defined and subsequent model predictions. The aim of this study
was to thus quantify the inter- and intra-operator repeatability of a subject-specific modelling methodology developed
for the analysis of subjects with juvenile idiopathic arthritis. Three operators each created subject-specific musculoskele-
tal foot and ankle models via palpation of bony landmarks, adjustment of geometrical muscle points and definition of joint
coordinate systems. These models were then fused to a generic Arnold lower limb model for each of three modelled
patients. The repeatability of each modelling operation was found to be comparable to those previously reported for
the modelling of healthy, adult subjects. However, the inter-operator repeatability of muscle point definition was signifi-
cantly greater than intra-operator repeatability (p \ 0.05) and predicted ankle joint contact forces ranged by up to 24%
and 10% of the peak force for the inter- and intra-operator analyses, respectively. Similarly, the maximum inter- and
intra-operator variations in muscle force output were 64% and 23% of peak force, respectively. Our results suggest that
subject-specific modelling is operator dependent at the foot and ankle, with the definition of muscle geometry the most
significant source of output uncertainty. The development of automated procedures to prevent the misplacement of cru-
cial muscle points should therefore be considered a particular priority for those developing subject-specific models.
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Introduction

The use of musculoskeletal models to determine the
muscle and joint contact forces (JCFs) during gait has
long been reported.1 The sensitivity of model outputs to
experimental errors such as misplacement of stereopho-
togrammetric markers and soft tissue artefact has been
explored through probabilistic analysis.2–4 Similarly,
there is a significant body of evidence demonstrating
model sensitivity to the defined musculoskeletal anat-
omy with the joint coordinate systems, inertial para-
meters, muscle properties and muscle path geometries
all investigated.5–8 However, the error involved in accu-
rately identifying these anatomical properties from
experimental data is less well understood. Due to varia-
bility in patient anatomy, concerns have been raised

about the accuracy of outputs obtained with scaled,
generic models.9 This is particularly the case when
applying such methods to juvenile or pathological sub-
jects, whose anatomy may differ significantly from the
cadavers upon which the generic models are based.10,11

Driven by the need for more accurate model predic-
tions and facilitated by advances in medical imaging
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technology, subject-specific modelling techniques are
becoming more widely developed and adopted.12–19

One such methodology20 was developed for the study
of subjects with juvenile idiopathic arthritis (JIA), an
autoimmune disease which can cause physical function
disabilities as a result of chronic inflammation of the
synovial joint membrane. The aetiology of the disease
remains unknown but it has been speculated that
altered knee and ankle joint loading21 may influence
disease progression22 and is thus a pathology that par-
ticularly warrants investigation with subject-specific
musculoskeletal models.

As part of such methodologies, analysis of clinical
imaging data allows, among other things, subject-
specific muscle paths and joint coordinate systems to
be identified and defined.4 Despite efforts to automate
these procedures,23,24 this is typically conducted by a
human operator and is thus liable to unavoidable inter-
and intra-operator variability in the parameters
defined.

To justify the time required for an operator to ana-
lyse subject medical images and manually modify a
model parameter, two criteria should be met: first, that
the model outputs are sensitive to its value, and second,
that it can be repeatably and reliably identified. As
such, several studies have aimed to quantify the varia-
bility and sensitivity of the parameters typically defined
as part of a subject-specific modelling approach.25–27

Martelli et al.28 reported the variation in predicted
JCFs and muscle forces after altering lower limb joint
coordinate systems in line with the inter- and intra-
operator distributions. These distributions were deter-
mined from those recorded by five operators, each
analysing computed tomography (CT) images of a sub-
ject. They found the largest impact of operator input
on JCFs to be at the ankle, with a maximum change of
0.33 times bodyweight (BW) reported. However, mus-
cle forces were found to vary more significantly, by up
to 114% of their median value. Valente et al.4 per-
turbed bony landmark locations, muscle path points
and maximum muscle tensions via a Monte Carlo anal-
ysis and found them to have a greater impact on the
ankle JCFs, with relevant values ranging by up to 1.58
BW, and on muscle forces, which varied by up to 1.58
BW. Such studies are extremely useful, allowing those
developing musculoskeletal modelling approaches to
identify the subset of critical parameters that are worth
varying on a subject-specific basis.

However, the subject-specific models created as part
of both of these studies were of healthy adult subjects.
Conversely, little research has been done into the
repeatability and sensitivity of such modelling meth-
odologies when applied to juvenile or pathological sub-
jects. As such, the aim of the following study was to
investigate the inter- and intra-operator repeatability of
a subject-specific modelling methodology developed for
children with JIA. The sensitivity of the estimated ankle
JCFs and muscle forces to the operator-dependent

variation in defined muscle geometries and joint coordi-
nate systems was also investigated.

Methods

Subjects and data acquisition

The data collection was carried out by specialised clini-
cal centres as part of the MD-Paedigree project (EC
7th FP, ICT Program, CN: 600932). Three female sub-
jects with JIA were selected to take part in the study
with written informed consent obtained from all sub-
jects and/or their parents. Subject data, including the
number of affected joints, a Child Health Assessment
Questionnaire score (CHAQ)29 and a composite disease
activity score (JADAS-71),30 are shown in Table 1.
Gait analysis was based on the PlugIn Gait31 and mod-
ified Oxford Foot Model (mOFM)32 marker protocols
(for detailed procedures, see Prinold et al.20) with three
gait trials performed by each subject randomly selected
for inclusion in this study.

Two sequences of magnetic resonance imaging
(MRI) scans of the foot and distal tibia were obtained
for each subject. The first sequence was a multi-slice,
multi-echo 3D Gradient Echo (mFFE) scan in the
sagittal plane with a 1mm slice thickness and 0.5mm
in-plane resolution. The second sequence was a 3D
short T1 inversion time inversion recovery fast field
echo scan, again in the sagittal plane. The slice thick-
ness was 2mm with a 0.6mm in-plane resolution.
Subject bony geometries were segmented from the first
MRI sequence by a single operator while the data from
the second sequence was used to define subject-specific
muscle paths.

Musculoskeletal modelling approach

A generic unilateral lower limb model of each subject
was created by scaling the geometry of the Arnold
model33 with the tools available in OpenSim.34 The
generic foot was subsequently replaced with a subject-
specific, two-segment equivalent, fused to the generic
model at the ankle joint. The process to create the

Table 1. Subject data.

Subject A Subject B Subject C

Age (years) 9.5 12.9 15.9
Height (m) 1.37 1.53 1.45
Mass (kg) 40.6 64.2 50.0
BMI (kg/m2) 21.5 27.2 23.8
Affected joints 6 5 3
CHAQ 0 0.5 1.75
JADAS-71 13.8 – 16.4

BMI: body mass index.

CHAQ29 is a measure of limitation to activities of daily living (range:

0–3; ‘3’ being most severe). JADAS-7130 is a composite disease activity

score (range: 0–101; ‘101’ being most severe).
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subject-specific foot was reported in detail by Prinold
et al.,20 but is presented in brief here.

Once bony geometries of the foot and distal tibia
have been segmented from the imaging data, the pro-
cess of creating a subject-specific foot model can be bro-
ken down into four distinct phases, all of which were
performed in NMSBuilder:4,35

1. Virtual palpation of anatomical landmarks. Key
landmarks on the segmented bony geometries were
identified by the operator according to Van Sint
Jan.36 These landmarks were divided into segment
landmark clouds with the tibia, hindfoot, talus,
metatarsal and forefoot segments requiring 3, 4, 4,
6 and 5 landmarks to be palpated, respectively.
The 22 markers virtually palpated in this study are
a subset of those reported in Prinold et al.20 A full
list of the markers used is available as a supple-
mentary file accompanying this article.

2. Registration of generic muscle atlas. The location of
the virtually palpated landmarks was subsequently
used to register a generic atlas of muscle points33

on to the subject-specific geometry. These served as
first estimate of the subject-specific muscle paths.
This process is not operator dependent.

3. Manual adjustment of muscle paths. All foot muscle
origin, insertion and via points were adjusted by
the operator to be consistent with the subject MRI
data. Points captured by the MRI scan in the distal
tibia were also altered resulting in a total of 74
muscle path points that had to be manually
modified.

4. Definition of joint coordinate systems. Proximal and
distal anatomical coordinate frames were defined
for the ankle (tibia–hindfoot) and metatarsopha-
langeal (MTP) joint (hindfoot–forefoot) via palpa-
tion of bony landmarks as in Stebbins et al.32 One
exception was the ankle joint centre which was
determined by fitting a cylinder to the talar dome
with its mediolateral axis serving as the plantar/
dorsi-flexion axis.20

The combined generic lower limb and subject-
specific foot model had a total of five segments (pelvis,
femur, tibia, hindfoot, forefoot) and 13 degrees of free-
dom: six at the pelvis, three at the hip, one at the knee
(flexion/extension), two at the talocrural ankle joint
(inversion/eversion and plantar/dorsi-flexion) and one
at the hindfoot–forefoot (plantar/dorsi-flexion). A total
of 54 muscle paths were defined in each model, of
which 16 span the ankle joint.

Simulation of gait trials

Muscle forces and JCFs were determined in OpenSim
using a standard approach of inverse kinematics, fol-
lowed by static optimisation and joint reaction analy-
sis.34 Model outputs were compared against joint
angles, joint moments and muscle activation patterns

reported in the literature for level walking.37–40

However, no attempts were made to validate the mus-
cle forces obtained with the static optimisation tool
against experimentally obtained electromyography
measures as this was beyond the scope of the study.

Coordinate actuators were defined at the pelvis while
residual actuators were employed at the hip joint only.
As a two-segment foot was defined, the single ground
reaction force (GRF) as recorded by the force platform
had to be divided between the hindfoot and forefoot
segments. This was achieved by applying the entire
measured load to the hindfoot until the centre of pres-
sure (COP) crossed the metatarsophalangeal joint, at
which point the load was applied exclusively to the
forefoot segment.20

Operators

Following the methodology described above, a muscu-
loskeletal model of each subject was created by each of
three expert operators. One operator completed the full
subject-specific modelling approach three times for a
single subject (Subject C) such that intra-operator anal-
yses could be performed. A minimum of 48h was
allowed to pass between each intra-operator modelling
procedure.

Statistical analysis

All operator-dependent inputs and model predictions
were recorded to allow the robustness of the modelling
approach to be investigated. Appropriate statistical
tests were selected according to the purpose of the
investigation and are detailed hereafter. The level of
significance (p) was set to be 0.05 in all analyses.

The repeatability of two modelling steps, i.e. the pal-
pation of each virtual landmark and the definition of
each muscle point location, was evaluated by calculat-
ing the standard deviation (SD) of the spatial coordi-
nates defined for each point. For the analysis of
virtually palpated landmarks, each segment landmark
cloud was considered to be an independent variable.
The repeatability of the definition of the joint coordi-
nate systems was assessed by determining the variability
(SD) in the Cardan rotation required to superimpose
the proximal frame upon the distal frame for each joint
in the model.

A one-way analysis of variance was run between the
results obtained for each of the three subjects to test
whether the anatomy of the patient was a significant
factor in the repeatability of the methodology. This was
performed at each stage of the modelling process con-
sidered (virtual palpation of anatomical landmarks,
manual adjustment of muscle paths, definition of joint
coordinate systems). Where no statistically significant
inter-subject differences were observed, a comparison
of inter- and intra-operator repeatability was also per-
formed for one subject (Subject C) using a two-tailed,
paired Student’s t-test (Figure 1).

Hannah et al. 417



The sensitivity of the ankle JCFs to inter- and intra-
operator modelling was assessed via calculation of the
variation in the mean vertical ankle JCF predicted for
each subject in the ground reference frame across the
three simulated gait trials. Similarly, the sensitivity of
model estimated muscle forces was investigated by
determining the mean of the maximum change in mus-
cle force output at any point during each gait trial.
This value was determined for each of six key muscles
that cross the ankle joint: soleus, gastrocnemius media-
lis, gastrocnemius lateralis, tibialis posterior, tibialis
anterior and peroneus longus, each of which to whom
ankle JCF was shown to be most sensitive in a previous
study.20 Furthermore, they are also muscles spanning
the ankle joint that have the largest physiological cross-
sectional area. All JCFs and muscle loads were normal-
ised to subject BW.

Results

Variability of model input

The maximum inter-operator SD in defined landmark
location were 2.9, 2.9 and 2.7mm for Subjects A, B
and C, respectively, with mean inter-operator repeat-
ability of all virtually palpated landmarks of
0.906 0.60mm. In comparison, the maximum intra-
operator SD was 2.3mm with a mean across all land-
marks of 0.666 0.63mm. All statistical tests upheld the
null hypothesis indicating virtual palpation is both
operator and subject independent.

The inter-operator repeatability of the defined mus-
cle point location (3.06 2.5mm) was found to be sig-
nificantly lower (p \ 0.05) than intra-operator
repeatability (1.76 1.9mm) for Subject C. The maxi-
mum variation in the spatial dimensions of any single
muscle point was 14.3mm (extensor hallucis brevis –
via point) and 9.6mm (flexor hallucis brevis – origin)
for the inter- and intra-operator analyses, respectively.

Mean inter-subject SDs were found to be
3.06 2.9mm for Subject A, 2.76 2.3mm for Subject B
and 3.06 2.5mm for Subject C with the maximum SD
of a single point being 17.0mm (flexor hallucis brevis –
origin), 12.3mm (extensor digitorum longus – via
point) and 14.3mm (extensor hallucis brevis – via
point), respectively. No significant inter-subject differ-
ences were observed. Further analysis of individual
muscle points indicated that the forefoot muscle inser-
tion points (flexors and extensors digitorum and hallu-
cis) were the most repeatably identified while operators
disagreed more about the location of via points relative
to muscle origin and insertion points.

When considering the joint coordinate systems
defined in the models (Figure 2), inter-operator SDs
were found to range from 1.36� to 3.02� for the ankle
inversion/eversion axis and from 0.26� to 1.72� for the
plantar/dorsi-flexion axis. Variability at the metatarso-
phalangeal plantar/dorsi-flexion axis was greater,
2.40�–7.04�. The variance in the intra-operator joint
coordinate systems was 0.50�, 1.15� and 0.88� for the
three axes, respectively. Inter- and intra-operator
repeatability was not found to differ by a statistically
significant margin and no inter-subject effects were
observed (Table 2).

Variability of model predictions

Figure 3 shows the inter-operator variation in the verti-
cal mean ankle JCF calculated for each subject across
the three modelled gait trials. The maximum ranges
observed were 1.50BW, 0.75BW and 0.73BW for
Subjects A, B and C, respectively. The maximum intra-
operator range was found to be smaller again, 0.28BW
for Subject C.

The average of the maximum inter-operator changes
in vertical ankle JCF observed at any point during a
gait trial was 1.556 0.36BW for Subject A (20% of
peak JCF), 0.776 0.31BW for Subject B (16% of peak

Figure 1. Flow chart illustrating inter- and intra-operator analysis and statistical tests employed. Subjects, operators (Op), models
(Mod) and gait trials are shown. Inter- and intra-operator comparisons were performed on both model inputs and outputs.
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JCF) and 0.756 0.02BW for Subject C (12% of peak
JCF) with the maximum recorded in any individual trial
of 1.86BW (Subject A – 24% of peak JCF). The equiv-
alent intra-operator value was smaller, 0.336 0.15BW
(6% of peak JCF), with a single trial maximum of
0.55BW (10% of peak JCF).

Table 3 shows the average of the maximum differ-
ence in estimated muscle force output for six key mus-
cles at any frame in the gait cycle. The muscles with the
greatest inter- and intra-operator variation were the
soleus, gastrocnemius medialis and tibialis anterior with
the differences observed in Subject A consistently larger
than with the other two models. The maximum inter-
operator difference observed in any one trial was
1.94BW for Subject A (tibialis anterior – 64% of peak

force), 0.96BW for Subject B (gastrocnemius medialis –
73% of peak force) and 0.94BW for Subject C (soleus –
40% of peak force). The maximum change output for a
muscle force in the intra-operator analysis was 0.44BW
in the soleus (23% of peak force).

Discussion

In this study, subject-specific models of three pathologi-
cal subjects were created such that the inter- and intra-
operator uncertainty in model parameter definition
could be estimated and the sensitivity of the ankle JCFs
and muscle forces output with the models evaluated.

Table 2. Inter- and intra-operator SD (�) in joint angle definitions.

Joint Inter-operator Intra-operator

Subject A Subject B Subject C Subject C

Inv/Ev PF/DF Inv/Ev PF/DF Inv/Ev PF/DF Inv/Ev PF/DF

SD (�) SD (�) SD (�) SD (�) SD (�) SD (�) SD (�) SD (�)

Ankle 1.36 1.64 3.02 1.72 1.36 0.26 0.50 1.15
MTP – 2.40 – 7.04 – 3.37 – 0.88

SD: standard deviation; MTP: metatarsophalangeal.

Inversion/eversion (Inv/Ev) and plantar/dorsi-flexion (PF/DF) axes are shown.

Figure 3. Range of inter-operator mean vertical ankle joint
contact forces (BW) obtained across three gait trials in the
ground reference frame. Dotted line represents average
occurrence of toe-off (TO).

Table 3. Maximum difference (Max diff) in estimated muscle force.

Muscle Inter-operator Intra-operator

Subject A Subject B Subject C Subject C

Max diff (BW) Max diff (BW) Max diff (BW) Max diff (BW)

Soleus 1.25 6 0.09 0.38 6 0.23 0.85 6 0.10 0.41 6 0.02
Gastrocnemius medialis 1.03 6 0.34 0.47 6 0.35 0.76 6 0.06 0.30 6 0.02
Gastrocnemius lateralis 0.90 6 0.51 0.31 6 0.14 0.06 6 0.00 0.01 6 0.01
Tibialis posterior 0.98 6 0.41 0.26 6 0.08 0.54 6 0.04 0.01 6 0.03
Tibialis anterior 1.46 6 0.29 0.25 6 0.08 0.19 6 0.02 0.17 6 0.02
Peroneus longus 1.03 6 0.34 0.40 6 0.25 0.22 6 0.01 0.08 6 0.03

BW: bodyweight; SD: standard deviation.

Mean 6 SD across three gait trials is shown.

Figure 2. Distal segment anatomical coordinate frames
defined by each operator. Ankle and metatarsophalangeal joints
(Subject C).
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The virtual palpation of bony landmarks was found
to be a repeatable operation, both intra- and inter-
operator with the mean inter- and intra-operator varia-
tion in the defined spatial dimensions of 0.90 and
0.62mm, respectively. This compares favourably with
the value of 1.11mm reported in a previous experimen-
tal study in which five individual operators each pal-
pated subject MRI imagery three times.4 However,
separate inter- and intra-operator repeatability data
were not reported, as here.

The definition of subject-specific muscle paths was
found to be subject independent but not operator inde-
pendent. This is crucial as errors in locating muscular
attachments are the largest source of inconsistency in
musculoskeletal output.4,20,23 The mean variation in
muscle point location was 3.06 2.5mm, lower than the
5.0mm uncertainty reported by Pal et al.,41 when deriv-
ing muscle attachment points from the measurement of
surface landmarks at the knee, and used as the level of
uncertainty in Valente et al.’s4 probabilistic analysis. As
would be expected, this suggests that the repeatability
of identifying muscle paths is improved when an opera-
tor has access to medical images of the subject.

Variability in the definition of model joint coordi-
nate systems has been shown to have a minor influence
on output JCFs but a considerable impact on the pre-
dicted muscle forces.28 The mean inter-operator varia-
tion in the ankle coordinate systems was 1.2� for the
plantar/dorsi-flexion axis and 1.9� for the inversion/
eversion axis. These values are comparable to those
reported by Martelli et al.,28 0.4� and 2.0�, respectively.
Mean variability was higher at the metatarsophalangeal
joint, 4.3�, indicating that the bony landmarks used to
identify this joint32 could be less repeatably identified.

When considering model outputs, the unavoidable
variability in operator-defined subject-specific para-
meter definition had a clear effect on vertical ankle
JCFs, with a maximum inter-operator variability of
1.86BW observed, a value equal to 24% of the peak
JCF. This is comparable with a similar study by
Valente et al.,4 who reported a slightly lower variation
of 1.58BW. However, while both studies varied the
location of muscle path points, their study altered the
location of bony landmarks and maximum muscle ten-
sions, as opposed to the joint coordinate systems as
reported here. Intra-operator variability in ankle JCF
was found to be much smaller, only 0.33BW, indicat-
ing that subject-specific model predictions obtained by
a single operator are directly comparable. However,
these findings can only be said to be valid for vertical
ankle JCFs as shear forces have not been considered.

Consistent with previously reported studies,25,27 per-
turbations of model input parameters had a consider-
able impact on the predicted muscle forces. When
varying the defined joint coordinate systems, Martelli
et al.28 found muscle forces to vary by up to 114%
compared to their median value, while Valente et al.4

reported a maximum variation of 1.54BW. These

values again compare favourably with the maximum
variation in muscle force observed in this study,
1.94BW. Furthermore, the muscles most affected in
Valente et al.4 at the ankle (soleus, gastrocnemius med-
ialis, tibialis anterior) are the same as reported here.
This indicates that it is the muscles with the larger phy-
siological cross-sectional areas and moment arms that
are most affected by uncertainty in their definition, and
that their misplacement has the greatest impact on pre-
dicted muscle forces and JCFs.11,20 Therefore, particu-
lar care should be taken when locating their bone
insertion and via points.

The estimated inter-operator JCFs and muscle loads
were considerably more varied for one subject than the
other two. Although no statistically significant inter-
subject differences in the model inputs were observed,
this subject had the highest levels of variability in the def-
inition of the muscle paths but interestingly, not in the
definition of the joint coordinate systems. This is further
evidence that it is the spatial location of muscle points
which are the greatest source of variability in the outputs
obtained with musculoskeletal models.4,20,23 As such, the
development of appropriate techniques for their reliable
identification would be particularly advantageous and
enable appropriate muscle moment arms, muscle lines of
action and muscle-tendon lengths to be defined.

A number of limitations exist in the reported metho-
dology that should be considered when reviewing the
presented results. First, all operators based their models
on the same segmented bony geometries, a procedure
which, while sometime automated,42–44 would also typi-
cally entail a further degree of inter-operator variation.
The entire modelling methodology was also only com-
pleted multiple times by a single operator and for a sin-
gle subject. While no statistically significant inter-
subject differences were observed, the intra-operator
analyses presented should therefore be interpreted with
an understanding that the inclusion of further subjects
and operators in the study could result in differing levels
of uncertainty. Furthermore, only the reported subject-
specific modelling methodology has been investigated,
and adopting an alternative modelling approach may
result in differing levels of repeatability and sensitivity.

A further limitation of the study is the use of a static
optimisation technique to estimate muscle–tendon
forces. Static optimisation assumes that muscle recruit-
ment is such that the metabolic energy expenditure
required to facilitate a movement is minimised45,46 and
this is implemented through the minimisation of an
objective function (the sum of muscle activations
squared in the case of this study). However, the gait of
pathological individuals is likely to be suboptimal with
regard to energetic efficiency, instead prioritising the
reduction of articular loading at painful joints, for
example. Caution should therefore be employed when
evaluating the outputs of the model as optimal
neuro-motor control has been assumed when simulat-
ing the motion of pathological subjects.
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Alternative methodological approaches to overcome
this limitation, such as personalizing the muscle recruit-
ment strategy using electromyographically driven mod-
elling techniques, are available in the literature.47

However, this was not possible as EMG signals for all
muscles crossing the ankle joint would be required and
these were not collected in this study. Identification of
a ‘disease-specific’ objective function would also be a
challenging task requiring careful validation and is out-
side the scope of this investigation.

A final limitation of the reported study is the defini-
tion of generic muscle parameters in an otherwise
subject-specific foot model, and their subsequent effect
on model predictions via the force-length-velocity rela-
tionship.48 It was considered reasonable to scale opti-
mal fibre lengths and tendon slack lengths such that
their relative ratio was maintained with respect to the
total muscle-tendon length at rest. However, future
studies could determine subject-specific muscle para-
meters by employing more complex anthropometric
scaling tools.49 Despite these limitations, it is clear that
the reported methodology allowed the stated aim of the
study to be achieved, to quantify the sensitivity of a
juvenile subject-specific musculoskeletal foot and ankle
model to the variation in operator-dependent input.

Conclusion

This study investigated the inter- and intra-operator
repeatability and sensitivity of a subject-specific mod-
elling methodology developed for the analysis of juve-
nile, pathological subjects. The findings of the study
indicate that the reported methodology exhibits com-
parable levels of repeatability and sensitivity to those
reported for modelling healthy adults.4,28 Inter-opera-
tor variation in the definition of muscle geometries
remains significant and has the greatest impact on
model outputs. As such, automated routines should
be developed to reduce the significance of the opera-
tor’s role and prevent the misplacement of crucial
muscle points. This will be of particular interest to
those developing musculoskeletal models of juvenile
or pathological subjects, for whom subject-specific
modelling is of the greatest importance.10,11
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5. Methods for MRI-based anatomical 

modelling of the lower limb  
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This chapter collects the methods and results relative to the development of a detailed 

pipeline for image-based lower-limb musculoskeletal modelling: “Pipeline for building a 

subject-specific MSK model from MRI and motion capture data”, included in the Appendix I 

of this thesis. The pipeline was published as additional material to the paper “Investigation of 

the dependence of joint contact forces on musculotendon parameters using a codified 

workflow for image-based modelling” (Modenese et al., 2018), that I co-authored. This was 

produced with the aim of ensuring a robust and reliable pipeline for processing imaging and 

motion capture dataset and documenting automated or semi-automated procedures to be 

shared with the biomechanics community to produce musculoskeletal models (MSKMs). The 

purpose of this chapter is also to clarify and integrate the methods described in brief in the 

publications included in the chapters 4 -7.  

5.1. Optimised input data for musculoskeletal modelling 

Subject-specific musculoskeletal modelling requires several input parameters. In order to 

reduce modelling errors and uncertainties, the accuracy of the input data (and relative 

experimental procedures) needs to be maximised. Aiming at fostering the adoption of a 

standardised and robust pipeline for musculoskeletal modelling, it is hence crucial to optimise 

the way in which parameters are measured and collected. Therefore, the first part of the PhD 

focused on the identification of the most critical aspects of data collections (including imaging 

and motion capture) toward the improvement of the input dataset. This was achieved 

pursuing a critical review of the limitations within previously collected datasets. 

5.1.1. Experimental protocols  

An optimal dataset for subject-specific musculoskeletal modelling, including gait analysis and 

MRI data, must reflect the clinical needs, addressing correctly the purpose of the 

investigation, i.e. a specific clinical question for a particular population. In addition, it must 

compromise between the quality of the data and the available facilities, prioritizing the 

comfort of patients and subjects involved in the study. Within this framework, a protocol was 

designed to be used for musculoskeletal modelling for the analysis of muscle forces and joint 



84 
 

loading, which aimed at being used in an adult population, including both older and young 

adults.  

Data collection: gait analysis and medical imaging 

Being the marker placement one of the most time-consuming part of the gait analysis data 

collection, often uncomfortable for the subject who is asked to stand for a considerable 

period, it is recommendable to reduce the marker-set to a minimum number. This number 

should represent the optimal compromise between placement time and invasiveness of the 

procedure, and accuracy of the acquisition. In a similar manner, the number of liquid-filled 

MRI-visible markers to be retained during the medical imaging should be the minimum to 

guarantee an accurate registration of the data. In specific applications or for specific research 

purposes, where a higher level of accuracy and detail is required, this number can be 

increased and redundant makers can be added, being aware that toilsome procedures might 

not be easy to translate in the clinical practice. 

A protocol for lower-limb MRI was developed as part of this PhD in collaboration with expert 

radiologists and clinicians with the purpose of improving two main aspects: the segmentation 

of bone geometries for the dentification of joint axes and the segmentation of muscle tissue 

to improve the discrimination between adjacent muscle and correctly identify their 

attachments and path. To achieve this, a 3D gradient echo in-and out of phase T1-weighted 

radial-volumetric interpolated breath-hold examination MRI sequence was selected, to be 

performed in 5 stacks from the feet up to the pelvis. A variable slice thickness was chosen: 3 

mm in the articular region, when maximal accuracy is required, and 5 mm along the femur 

and tibia shaft, where less detail is acceptable; whereas the in-plane voxel size was set to 

1.1x1.1 mm.  

Additionally, it emerged that a critical aspect for the identification of the joint axes from the 

bone segmentation is the correct alignment of the body segment when the subject is lying on 

the MRI bed. The use of a foot positioner enabled to ensure a 90-degree ankle angle and with 

the foot facing forward, also limiting the internal/external rotation of the hip. 

5.2. Anatomical model 
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The lower limb anatomical model was developed within the application NMSBuilder (Valente 

et al., 2017), which is a freely-available software allowing to process biomedical data (medical 

images and segmentations) to be used for musculoskeletal modelling. The first step of the 

pipeline entailed importing the segmented geometries in NMSBuilder and organizing them in 

11 segments composing the lower limbs, namely pelvis and bilateral femur, tibia, talus, 

midfoot, and phalanges. Each segment includes both bone and soft tissue (i.e. the outside 

contour of the skin) geometries.  

5.2.1. Creation of the joints 

In order to describe the motion with respect to the environment, the initial configuration of 

the segmental chain needs to be known. In this sense, segmental frames define the pose of 

each body with respect to the ground.  Movement is then represented by the rotation (or 

translation) of the distal reference system with respect to the proximal refence system. The 

pelvis, being the first segment of the chain, is referred to the ground by means of a free joint 

with 6 DoFs. Each distal body is referred to the proximal most adjacent one by means of 

rotational transformation. Ten joints were included in the model; two hips, schematized as 

ideal ball and socket with 3 DoFs, two knee joints, two tibiotalar joints, two subtalar joints, 

two metatarsophalangeal (MTP) joints, all schematized as ideal hinges with 1 DoF.  

The description of the joints articulating between the body segments depends on the 

definition of two reference systems, one on the proximal and one on the distal segment, and 

on the relationship between the two. These anatomical frames are defined in NMSBuilder by 

means of three points, one representing the origin of the system, one setting the direction of 

the x axis, and one identifying the x-y plane. The z axis is derived as a consequence of the 

right-hand rule. To identify these points two methods can be implemented:  

• Virtual palpation: referring to the identification of anatomical points, usually bony 

landmarks, on a 2D or 3D graphic representation of the human body, i.e. medical 

images or a model obtained from the segmentation of medical images (van Sint Jan, 

2007).   



86 
 

• Morphological fitting: referring to the operation of fitting analytical shapes to bone 

geometries using a least squared error procedure for the identification of the optimal 

fitting (Modenese et al., 2018, Montefiori et al., 2019a, Montefiori et al., 2019b, Parr 

et al., 2012, Siegler et al., 2014). The procedure was implemented in a MATLAB 

(R2016b, The MathWorks, Inc., USA) script taking as an input the shape of the 

contacting articular region and giving as an output the centres and radii of the fitted 

geometries (Figure 5-1). 

 

Figure 5-1 – Definition of the joint axes through morphological fitting of analytical shapes to the 
articular surface of the bones. Example for hip, knee and ankle fitted to sphere, cylinder, and 

cylinder, respectively. 

Errors in the identification of these points introduce offsets in the relative position of the 

segments, ultimately leading to wrong estimates of the segmental kinematics. For this reason, 

morphologic fitting is preferred as less sensitive to operator-error. In fact, while the virtual 

palpation is a completely manual procedure, where the operator expertise is crucial to the 

successful location of the points, the fitting procedure is performed automatically through 

the algorithm, and the only manual operation is the selection of the articular surface to be 

fitted. The method has proved to be robust to differences in the selection of such area; full 

assessment of the repeatability and reproducibility of the methodology is reported in chapter 
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5 for the foot and ankle reference systems and in chapter 6 for the lower limb reference 

systems. 

In brief, the identification of the axes of rotation of the different joints was achieved as follows 

(detailed procedure described in Appendix I): 

• Pelvis joint (6 DoFs): through virtual palpation of the midpoint between the most 

anterior points on the superior iliac spines of the pelvis to identify the origin of the 

joint 

• Hip joint (3 DoFs): through morphologic fitting of the femur head to a sphere, whose 

centre represented the origin of the joint; 

• Knee joint (1 DoF): through morphologic fitting of the femur condyles to a cylinder, 

whose centre and axis represented the origin and axis of the joint, respectively;  

• Ankle joint (1 DoF): through morphologic fitting of the talar dome to a cylinder, whose 

centre and axis represented the origin and axis of the joint, respectively; 

• Subtalar joint (1 DoF): through morphologic fitting of the posterior-inferior 

talocalcaneal interface to a sphere, whose centre represented the origin of the joint 

and through morphologic fitting of the anterior talonavicular interface to a sphere, 

whose centres (connected to the origin of the joint) defined the axis of the joint 

• Metatarsals joint (1 DoF): through virtual palpation of the most inferior point on the 

distal head of the first and fifth metatarsals to identify the origin (on the first 

metatarsals) and the axis of the joint (connecting the two points). 

5.2.2. Location of muscle attachment points  

A description of the muscle geometry respectful of the real muscle anatomy represents one 

of the most critical steps in the construction of a personalised MSKM. In fact, many authors 

investigated the sensitivity of models to muscle geometry, especially muscle moment arm 
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(ma), namely the perpendicular distance between the muscle line of action and the centre of 

the joint the muscle is crossing (Figure 5-2) (Ackland et al., 2012, Bahl et al., 2019, Navacchia 

et al., 2016, Prinold et al., 2016, Scheys et al., 2011, Scheys et al., 2008a, Scheys et al., 2008b, 

Valente et al., 2014). 

 

Figure 5-2 – Example of definition of the gluteus maximus path (red lines) according to the three-
bundle schematisation proposed by Delp et al. (1990) and identification of the moment arm (ma) 

of the first bundle.  

Virtual palpation on MRI 

Muscle attachment points can be directly visible on the MRI, especially when they attach to 

bony tuberosity or prominences that enable to clearly identify the region on the bone where 

the muscle originates or inserts (Ascani et al., 2015). Via points and muscle paths can be easily 

located if the MRI contrast ensure the visibility of the different muscles and tendons. A clear 

example is shown in Figure 5-3 where ankle extensors and flexors via points can be selected 

on different MRI slices by means of virtual palpation of points on the images.  
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Figure 5-3 – Identification of the via points of the muscles crossing the ankle on the transverse 
plane of the MRI. 

Supervised atlas registration 

This method is based on the use of an atlas of muscle points, taken from a literature generic 

model (Delp et al., 1990). In order to register these points on their corresponding location on 

a subject-specific model, a list of bony landmarks need to be added to the atlas. These bony 

landmarks must be placed in easily identifiable and meaningful position, to ensure the 

repeatability and reproducibility of their location. The same landmarks are then palpated on 

the subject-specific model and the bony landmark in the atlas are matched to their 

corresponding palpated markers through an affine transformation. This is made possible by 

using the same labelling for the markers in the atlas and in the subject-specific model. The 

resulting transformation, obtained from minimising the residual error of each transformation 

between couples of markers, is applied to the coordinates of the muscle points in the generic 

atlas, which are mapped onto the subject-specific model.  

A MATLAB function (Modenese et al., 2018) is then used to snap the registered muscle points 

in order to adjust their location: origin and insertions are moved onto the nodes of the bone 

geometry they belong to, whereas via points are not moved, but eventually manually 

adjusted, if required (Modenese et al., 2018).  

The repeatability of the whole procedure was assessed in the papers “Sensitivity of a juvenile 

subject-specific musculoskeletal model of the ankle joint to the variability of operator 

dependent input” and “Linking joint impairments and gait biomechanics in patients with 
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Juvenile Idiopathic Arthritis”, included in chapter 4 and 6, respectively, by measuring the 

intra- and inter-operator repeatability of both landmark palpation and muscle points 

identification.  

Iterative Closest Point approach 

This method relies on the existence of a musculoskeletal database including data from eleven 

older women, produced as part of the project Multisim, who partially funded this PhD. The 

database, to be released with the paper “The effect of muscle personalisation in the estimate 

of muscle forces and joint contact forces in post-menopausal women”, currently in 

preparation, contains bone and muscle geometries segmented from MRI in the format of 

stereolithographic files, a list of individual lower-limb muscle volumes and muscle points, as 

comma-separated vector of coordinates in the format of text files. Given the database (D), 

containing eleven datasets (D1, …, D11) an automatic identification of muscle points is possible 

through Iterative Closest Point (ICP) (Kjer and Wilm, 2010) algorithm registration in MATLAB 

(Figure 5-4). When a new model (Mnew) must be produced, a best matching dataset (Dbest) can 

be found among those available in D, based on a preliminary registration of the bone 

geometries in D1, …, D11 onto Mnew. Dbest is identified as the dataset whose registration gives 

the lower residual error and is registered again to Mnew through ICP mapping. Twenty 

iterations are implemented as resulted in the best compromise between computational time 

and residual error, which was found to decrease below 5% after the 18th iteration. The output 

of the registration is a transformation matrix that is afterwards applied to the cloud of muscle 

points associated to Dbest in order to map them onto the Mnew bone geometries. The previously 

described snapping algorithm is used here as well in order to adjust the final location of the 

muscle attachments and ensure their coordinates belong to the bone surface. 
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Figure 5-4 – Schematics of the ICP-based mapping of the muscle points. 

5.2.3. Inertial properties 

The estimate of the kinetics of the various joints requires the definition of the inertial 

parameters of each segment, i.e. their volume and density, as the mass cannot be measured. 

The volume is extracted from the volume of the segmented geometry, whereas the density is 

assigned from literature values: 1.46 kg/cm3 for the bones and 1.02 kg/cm3 (or 1.03 kg/cm3) 

for the soft tissue of females (or males) as estimate by White et al. (1987) accounting for both 

muscle, fat and other soft tissues in the body.  
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Abstract—Juvenile Idiopathic Arthritis (JIA) is a paediatric
musculoskeletal disease of unknown aetiology, leading to
walking alterations when the lower-limb joints are involved.
Diagnosis of JIA is mostly clinical. Imaging can quantify
impairments associated to inflammation and joint damage.
However, treatment planning could be better supported
using dynamic information, such as joint contact forces
(JCFs). To this purpose, we used a musculoskeletal model to
predict JCFs and investigate how JCFs varied as a result of
joint impairment in eighteen children with JIA. Gait analysis
data and magnetic resonance images (MRI) were used to
develop patient-specific lower-limb musculoskeletal models,
which were evaluated for operator-dependent variability
(< 3.6�, 0.05 N kg21 and 0.5 BW for joint angles, moments,
and JCFs, respectively). Gait alterations and JCF patterns
showed high between-subjects variability reflecting the
pathology heterogeneity in the cohort. Higher joint impair-
ment, assessed with MRI-based evaluation, was weakly
associated to overall joint overloading. A stronger correla-
tion was observed between impairment of one limb and
overload of the contralateral limb, suggesting risky compen-
satory strategies being adopted, especially at the knee level.
This suggests that knee overloading during gait might be a
good predictor of disease progression and gait biomechanics
should be used to inform treatment planning.

Keywords—Biomechanics, Musculoskeletal, Gait analysis,

MRI, Musculoskeletal modelling, Lower-limb, Juvenile

arthritis, Opensim.

INTRODUCTION

Juvenile Idiopathic Arthritis (JIA) is a group of
paediatric chronic diseases of unknown aetiology,
particularly affecting the knee and ankle joints,28

which can lead to cartilage damage due to inflamma-
tion, articular malposition and altered mobility.19,28

Current practice to quantify disease activity in JIA is
based on composite tools such as the Juvenile Arthritis
Disease Activity Score (JADAS7). The JADAS con-
sists of the following items: the total number of joints
with active arthritis, the physician and the
patient’s/parent’s global assessment of the disease and
the erythrocyte sedimentation rate as an inflammatory
marker. The physician and patient’s/parent’s global
assessment constitute a subjective element of evalua-
tion of joints status and mobility, and as such can
present strong disagreement.24,29

Medical imaging has been proposed as an alterna-
tive in improving the assessment of JIA with respect to
traditional clinical examination with ultrasound tech-
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niques being used to quantify the tendon and joint
synovial inflammation, or cartilage and bone
integrity.6 More recently, Magnetic Resonance Imag-
ing (MRI) has been introduced to support early diag-
nosis of JIA thanks to more reliable quantification of
synovitis, bone marrow oedema, and bone ero-
sions.17,26 Image-based techniques, however, can only
provide information about local impairment, as usu-
ally assessed in unloaded static conditions, and as such
are not necessarily informative in terms of consequent
functional alterations that could explain different
patterns of pathology progression. For this reason,
gait analysis techniques have been suggested as a tool
to functionally characterise alterations in the joint
kinematics and kinetics of patients with JIA.3,13,15,22

These studies reported hyper-flexion of the hip and
knee joints and reduced plantarflexion of the ankle
joint, with associated reduction in ankle moment and
power as common gait pattern traits of in JIA. These
alterations returned to normal after treatment in the
less severe cases, suggesting a clear connection between
JIA activity and functional impairment.3,13,15 Unfor-
tunately, no insight into the specific causes of the
observed biomechanical alterations that could have
explained the absence of a response to treatment in
more severe cases was provided. Since internal joint
loading is directly related to bone and cartilage load-
ing, it can be hypothesised that its estimate can provide
further insight on the link between joint inflammation
and impaired walking function. Understanding this
link would support more accurate diagnosis and
specific treatment planning. Musculoskeletal (MSK)
modelling of the lower limb can be used for this pur-
pose.42

Several MSK modelling approaches have been
proposed in the literature for representing individual
patients, from the scaling of generic models to match
the subject’s anatomical features1 to more detailed
image-based techniques.2,16,40 The latter has proved
to be a feasible approach for the investigation of
lower limb biomechanics in juvenile populations20,22

and can provide tools to gain insight in disease
mechanisms, especially when MSK dysfunction ap-
pears causing functional limitations and altered
locomotion.8,27,31,32

The aim of this paper is to provide further insight
into the relationship of disease activity and joint
impairment to altered joint loading in children with
JIA, and to highlight compensatory strategies that
potentially lead to joint damage. To this purpose, we
will first establish the repeatability and reproducibility
of a patient specific MSK modelling approach previ-
ously proposed for the analysis of juvenile gait.20 This
approach will then be used to investigate the rela-

tionship between joint involvement (intended as pres-
ence of inflammation and/or cartilage damage in one
or more of the lower limb joints) and the hip, knee and
ankle joint contact forces (JCFs) in a group of children
with JIA. We hypothesised that in the presence of an
active disease, where inflamed joints need to be pro-
tected to prevent pain, a reduction of the internal loads
should be observed. The adopted protection strategies,
however, might also lead to a compensation causing
overloading of other joints in the same or opposite
limb.

MATERIALS AND METHODS

Subjects and Data Acquisition

Eighteen participants (5 males, 13 females, age:
12 ± 3 years, mass: 50.2 ± 17.3 kg, height:
150 ± 16 cm, Table 1) diagnosed with JIA were re-
cruited from two different children’s hospitals
(‘‘Bambino Gesù’’ Children’s Hospital, Rome, Italy,
and Istituto Giannina Gaslini, Genoa, Italy). The
inclusion criteria were ankle arthritis in new onset JIA
or ankle involvement in long lasting JIA (as assessed
by clinical observation) and age between five and six-
teen years. The ethical committees of both hospitals
approved the study and written informed consent was
obtained by the patients’ carers.

Gait analysis data were collected in the two different
hospitals using movement analysis based on infrared
optical stereophotogrammetry. An 8-camera system
(MX, Vicon Motion System Ltd, UK, 200 Hz) with
two force platforms (OR6-6, AMTI, USA, 1000 Hz)
was used in Rome and a 6-camera system (Smart DX,
BTS Bioengineering, Italy, 100 Hz) with two force
platforms (Kistler, UK, 1000 Hz) was used in Genoa.
The marker-set was a combination of the Vicon PlugIn
gait (Vicon Motion System) and the modified Oxford
Foot Model (mOFM) protocols,35 with a total of
fourty-four markers (Fig. 1). A subset of twenty-eight
markers was retained during a following MRI exam
(see Modenese et al.20 for detailed protocol) including
a full lower limb 3D T1-weighted fat-suppression se-
quence (e-THRIVE) with 1 mm in-plane resolution
and 1 mm slice thickness.

Musculoskeletal Modelling Procedure

Eighteen lower limb patient-specific MSK models
were built following the procedure described in
Modenese et al.20 Bone geometries were segmented
from the MRI with a statistical shape modelling
approach.37 The anatomical models were built by one
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expert operator using specialised software
(NMSBuilder39). Nine body segments were included in
the model, namely one pelvis and bilateral femur, tibia,
talus and foot segments. The inertial properties of each
segment were computed accounting for both bone and
soft tissue densities.41 Eight joints were modelled as
ideal ball-and-socket (hip) joint, or ideal hinge (knee,
ankle, subtalar). The articular surfaces were identified
and isolated in Meshlab5 and the joints’ axes of rota-
tion were defined with a morphological fitting
approach using a least square difference minimisation
in MATLAB (v9.1, R2016b, The MathWorks Inc.,
USAMathWorks, USA) and following the ISB con-
ventions.43 Muscle attachments and via points were
calculated through a supervised atlas registration
approach40 based on a reference model11 and manually
adjusted against the MRI if needed.

Musculotendon parameters were modelled as Hill-
type muscle elements.38 Optimal fibre length (lopt),
tendon slack length (ltendon) were scaled to maintain
the lopt/ltendon ratio as in the ‘‘gait2392’’
generic model11 available with the OpenSim distribu-
tion. Pennation angle was set according to the value in
the ‘‘gait2392’’11 and maximal contraction velocity
was set to 10 fibres per second.38 Maximal isometric
force (Fmax) was linearly scaled based on the ratio
between the lower-limb mass of the subject (derived
from the MRI) and of the generic model.11 The force–
length–velocity (FLV) relationship was not considered

during the simulations, thus neglecting contraction
dynamics.20

The experimental markers visible in the MRI were
included into the model as virtual markers and then
registered to those used for the gait analysis within
OpenSim,10 where gait was simulated using the Inverse
Kinematics and Inverse Dynamics routines. Gait data
were normalised over a gait cycle, identified from
subsequent heel strikes of the same limb, which were
determined either from the force platform or from the
foot markers. Joint powers (JPs) were calculated as the
product of joint moment and angular velocity. The
Static Optimisation tool was used to estimate muscle
activations and forces and the Joint Reaction Analysis
tool36 was then used to estimate the JCFs (intended as
the norm of the reaction force vector).

The above modelling procedure entailed two oper-
ator-dependent steps: the identification of muscles
origins, insertions and via points; and the selection of
the joints’ surface for morphological fitting (and con-
sequent definition of joint frames, including their cen-
tre and axes orientation). Three operators were hence
enrolled to assess both inter- and intra-operator vari-
ability of the procedure and their effects on the model
output (Fig. 2). They produced three MSK models
each using data from three randomly selected subjects
(two females, one male, 13.7 ± 1.2 years,
1.63 ± 0.10 m, 68.5 ± 5.3 kg). One of the operators
was also asked to repeat the modelling three times for

TABLE 1. Patients’ anthropometric and clinical details.

Patient Gender (F/M) Age (year) Height (m) Weight (Kg) Sub-type

MRIIndex

Right Left

1 F 10 1.39 41 PsA 0 3

2 F 15.5 1.61 68 Ext oligo 3 3

3 M 14 1.74 76.5 Poly- 0 0

4 F 11 1.45 54 Oligo 0 1

5 F 18.5 1.59 68 Ext oligo 3 0

6 F 16.5 1.68 83 Ext oligo 2 5

7 F 14.5 1.65 54.5 PsA 3 5

8 F 11 1.31 26.6 Poly- 2 0

9 F 14 1.63 63.8 Poly- 0 0

10 F 9 1.29 32.5 Poly- 2 1

11 M 10 1.5 37 Oligo 1 2

12 F 7 1.28 23 UndA 2 1

13 M 7.5 1.17 35.7 Oligo 1 1

14 F 13 1.68 49 Oligo 0 2

15 M 12.5 1.55 45.6 Oligo 0 0

16 M 10 1.36 32 Oligo 1 3

17 F 13.5 1.56 54.5 Oligo 0 0

18 F 13.5 1.54 63.5 Poly- 0 0

Average – 11.9 1.48 47.8 – – –

SD – 3.2 0.17 18.6 – – –

Total 15F – – – – – –

Oligo persistent oligoarticular JIA, Ext oligo extended oligoarticular JIA, PsA psoriatic arthritis, Poly- rheumatoid-factor-negative polyarticular

JIA, UndA undifferentiated arthritis.
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each subject. Intra- and inter-operator variability of
joint angles, joint moments and JCFs were quantified
by standard deviation (SD) and range between repeti-
tions over the entire gait cycle.

Imaging Evaluation Assessment

An MRI-based assessment of joint involvement
was performed for the hip, knee, ankle, and mid-foot
joints. For each joint the MRI inflammation score
was assigned on the short tau inversion recovery
(STIR) sequence using a 0–3 scale based on the
amount of joint effusion (0 = no inflammation;
1 = mild/moderate inflammation; 2 = severe
inflammation). After training and calibration sessions,
the MRIs were read by a paediatric radiologist and a
paediatric rheumatologist with more than 10 years
expertise in musculoskeletal MRI. The readers were
blind to the clinical status of the patient. Any dis-
agreement was resolved by consensus.9 This evalua-
tion highlighted an active disease in 21 out of the 36
investigated limbs (Table 1). A total MRI score
(MRIIndex) was then calculated by adding the values
of both lower limb joints and was used to divide the
patients into two groups: impaired (IM, n = 13) and
non-impaired (NI, n = 5). The NI group was then
used as a control group.

Statistical Analysis

A 1D non-parametric t test was used to compare
joint angles, moments (normalised to body mass times

height21), powers and contact forces (normalised to
body weight, BW), estimated with the MSK simula-
tions in the IM and NI by means Statistical Parametric
Mapping (SPM) in MATLAB, using the SPM1D
package.25

Each patient’s walking biomechanics was charac-
terised using peaks of the hip (FH1, FH2), knee (FK1,
FK2) and ankle (FA) JCFs; area under the hip (AFH),
knee (AFK) and ankle (AFA) JCF curves; peak of ankle
power (PA) and area under the hip (APH), knee (APK)
and ankle (APA) JP curves. For the IM group, the link
between joint impairment and the biomechanical
alterations was investigated analysing the correlation
between the MRIIndex and the JCFs using the cumu-
lative parameter including both limbs’ joints:
JCFIndex= FH1 + FH2 + FK1 + FK2 + FA. Ob-
served correlations were classified as weak
(0.3 < q £ 0.5), moderate (0.5 < q £ 0.7) or strong
(q > 0.7), based on the Spearman’s Rho non-para-
metric test.

The IM group was sub-divided into patients with
mono-lateral impairment (MI, n = 5), and patients
with bilateral impairment (BI, n = 8) to investigate
differences between relevant gait patterns. Dunn’s non-
parametric multiple t test (critical Q value at 2.388)
was used to highlight differences in the biomechanical
parameters among MI, BI and NI using multiple,
stepdown comparisons.4 Robust z score, based on
outlier-insensitive median and median absolute devia-
tion,30 was used to normalise the parameters and
quantify the deviation of the MI and BI groups from
the NI group, intended as a control.

FIGURE 1. Experimental markers used in the stereophotogrammetric protocol (filled and empty dots) and retained during the
imaging (filled dots) and relevant description.
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Finally, the presence of contralateral compensatory
strategies was quantified testing the correlation
(Spearman’s Rho non-parametric test) between the
MRIIndex of one limb and biomechanical parameters
measured for the same limb and for the opposite limb.
Significance was set to a = 0.05 for all the statistical
tests.

RESULTS

The three operators detected the muscle origins and
insertions with an intra- and inter-operator variability
of 1.2 ± 0.6 mm and 2.2 ± 1.0 mm, respectively. In-
tra- and inter-operator SD in the identification of the
joint centres and axes orientation from morphological
fitting was below 3 mm and 3�, respectively (Table 2),
except for one model where intra- and inter-operator
SD of the ankle axes orientation reached 5.2� and 8.3�.
The propagation of these uncertainties to the models’
output, led to a maximum SD of joint angles and
moments which was always below 3.0� and
0.03 N kg21, respectively, for the intra-operator anal-
ysis and below 3.6� and 0.05 N kg21, respectively, for
the inter-operator analysis. The average percentage of
SD with respect to the range of motion (ROM) was
always below 10% except for the inter-operator SD of
two models’ subtalar angles (Table 3). Intra- (Fig. 3a)
and inter- (Fig. 3c) operator variations of the JCFs
and their variations between-repetition (Figs. 3b and
3d) were all below 0.3 BW and 0.5 BW (equivalent to
less than 10% of peak value).

The 1D t test between the IM and NI groups
(Fig. 4) showed a significant difference only in the
early stance phase of the hip moment, where the IM
average joint flexion moment was up to 0.4 N m kg21

smaller than NI, and in the second peak of the knee
contact force, where the IM average JCF was up to 0.8
BW higher than the NI. All the remaining time-de-
pendent comparisons were not significant.

Table 4 shows the values obtained for the biome-
chanical parameters in the three groups. A meaningful
statistical analysis was hindered by the low sample size,
but the values did not seem to suggest a clear trend in
the differences between the two limbs within the
groups. Relevant values were then grouped to calculate
the normalised z score used to build the radar plots in
Fig. 5, which summarises the deviation of BI and MI
groups from the biomechanical pattern shown by the
NI groups. Visual analysis of the graphs suggests an
overall tendency of BI to excessively load the knee
when compared to the other two groups. The largest
differences were observed for the PA (z = 2 3.0 and
z = 2 1.6 for BI and MI, respectively), FK1

(z = 2 1.9 for MI), FK2 (z = 1.7 for BI), APK

(z = 2 1.1 for MI), FA (z = 1.1 for BI). Peculiarly,
FK1 and APK showed a discordant deviation, with
positive z score for the BI and negative z score for the
MI. Dunn’s test (Qcritic = 2.388) highlighted a signif-
icantly higher FK1 (Q = 2.8468) in the BI group
compared to the MI (with 0.6 BW average difference)
and FK2 (Q = 4.0224), in the BI group compared to
the NI (with 1 BW average difference).

A moderate correlation (q = 0.597, p = 0.031) was
observed between the MRIIndex and JCFIndex (Fig. 6).
When observing the link between MRIIndex of a single
limb and the biomechanical parameters, a significant
weak correlation was observed only for the FH1

(q = 0.490, p = 0.011), APK (q = 0.472, p = 0.015)
and APA (q = 0.390, p = 0.049). When analysing the
compensatory mechanisms involving the contralateral
limb, significant weak to strong correlations were

FIGURE 2. Outline of the repeatability study.
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found for FH1 (q = 0.501, p = 0.009), AFH

(q = 0.712, p < 0.001), PA (q = 0.544, p = 0.004),
FK1 (q = 0.427, p = 0.029), FK2 (q = 0.521,
p = 0.006), and AFK (q = 0.405, p = 0.040).

DISCUSSION

In this study, we proposed an MRI-based MSK
model of the lower limb to investigate the relationship
between joint impairment and joint loading during gait
in a cohort of children with JIA, which was charac-
terised by a variety of disease manifestations and
consequent gait alterations. The reported results dis-
couraged any hypothesis of a unique pre-
dictable cause–effect relationship, which suggests that
adding a dynamic functional gait assessment to the
image-based patient evaluation might help to better

identify joints at risk of critical compensatory over-
loading and hence better inform personalised treat-
ment. Furthermore, it clearly emerged that patient-
specific models do have an ability to combine multiple
data into coherent, physics-based predictions that ap-
pear to be strongly discriminative even in a dramati-
cally heterogeneous population like the one
investigated here. Thus, these methods should be
pursued to clinically investigate the complex compen-
satory strategies that JIA flares produce and the effect
that such strategies may have on the response to first
line treatments.

The model adopted in this study presented some
limitations. Firstly, the joints were schematised as ideal
joints. This simplification is commonly accepted for
the hip, being well described by the ball-and-socket
coupling but represents a limitation in the under-
standing of knee and ankle motion.34,44 A second
limitation was the estimation of musculotendon
parameters. They were linearly scaled to lower-limb
mass from a generic model available in the literature 11

where these parameters were specified for only a single
nominal subject. Experimental data suggest that mus-
culotendon parameters are highly variable between
subjects, especially when anthropometrical differences
are considerable (i.e., children vs. adults), therefore
linear scaling of these quantities might not be appro-
priate for a juvenile population. On the other hand, a
direct and non-invasive measure of these parameters is
not possible in vivo. Future study will aim at improving
this aspect, implementing methods to extract more

TABLE 3. Repeatability of model output.

Hip flex/ext Hip ab/ad Hip int/ext Knee flex/ext Ankle PF/DF Subtalar inv/ev

Joint angles (% ROM)

M1

Intra 0.6 ± 0.3 1.5 ± 0.4 3.8 ± 0.7 0.6 ± 0.4 7 ± 2.3 9.5 ± 3.2

Inter 0.4 ± 0.3 2.7 ± 1.5 5.8 ± 2.1 0.5 ± 0.2 7.8 ± 1.3 12.2 ± 2

M2

Intra 1.2 ± 1.2 3.6 ± 1.8 5.2 ± 4.6 1.0 ± 0.6 9.6 ± 6.3 5.6 ± 4.9

Inter 2.4 ± 0.3 7.6 ± 1.4 6.1 ± 2.5 2.6 ± 0.5 4.4 ± 0.9 16.8 ± 5.3

M3

Intra 0.4 ± 0.1 2.0 ± 1.0 2.9 ± 0.2 0.4 ± 0.1 1.7 ± 0.7 4.0 ± 0.0

Inter 3.7 ± 3.7 2.7 ± 1.5 9.4 ± 3.6 1.7 ± 0.7 5.6 ± 3.2 4.2 ± 1.6

Joint moments (% PP)

M1

Intra 0.8 ± 0.1 0.5 ± 0.0 1.0 ± 0.6 0.7 ± 0.6 0.3 ± 0.1 1.6 ± 0.4

Inter 0.8 ± 0.1 0.5 ± 0.2 1.5 ± 0.1 0.7 ± 0.4 0.3 ± 0.0 2.9 ± 1.0

M2

Intra 1.0 ± 0.5 0.9 ± 0.5 1.5 ± 0.5 1.3 ± 0.3 0.3 ± 0.0 3.0 ± 0.7

Inter 2.1 ± 0.8 1.0 ± 0.2 3.3 ± 0.2 2.9 ± 0.6 0.8 ± 0.0 7.5 ± 2.6

M3

Intra 0.4 ± 0.0 0.6 ± 0.1 0.8 ± 0.3 0.9 ± 0.4 0.2 ± 0.0 1.5 ± 0.3

Inter 0.9 ± 0.6 0.8 ± 0.0 8.4 ± 8.5 1.9 ± 0.9 0.5 ± 0.5 3.6 ± 2.8

Mean ± SD percentage of joint range of motion (ROM) and peak-to-peak moment (PP) for the intra- and inter-operator SD over the gait cycle

for the three models (M1–3).

TABLE 2. Repeatability of operator dependent input.

Joint centre (mm) Axes orientation (�)

Intra Inter Intra Inter

Hip 0.2 ± 0.1 0.2 ± 0.1 1.6 ± 0.9 0.9 ± 0.2

Knee 1.3 ± 1.6 2.0 ± 0.8 1.7 ± 1.1 1.6 ± 0.5

Ankle 0.5 ± 0.1 1.0 ± 0.6 4.0 ± 1.8 3.9 ± 3.8

Subtalar 0.8 ± 0.2 1.5 ± 0.7 1.0 ± 0.2 1.0 ± 0.3

Mean ± SD (across the three models) of the intra- and inter-

operator SD of joint centre and axes orientation (defined as the

average SD over the three joint axes) for the lower limb joints.
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information from MRI (such as moment arm, indi-
vidual muscle volume and cross-sectional area).
Modenese et al.20 showed that the choice of the scaling
method does not influence the resulting JCFs if the
FLV relationship is taken into account. Here, on the
contrary, contraction dynamics was neglected, poten-
tially causing the overestimate of the second knee
contact force peak.20 However, the consistency of this
choice throughout all the simulations did not affect the
comparison between impaired and non-impaired sub-
jects’ JCFs. Finally, we applied the Static Optimisation
technique to estimate muscle forces assuming an

optimal force distribution strategy. This might not be
the case in a pathological population, where subopti-
mal mechanisms can be adopted aiming at reducing
joint loading.12

Despite the above limitations, the proposed
approach led to satisfactory intra- and inter-operator
repeatability of the estimated output in the context of
the investigated application. The variability observed
in the input did not substantially affect the output of
the simulations, with limited variations observed for all
joint kinematics and kinetics and for the joint contact
forces. The combined effect of mis-locating joint centre

FIGURE 3. Repeatability of the model output: example of mean and SD (shadow) over three walking trials of hip, knee and ankle
JCFs for one model (left and right side in red and black, respectively) built by the same operator three times (a) and three different
operators (c). Ranges of variation of JCFs for (b) intra-operator and (d) inter-operator analysis
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and axes and misidentifying muscle points led to an
overall uncertainty of 0.5 BW, which is lower than
10% of the estimated peak values. The operator-re-
lated uncertainty found in the repeatability study was
considered reasonable to safely apply the modelling

protocol in a clinical scenario to estimate joint angles,
moments, powers and contact forces, and to investi-
gate the link between joint impairment and alteration
of the relevant biomechanical parameters in JIA.
Lower repeatability was observed for the movements
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out of the sagittal plane, for this reason, only flexion/
extension movements were investigated in this study.
This choice is certainly a limitation, but it is in line with
previous gait analysis studies on JIA children.3,15,19,22

The uncertainty in the identification of the joint
centre and axes was similar to what has been reported
in the literature18 for the knee and ankle joints of
healthy adults (up to 6.4 mm and 4.5� and up to
4.6 mm and 4�, respectively), leading to JCF variations
of up to 9% of peak values. Previous studies demon-
strated that the repeatability of JCF estimates is highly

dependent on the definition of muscle geometries.
Navacchia et al.23 showed that muscle path uncertainty
can have an average 10% effect on the predicted JCFs.
In a previous study investigating a juvenile ankle
model,14 our group reported up to 20% of peak ankle
JCF variability due to intra- and inter-operator
uncertainties in muscle point identification equal to
1.7 ± 1.9 and 3.0 ± 2.5 mm, respectively, with maxi-
mum values up to 14.3 mm for single points. The intra-
and inter-operator variability of muscle points in the
present study was reduced to 1.2 ± 0.6 and
2.2 ± 1.0 mm, respectively, with maximum values of
5 mm. This progress was the result of an improved
identification of the set of bony landmarks used for the
supervised registration of muscle points.20 Nonethe-
less, since muscle paths are a well-known critical factor
in the estimate of moment arms, muscle forces, and
JCFs,33 future investigations should focus on further
automating and improving this step.

The modest propagation of the input uncertainty on
the models’ predictions made these patient-specific
models highly discriminative; we were able to highlight
significant differences between individual patients, and
between limbs in the same patients. However, the co-
hort of children enrolled in this study was charac-
terised by a high clinical heterogeneity with different
JIA subtypes and severity. Five children, despite a
history of JIA, did not present active disease at the
time of the visit, and were therefore classified as not
impaired. Eight patients presented bilateral impair-
ment and five mono-lateral impairment, mostly
affecting the knee and ankle joints. This heterogeneity
clearly affected the results of the group analysis of
disease-related gait pattern, due to a large variability in
the average joint angle, moment, and power curves.
Consequently, no specific pathology-related pattern

TABLE 4. Inter-group analysis.

BI (n = 16) MI (n = 10)
NI (n = 10)

Most affected limb Less affected limb Affected limb Non-affected limb
�X (range) �X (range) �X (range) �X (range) �X (range)

Hip FH1 (BW) 3.9 (2.6/5.8) 4.2 (3.4/5.5) 3.7 (3.2/4.2) 3.3 (2.9/4.1) 3.9 (3.1/5.2)

FH2 (BW) 4.1 (3.8/6) 4.7 (3.6/6.1) 3.8 (3.4/3.9) 4 (3.7/5.6) 3.8 (2.7/4.3)

AFH (BW s) 1.4 (1.6/2.3) 1.9 (1.7/2.4) 1.7 (1.5/1.7) 1.9 (1.6/2.1) 1.8 (1.6/2.1)

APH (W s kg21) 0.3 (0.1/0.4) 0.3 (0.2/0.4) 0.2 (0.1/1.0) 0.2 (0.1/0.3) 0.3 (0.2/0.4)

Knee FK1 (BW) 2.6 (2.1/4.5) 2.7 (2.2/3.6) 2.0 (1.9/3.5) 2.1 (1.7/3) 2.5 (2.2/3.1)

FK2 (BW) 3.7 (2.9/4.4) 4 (3/5.1) 2.8 (2.6/3.2) 3.4 (2.9/3.9) 2.7 (2.3/3.5)

AFK (BW s) 1.3 (1.1/1.5) 1.4 (1.2/1.6) 1.3 (1.1/1.6) 1.3 (1.1/1.7) 1.2 (1.1/1.5)

APK (W s kg21) 0.3 (0.1/0.5) 0.3 (0.1/0.4) 0.2 (0.1/0.4) 0.2 (0.2/0.3) 0.3 (0.2/0.5)

Ankle FA (BW) 6.6 (5.4/8.1) 6.4 (5.3/7.7) 6.0 (5.2/7.2) 6.3 (5.5/7.4) 5.7 (4.3/7.7)

AFA (BW s) 1.9 (1.5/2.2) 1.8 (1.6/2.2) 1.9 (1.7/2.6) 2.0 (1.7/2.1) 1.8 (1.4/2.1)

PA (W kg21) 2.7 (2.4/4.8) 2.9 (2.2/4.3) 2.4 (1.9/3.3) 2.9 (2/3.4) 3.9 (2.2/4.7)

APA (W s kg21) 0.4 (0.3/0.5) 0.4 (0.3/0.5) 0.3 (0.3/0.9) 0.4 (0.3/0.5) 0.4 (0.2/0.5)

Medians (�X) and ranges of the JCF and JP parameters for the three groups with n representing the number of limbs in each group.
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F H2  [BW]

A FH [BW s]

A PH [W s kg -1]

FK1
 [BW]
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A
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NI† 

∗
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FIGURE 5. Radar plot visualisation of the JCF and JP
parameters normalised using robust z score. * = BI group
significantly different from MI; � = BI group significantly
different from NI.
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was detected in the IM group kinematics, contrary to
what was reported in a previous study,15 where hyper-
flexion of the hip and knee joints and reduced plan-
tarflexion in the ankle were found to be a common trait
in 36 patients with symmetrical polyarticular joint
involvement. A possible explanation for this discrep-
ancy can be found in the reduced numerosity (n = 5)
of our non-impaired group, and in the fact that JIA-
related joint inflammation had been reported for these
children within the previous 12 months. As such, ra-
ther than fully representative of a healthy population,
their gait biomechanics was that of a group of indi-
viduals capable of responding to the disease activity by

leveraging on loading and walking strategies that en-
abled them to reduce joint inflammation and pain.

The limited number of participants and the vari-
ability of their clinical status drove the choice of using
a cumulative impairment scoring index (accounting for
all the lower limb joints), which prevented the inves-
tigation of individual contributions of each joint and
the impact of different involvement levels to the overall
functional alteration. Larger and more homogeneous
datasets would be necessary to overcome this limita-
tion. Nonetheless, the cumulative JCFIndex was found
to be moderately correlated to disease activity level in
the lower limbs, and when analysing the joints sepa-
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rately, a significantly higher (up to 15%) knee peak
contact force was observed during push off in the IM
group. This result was partially confirmed when
investigating distinctive features of mono-lateral and
bilateral impaired groups. In fact, a positive z score
was observed for all the JCF parameters of the BI,
resulting in the overloading of the joints, with partic-
ular significance for the knee (FK1 and FK2).

When the behaviour of the two limbs was investi-
gated separately, the presence of compensatory load-
ing strategies became evident, with an increased
loading of the contralateral hip (higher AFH) in the
most impaired patients. Additionally, overloading of
the hip arose for both limbs in the first phase of the
stance (higher FH1). An overall higher loading of the
knee (AFK) was observed, especially during push-off
phase (FK2), in the less affected limb as a possible
strategy for protecting the painful joints. This exces-
sive loading might be one of the causes for further
development of the pathology. From this perspective,
the knee joint loading might be the best variable to
monitor in order to predict disease progression and
guide treatment.

In conclusion, this paper presented for the first time
the application of a juvenile subject-specific MSK
modelling approach to the investigation of the link
between joint impairment and joint loading during
walking in children with JIA. The model ensures
repeatable estimates of lower-limb biomechanical
parameters and the results of its application encourage
further development of this approach as a support of
the current clinical practice for understanding and
preventing functional alterations associated to exces-
sive joint loadings. In this sense, only knee JCF
resulted as a good candidate for predicting JIA activity
and potential indicator of compensatory mechanism
associated to mono-lateral involvement, but future
longitudinal studies are needed to test this hypothesis.
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Viceconti, and C. Mazzà. Investigation of the dependence
of joint contact forces on musculotendon parameters using
a codified workflow for image-based modelling. J. Biomech.
73:108–118, 2018.

21Moisio, K. C., D. R. Sumner, S. Shott, and D. E. Hurwitz.
Normalization of joint moments during gait: a comparison
of two techniques. J. Biomech. 36(4):599–603, 2003.

22Montefiori, E., L. Modenese, R. Di Marco, S. Magni-
Manzoni, C. Malattia, M. Petrarca, A. Ronchetti, L. T. de
Horatio, E. H. P. van Dijkhuizen, A. Wang, S. Wesarg, M.
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7.1. Abstract  

Goal: This study investigated the importance of muscle anatomical personalisation when 

estimating joint contact forces (JCFs) using musculoskeletal models (MSKMs) in a cohort of 

post-menopausal women. Methods: Motion capture and Magnetic Resonance Imaging data 

were used to produce three lower-limb MSKMs for eleven women: 1) a generic-scaled model 

(Gen); 2) a hybrid model (Hyb) with personalised joints and scaled muscle parameters; 3) a 

subject-specific model (SSp) with personalised joints and maximal isometric force (Fmax) 

estimated from muscle volume (VM) and musculotendon length (lMT). Within- and between-

subject comparison of VM and lMT was assessed to quantify asymmetry and anatomical 

variability across the cohort. Linearly scaled and personalised Fmax were compared and the 

effect of model personalisation on the estimated JCFs (OpenSim) was also assessed. Results: 

VM and lMT differed by up to 45% and 25%, respectively, both within and between subjects. 

Fmax varied by up to 230% when scaled or personalised leading to different muscle activation 

patterns affecting the muscle force estimates. JCFs were highly patient-specific and inter-

model differences ranged between -1.2÷2.6 BW, -1.4÷1.5 BW, and -1.0÷1.8 BW at the hip, 

knee, and ankle, respectively. Conclusion: The observed anatomical variability suggested that 

personalisation of Fmax should be pursued especially in certain clinical contexts, i.e. prediction 

of osteoporotic fracture, joint replacement or cerebral palsy. Significance: The proposed SSp 

model accounts for the first time for anatomical variability and asymmetry including 

personalised Fmax. A unique image-based dataset of bone and muscle anatomy of older 

women is now available to foster research in this field. 
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7.2. Introduction 

Musculoskeletal (MSK) modelling is increasingly being adopted to estimate joint contact and 

muscle forces during dynamic tasks (Delp et al., 2007, Delp et al., 1990, Giarmatzis et al., 2015, 

Jonkers et al., 2008, Liu et al., 2008, Steele et al., 2010). Information about joint loading and 

muscle forces can be of particular interest in older individuals where both joint integrity and 

muscle strength are reduced, such us in the presence of sarcopenia, osteopenia, or 

osteoporosis. 

MSK modelling techniques are often based on generic MSK models to be scaled to the subject 

anthropometric measures (Delp et al., 1990, Giarmatzis et al., 2015, Jonkers et al., 2008, Liu 

et al., 2008). However, these approaches tend to rely on many geometrical and anatomical 

assumptions, neglecting the individual variability and therefore, knowingly affecting the 

accuracy of the model outcomes (Bahl et al., 2019, Gerus et al., 2013, Martelli et al., 2015, 

Prinold et al., 2016, Scheys et al., 2006, Scheys et al., 2008a, Scheys et al., 2008b, Valente et 

al., 2014, Wesseling et al., 2016). Recently Ding et al. (2019) quantified how anthropometry 

(namely body mass, limb length and limb length to pelvis width ratio), together with gender, 

are particularly relevant when scaling a model. Bahl et al. (2019) observed errors of 37 mm in 

the identification of hip joint centre when using scaled models in populations with hip 

osteoarthritis and high body mass index. This error translated in erroneous estimates of hip 

muscles moment arm, especially affecting the flexor muscles. Additionally, scaled models do 

not account for loss of muscle strength typically associated to ageing (Brooks and Faulkner, 

1994), which can be both subject- and muscle-specific (Maden-Wilkinson et al., 2013). These 

factors can influence the estimated muscle force distribution and thereby joint contact force 

(JCF) estimation (Ackland et al., 2012, De Groote et al., 2010). Therefore, a few studies have 

questioned whether the use of generic-scaled models with unscaled or linearly scaled muscle 

properties (derived from data of adult specimens) should be considered appropriate when 

investigating muscle function in pathological or juvenile populations (Kainz et al., 2018, 

Modenese et al., 2018). An attempt to overcome this limitation has come from clinical 

measurements of muscle strength (i.e. hand-held dynamometers), which however are not 

muscle-specific but rather assess muscle functional groups (Kainz et al., 2018). 
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Other authors investigated the effect of personalising geometrical and architectural muscle-

tendon parameters, finding a moderate, but muscle-specific, sensitivity of models’ output to 

maximal isometric force (Ackland et al., 2012, Valente et al., 2014). However, these studies 

were either based on the perturbation of the muscle parameters within small ranges (Ackland 

et al., 2012) or proportionally for all the muscles (Valente et al., 2014), therefore neglecting 

muscle or subject specificity in the variability of parameters such as maximal muscle 

stress (Buchanan et al., 2004).  

Wesseling et al. (2016) presented an overview of the effect of different levels of model 

personalisation limited to the estimate of the hip JCF showing how highly personalised models 

can provide estimates of the first hip JCF peak more similar to those measured in-vivo with an 

instrumented prosthesis (Bergmann et al., 2001). They especially stressed the role of 

personalised muscle geometry, achieved introducing wrapping surfaces. Carbone et al. (2016) 

investigated the sensitivity of models to variations in the both MSK geometry and 

musculotendon (MT) parameters, highlighting its muscle-specificity. Arnold et al. (2010) used 

the average MT values from a large cadaveric dataset (n=21) (Ward et al., 2009) to personalise 

their model, reaching the conclusion that tuning individual muscle parameters might provide 

results that compare better to experimental measurements (Arnold et al., 2010). This 

conclusion supported the formulation of our hypothesis that intra- and inter-subject 

anatomical variability should be accounted in MSK models. In particular, we hypothesised 

that muscle volumes and, as a consequence, muscle paths and MT lengths might be especially 

variable across elderly due to preferential atrophy and muscle loss happening after a certain 

age (Handsfield et al., 2014). From here the choice of investigating anatomical variability in a 

cohort of older women. Additionally, to the best of our knowledge, a comprehensive analysis 

of the effect of an anatomical personalisation that includes both skeletal and MT parameters 

on the estimates of JCFs for the three main joints of the lower limb is still lacking in this 

population. 

Therefore, the aim of this study was to investigate the effects of different levels of model 

personalisation on the estimation of the JCFs and muscle forces in postmenopausal women. 

To assess this, we created a linear scaled generic model as well as two subject-specific models, 

one with personalised skeletal and joint geometries and one with additional personalisation 



115 
 

of muscle paths and maximal isometric force (Fmax). These models were applied to estimate 

joint contact forces (JCFs) in the main lower-limb joints of our cohort.  

One of the barriers to image-based personalisation of MSK models is in the fact that this is 

highly time consuming and operator dependent. A few recent studies (Modenese et al., 2018, 

Montefiori et al., 2019, Scheys et al., 2006) have tried to promote standardised 

methodologies where an automated procedure can reduce modelling time. In this 

perspective, the availability of a database including muscles and bone geometries as obtained 

from Magnetic Resonance Imaging (MRI) segmentations would be essential to foster data and 

methods sharing and to promote the development of approaches based on statistical shape 

modelling or similar as an alternative to scaling from generic cadaver data. Ding et al. (2019) 

has proposed such a database for healthy young adults, however, the adoption of such data 

in studies involving older participants might not be appropriate.  

The secondary aim of this study was hence that of providing the scientific community with an 

image-based dataset of bone and muscle anatomy of older individuals to foster the 

development of automatic image processing and modelling tools. 

7.3. Methods 

7.3.1. Participants and data acquisition 

Eleven postmenopausal women (69±7 y, 66.9±7.7 kg, 159±3 cm) with osteopenia or 

osteoporosis presented to the Metabolic Bone Centre, Northern General Hospital in Sheffield, 

UK were recruited for this study. Inclusion criteria were having a DXA bone mineral density T-

score at the lumbar spine or total hip (whichever is the lower value) below or equal to 1. 

Exclusion criteria included:  BMI <18 or >35, history of or current conditions known to affect 

bone metabolism and bone mass density, history of or current neurological disorders, 

prescription of oral corticosteroids for more than 3 months within the last year, history of any 

long term immobilisation (>3 months), conditions that prevent the acquisition of 

musculoskeletal images, use of medications or treatment known to affect bone metabolism 

other than calcium/vitamin D supplementation and alcohol intake greater than 21 units per 

week. The study was approved by the UK NHS research ethics committee. The study was 

approved by the Health Research Authority East of England – Cambridgeshire and 
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Hertfordshire Research Ethics Committee and was conducted in accordance with the 

Declaration of Helsinki. Written informed consent was obtained from all participants. 

Participants attended the hospital on one occasion. During this visit, participants underwent 

a 3D gait analysis and a lower limb MRI scan.  

Gait analysis 

For the gait analysis, participants were asked to walk along a 10 m walkway barefoot at a self-

selected walking speed. Marker trajectories from five valid walking trials were recorded at 

100 Hz using a 12-camera motion capture system (Vicon, Oxford, UK). A modified Vicon plug-

in-gait marker set was used (Figure 7-1). Ground reaction forces were simultaneously 

acquired at 1000 Hz using two force platforms (Kistler, Winterhur, Switzerland). Vicon Nexus 

was used to label marker trajectories and fill gaps <5 frames. Prior to the MRI scans, the 

position of several motion capture markers was drawn on the skin to allow exact replacement 

with MRI-visible markers during the scan. 

Surface electromyography (EMG) data (Cometa srl, Milan, Italy) were recorded from five 

muscles: Vastus medialis, Biceps femoris long head, Gastrocnemius medial and lateral, Tibialis 

anterior. 

Magnetic Resonance Imaging 

Full lower limb MRI was collected using a Magnetom Avanto 1.5 T scanner (Siemens, Erlangen 

Germany). A T1-weighted scanning sequence was used with an echo time of 2.59 ms, a 

repetition time of 7.64 ms, flip angle of 10 degrees and voxel sizes of 1.1x1.1x5.0 mm for the 

long bones and 1.1x1.1x3.0 mm for the joints. Within the MRI scans, all lower limb bones 

were segmented using Mimics 20.0 (Materialise, Leuven, Belgium).  In each limb, 23 muscles 

were segmented, initially using the automated muscle segmentation toolbox (Mimics 

Research 20.0, Materialise, Belgium), after which the necessary manual adjustments were 

performed. To assess the inter-operator repeatability of the muscle segmentation procedure, 

muscle volume (VM) of three participants were determined independently by three different 

operators.  
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Figure 7-1 - Marker placement as used during gait analysis and MRI scanning. Sixteen markers 
were placed during both gait analysis and MRI (filled red circles), nine extra markers were only 

used during gait analysis (open red circles). EMG of five muscles (blue closed circles) was collected 
during gait analysis. 

7.3.2. Musculoskeletal models 

Three MSK models (Figure 7-2) were created for each individual with a different level of 

personalisation to estimate JCFs at the hip, knee, and ankle: (1) a generic-scaled MSK model 

(Gen); (2) a hybrid MSK model based on subject-specific bone geometries (Hyb); (3) a MSK 

model with subject-specific bone geometries as well as a personalised muscle parameters 

(SSp). Hyb and SSp models were complemented with virtual markers (visible in the MRI) used 

for the registration with gait analysis data. 

Generic-scaled model (Gen) 

The OpenSim gait2392 (Delp et al., 1990) model was adapted to include the experimental 

marker set used during the gait analysis and six additional markers corresponding to the 

joint’s centres. The torso, with relevant joints and muscles, was removed and subtalar and 

metatarsophalangeal joints were locked.  Best practice recommendations (Hicks et al., 2015) 

were followed to scale the model using the OpenSim Scaling Tool, with a maximum marker 
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error and RMS error below 2 cm and 1 cm, respectively. Joint centres were calculated from 

gait markers through the Harrington method (Harrington et al., 2007) (hip), or computed as 

the mid-point between condyle or malleoli experimental markers (knee and ankle, 

respectively). Body segments were scaled based on the ratio between pairs of corresponding 

experimental (from a static standing trial, including joint centre markers) and model markers 

placed on the generic model. The segment inertia was scaled based on the total body mass.  

MT units were modelled using a three element Hill-type muscle model (Thelen, 2003), 

requiring the definition of the following five MT parameters: optimal fibre length (lopt), tendon 

slack length (lTS), pennation angle, maximal contraction velocity and Fmax. The lopt and lTS were 

scaled to maintain the lopt/lMT and lTS/lMT ratios of the generic gait2392 model (lMT = 

musculotendon length). The pennation angle was set according the gait2392 model and 

maximal contraction velocity was set to 10 fibres per second (Thelen, 2003). Values for Fmax 

were linearly scaled to the whole-body mass from the gait2392 model according to the 

following equation: 

𝐹𝑚𝑎𝑥 =
𝑚

𝑚𝐺𝑒𝑛
∗ 𝐹𝑚𝑎𝑥𝐺𝑒𝑛 

where m is the mass of the subject, mGen is the mass of the gait2392 model and FmaxGen is the 

default Fmax of the muscles in the gait 2392 model. 

Hybrid model (Hyb) 

The hybrid model was created segmenting bone geometries from the MRI and adapting a 

previously published modelling technique (Modenese et al., 2018, Montefiori et al., 2019), 

with the muscle origin and insertions directly identified on the MRI images. The kinematic 

model included seven body segments (pelvis, two femurs, two tibias, two feet) articulated by 

six joints. The hip joint was modelled as a ball-and-socket, and the knee and ankle as ideal 

hinges. 

MT units were parametrised as previously described for the Gen model but updating lopt and 

ltendon with the values calculated from the origins and insertions identified on the MRI images. 

Fmax was scaled to the lower-limb mass according to:  

𝐹𝑚𝑎𝑥 =
𝑚𝐿𝐿

𝑚𝐿𝐿𝐺𝑒𝑛
∗ 𝐹𝑚𝑎𝑥𝐺𝑒𝑛 
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where mLL is the mass of the lower limb of the subject, calculated as a product of the volume 

of the lower limb (estimated from the MRI) and the density of the tissue (White et al., 1987)) 

and mLLGen is the mass of the lower limb of the gait2392 model.  

Subject-specific model (SSp) 

The SSp model was built adapting the Hyb model and differed from it for the definition of 

muscle points and Fmax. Where possible, muscle paths from the Hyb model were adjusted 

checking against the MRI and moving via points to better match the centreline of the 3D 

segmentation. In particular, this was done for: origin points of the Gluteus medius and 

minimus, and Soleus; via points of the Iliacus, Psoas, Rectus femoris, Tensor fasciae latae, 

Semimembranosus, Gastrocnemius medial and lateral, and Sartorius; insertion points of the 

Gastrocnemius medial and lateral, and Soleus. The Fmax was calculated on the basis of the 

well-known relationship with physiological cross-sectional area (PCSA) (Fick, 2012) using 

segmented muscle volumes according to: 

𝐹𝑚𝑎𝑥 = k ∗
𝑉𝑀

𝑙𝑜𝑝𝑡
 

where k is the specific tension (61 N/cm2, (Arnold et al., 2010)), VM is the volume of the 

segmented muscle, and VM/lopt corresponds to the muscle PCSA 

To further evaluate the differences between the SSp and the Hyb models, two intermediate 

models were built: HybSSpPath, where the Hyb model was complemented with personalised 

muscle path from the MRI segmentations; HybSSpFmax, where the Hyb model had Fmax 

calculated from the MRI VM. 
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Figure 7-2 – A) Gen model, with scaled joint axes and muscle geometry (OpenSim Scaling Tool); B) 
joint axes identification through morphologic fitting in Hyb and SSp; C) identification of the 
muscle attachments and via points from manual palpation of the MRI in the Hyb model; D)  

identification of the muscle attachments and via points from the centre line of the  segmentations 
in the SSp model; E), F), G) calculation of the muscle parameters for Gen, Hyb and SSp, 

respectively. 

Dynamic simulations 

Joint angles and moments were computed with the Inverse Kinematics (marker weights set 

to 1 for all the markers) and Inverse Dynamics (coordinates filtered at 6 Hz) tools in OpenSim 

3.3 using the MATLAB API (v9.1, R2017b, Mathworks, USA) and following the OpenSim 

recommendations (Hicks et al., 2015). Static Optimisation was then run minimizing the sum 

of muscle activations squared (Anderson and Pandy, 2001) and neglecting the force-length-

velocity (FLV) relationship of the muscles to compute their force and activation. This choice 

was motivated by the fact that including FLV relationship led to saturation of most of the 

muscle activations. This was likely due to the use of personalised muscle parameters, instead 

of the default parameters, for whom the FLV relationship was meant to be implemented. This 

choice was pursued for all the models and simulations. Ideal moment generators (reserve 
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actuators), providing joint torque when muscle forces could not balance the external 

moments, were included for each degree of freedom, but made unfavourable to recruit by 

assigning them a unitary maximum force. Finally, Joint Reaction Analysis (Steele et al., 2012) 

was run to calculate joint contact forces (JCFs).  

All analyses were repeated for the three modelling approaches and for all trials. A qualitative 

validation was performed comparing the estimated muscle activations to measured EMG data 

(when available) and by ensuring the contribution of reserve actuators to joint dynamics 

never exceeded 5% (van der Krogt et al., 2012). Joint angles, moments and resultant JCFs 

(scaled to body weight, BW) were estimated for the hip, knee and ankle and averaged among 

the available trials for each subject and each modelling approach.  

7.3.3. Data analysis 

Intra- and inter-operator repeatability of the muscle segmentation and consequent VM 

calculation was assessed for the 22 muscles fully visible in the MRI by calculating the 

maximum standard deviation (SD) and coefficient of variation (CoV) over three repetitions. 

All muscle segmentations used for the following analyses were generated by the same expert 

operator.  

To discard the hypothesis of anatomical symmetry, the differences between the VM of the 

muscles belonging to the left and right limbs were assessed with a paired t-test (significance 

level, α=0.05) and the CoV between subjects was quantified. The same analysis was used to 

investigate the symmetry of the lMT, as calculated after extracting the paths of the 30 analysed 

muscles (22 muscles including 4 with three bundles) from the centre lines of the 

segmentations.  

The effect of personalising VM and lMT on the calculated lTS, lopt, and Fmax was quantified by 

comparing the values in the Hyb and SSp and reported as a percentage difference for the right 

and left limb separately. This choice was dictated by the interest in understanding the 

propagation of possible asymmetries observed in the VM and lMT to the lTS, lopt, and Fmax.  A 

paired t-test was used to investigate statistical significance of the observed differences in the 

30 muscles personalised in the models. 
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A repeated measure ANOVA (α=0.05) was used to compare the JCFs estimated with the three 

different MSK approaches by means of 1D statistics based on Statistical Parametric Mapping 

(SPM) in MATLAB, using the SPM1D package (SPM1D, www.spm1D.org, v M.0.4.5, (Pataky, 

2012)). If statistical significance was reached, post hoc independent paired t-tests were 

performed to determine between which groups significant differences occurred. Bonferroni 

corrections were used to calculate the critical p-value used for post hoc analysis being set to 

p=0.017. A further repeated measure ANOVA (α=0.05) assessed differences between peak 

JCFs using the Hyb and SSp and the intermediate models HybSSpPath and HybSSpFmax. Post hoc 

independent paired t-tests were run when relevant (Bonferroni correction, p=0.0125).  

7.4. Results 

Inter-operator repeatability resulted in a maximum SD between 2.8 cm3 (Gastrocnemius 

lateral) and 31.5 cm3 (Vastus lateralis) corresponding to a CoV of 4.6% and 9.8%, respectively. 

The values of individual VM for the left and right leg have been included as supplementary 

material in Appendix II. 

7.4.1. Anatomical variability  

Volumes 

The group mean and SD values for muscle volumes are reported in Figure 7-3 as a fraction of 

the total limb muscle volume as this allows comparison of the results to previous in-vivo 

literature (Handsfield et al., 2014). The calculated VM of the hip, knee, and ankle main muscles 

are also listed in Figure 7-4 to highlight the evident intra- and inter-subject variability of these 

quantities. The Sartorius, Gluteus maximus, Adductor magnus, and Vastus lateralis, were on 

average all significantly lower in the left than in the right limb. In some subjects, the 

asymmetry between the two limbs was over 45% for single VM. The inter-subject CoV ranged 

between 13% (Tibialis anterior) and 35% (Gracilis).  

 



123 
 

 

Figure 7-3 – Mean±SD muscle volume calculated as a fraction of total limb muscle volume for the 
right and left limb of the eleven subjects in the present study and for the cohort of young adults 

enrolled by Handsfield et al. (2014). 

Musculotendon lengths  

The personalised lMT measured in the SSp model are reported in Figure 7-5. Differences 

between limbs reached 25% of the value and were particularly high for the Glutei. A 

significant difference between the two limbs was observed on average for the Gluteus 

maximus (II bundle), Gluteus medius (II and III bundles), Gluteus minimus (I bundle), Iliacus, 

Adductor magnus (III bundle), Rectus femoris, and Vastus intermedius and lateralis. Once 

again, high inter-subject variability was observed: inter-subjects CoV ranged between 2% 

(Tensor fasciae latae) and 14% (Gluteus medius II bundle). Longer MT units were measured in 

the right limb for certain muscles of a given individual and in the left limb for others, without 

any obviously recognisable pattern. 
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Figure 7-4 - Mean±SD of muscle volumes (significant difference between left and right: * p<0.05, 
**p<0.01) and maximum SD from the repeatability analysis. Individual percentage difference 

between the legs is reported as a bar plot where each bar represents a participant: blue positive 
(red negative) values show that the right leg is bigger (smaller). DFs and PFs stand for dorsi and 

plantar flexors, respectively. 
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Figure 7-5 - Mean±SD of musculotendon length (significant difference between left and right: * 
p<0.05, **p<0.01). Individual percentage difference between the legs is reported as a bar plot 

where each bar represents a participant: blue positive (red negative) values show that the right 
leg is bigger (smaller). DFs and PFs stand for dorsi and plantar flexors, respectively.  
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7.4.2. Musculotendon parameters 

Tendon slack length and optimal fibre length  

The comparison between the lST and lopt estimated in the Hyb and SSp models highlighted 

differences above 80% (for lST) and 50% (for lopt) in some isolated cases (i.e Vastus lateralis 

and medialis). The CoV of the difference between Hyb and SSp across all the muscles and 

subjects was 150% for both parameters. A specific pattern could not be identified, since none 

of the subjects presented values consistently higher (or smaller) in any of the two models. 

The values differed from subject to subject and from muscle to muscle and significant 

difference between Hyb and SSp values was found only for the lST and lopt of the Soleus 

(p<0.01) and for the lopt of the Sartorius, Gluteus medius (III bundle), Tensor fasciae latae and 

Gastrocnemius lateralis (p<0.05).The inter-model differences were consistent for the two 

body sides (see Appendix II for additional material). 

Maximal isometric force 

The Fmax was calculated from the PCSA, obtained dividing the MRI-measured VM by the lopt. 

The PCSA values are reported in Figure 7-6, where they are also compared to literature data 

from an ex-vivo study (Ward et al., 2009).  

 

Figure 7-6 – Mean±SD physiological cross-sectional area (PCSA) of the main muscles of the right 
and left lower limb estimated from muscle volumes of the eleven subjects in the present study and 

compared to those measured from cadavers by Ward et al. (2009). 
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The Fmax calculated from the individual VM (SSp) differed from that of the Hyb for up to 230% 

of the value for single cases.  CoV of the difference between Hyb and SSp was above 80% 

across all the muscles and subjects (Figure 7-7). For this parameter, a trend could be observed 

in some muscles with the Gluteus maximus, Gluteus medius (I bundle), Adductor magnus, and 

Vastus intermedius, presenting consistently and significantly bigger Fmax in the SSp. Similarly, 

the Iliacus, Gracilis, Biceps femoris short head, and Rectus femoris presented a significantly 

smaller Fmax in the SSp for all subjects and in both limbs.  

7.4.3. Muscle activations  

Muscle activations were compared for 86 muscle (the 92 included in the gait2393 minus those 

removed as attaching to the torso) at each point of the gait cycle quantifying the differences 

between SSp and Hyb, SSp and Gen, and Hyb and Gen (Figure 7-8). The SSp model showed 

constantly lower activation of the hip abductors during stance and lower activation of the 

knee flexors and ankle plantar flexors during mid- and late stance, with respect to both SSp 

and Hyb. This was associated to higher activation of the knee adductors during late stance 

and of the knee extensors during mid- and late stance. The Gen model presented higher 

activation of the hip rotators and flexors, especially during mid- and late stance, associated 

to lower knee extensors activation.  

Unfortunately, EMG data was not recorded on regular basis due to technical difficulties. 

Nonetheless, in those subjects/trials where the EMG signals were available, these showed 

consistency with the muscle activations estimated by the three models (Figure 7-9). 
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Figure 7-7 Mean±SD of the maximal isometric force for the right and left muscles personalised in 
the SSp model and percentage difference between Hyb and SSp (* p<0.05, **p<0.01). Individual 
percentage difference is reported as a bar plot where each bar represents a participant: green 
positive (orange negative) values show that the optimal fibre length in the Hyb model is bigger 

(smaller). DFs and PFs stand for dorsi and plantar flexors, respectively. 
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7.4.4. Joint contact forces 

JCFs were found to vary both between individuals and between models, with the repeated 

measure ANOVA highlighting some significant differences; the post hoc paired t-test (Figure 

7-10) revealed higher average estimates of hip contact force during push off phase for the 

SSp model, whereas the Hyb model estimated higher hip contact forces during initial contact. 

On average, the Gen model always provided the lowest hip peack JCF values among the three 

models. At the knee, the SSp model showed the smallest contact force during initial contact, 

wherease the Hyb presented the highest estimates for the second knee peak and push off 

phase. At the ankle, a significant difference was observed only between Hyb and Gen, with 

the former estimating higher peak JCFs.  

Average peak differences of JCFs were generally small, between 0.4 BW (between Hyb and 

Gen at the ankle peak) and 0.7 BW (between SSp and Gen at the second hip peak). However, 

inter-model absolute differences for individual subjects reached up to 2.5 BW, 1.2 BW, and 

1.8 BW, at the hip, knee, and ankle late stance peaks, respectively (Figure 7-10). Moreover, 

as a consequence of inter-subject differences in the MT parameters, some subjects presented 

consistently higher estimates with one model throughout the gait cycle, whereas others 

showed higher values with one model during early stance and lower during late stance and 

vice versa. Similarly, inter-model differences varied notably throughout the gait cycle, with 

maximum values not necessarily found in correspondence of JCF peaks.  

Despite being of negligible amplitudes and as such of little relevance, JCFs were found to vary 

significantly between models during most of the swing phase at the hip and knee and during 

terminal swing phase at the ankle. 

The peak values for the hip, knee, and ankle JCFs obtained at intermediate stages of model 

personalisation are shown in Figure 7-11. A clear pattern was observed for the first hip and 

the two knee peaks, with Hyb giving the highest estimates, followed by HybSSpPath, HybSSpFmax, 

and SSp, respectively. The opposite trend was observed for the second hip peak. In detail, 

negligible differences were observed on average between Hyb and HybSSpPath (all below 0.3 

BW) and between SSp and HybSSpFmax (below 0.2 BW). The largest difference was 0.6 BW 

between Hyb and SSp at the second knee peak. The repeated measure ANOVA with post hoc 

paired t-test (p=0.0125) showed significant difference between the peaks (p<0.001) for most 
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comparisons at the first knee and hip peaks and at the second hip and knee peaks. Less 

consistent patterns were observed at the ankle.  

 

Figure 7-8  - Comparison of muscle activation patterns between the different models. Average 
difference over all subjects for SSp vs Gen model (top), SSp vs Hyb model (middle) and Hyb vs Gen 

model (bottom). Each row corresponds to an individual muscle according to the list specified in 
the table. Vertical dashed line indicates the time instant when toe off occurred. DFs and PFs stand 

for dorsi and plantar flexors, respectively. 
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Figure 7-9 - Example of EMG signal (bottom box) and muscle activation (top box) estimated with 
SSp , Hyb and Gen for five muscles of one subject. 

 

Figure 7-10 - Mean±1SD JCFs (bold lines) for the SSp and Gen (top), Gen and Hyb (middle), and SSp 
and Hyb (bottom) and SSp-Gen (top), Gen-Hyb (middle), and SSp-Hyb (bottom) differences for 

individual limbs (thin lines). Black bars indicate significant differences (post hoc test, p=0.017). 
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Figure 7-11 - Statistical distribution of the peak JCF for hip, knee, and ankle with the Hyb, by 
HybSSpPath, HybSSpFmax, and SSp models. * = significant difference (p<0.001). 

7.5. Discussion 

This study aimed at quantifying to what extent model specificity can affect the results of MSK 

simulations, in light of a newly quantified variability of muscle anatomy in older women. To 

this purpose, 3D bone and muscle geometries extracted from MRI data collected from eleven 

post-menopausal women were combined with motion capture data to generate MSK models 

at various level of personalisation.  

This is, to our knowledge, the first study providing a quantification of muscle volumes and 

musculotendon lengths in older women. Despite the average height and weight of our cohort 

being smaller we found slightly larger VM than those previously reported for an ex-vivo cohort 

(Ward et al., 2009), This could be explained by the loss in muscle mass in cadavers, which in 

that study was used to calculate the volumes (Ward and Lieber, 2005). On the contrary, our 

VM were slightly smaller than those estimated in-vivo from MRI in both young (25.5±11.1 

years) (Handsfield et al., 2014) and older adults (61.5±6 years) (Almurdhi et al., 2016), which 

might be justified by those studies involving also male participants. This likely also explains 

the smaller inter-subject variability found in our study. When quantified as a fraction of total 

limb muscle volume, the VM values of our cohort were indeed similar to those reported for 

young adults (Handsfield et al., 2014). 

This study also presented, for the first time, a thorough assessment of the effects of skeletal 

and muscle anatomical variability between body sides and across individuals. When looking 
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into variability between limbs of the same subject, we observed up to 45% of VM and up to 

25% of lMT differences. This suggests that, conversely from most common approaches, care 

should be taken in assuming symmetry when assigning MT parameters, even in healthy 

populations. The inter-subject variability was between 13% and 35% for the VM and between 

2% and 14% for the lMT, in line with previous literature (Ward et al., 2009). The largest values 

were observed for the Gluteus medius and minimus, Biceps femoris short head, 

Semitendinosus, Gracilis, Sartorius, Tensor fasciae latae (for the VM) and for the Gluteus 

medius and minimus, Vastus medialis and lateralis, Soleus, Tibialis anterior (for the lMT). 

Subject-specific models can better resemble anatomical variability compared to generic-

scaled models (Ding et al., 2019) and skeletal personalisation alone does not significantly 

modify the model estimates of the hip JCF (Wesseling et al., 2016). Furthermore, the 

force/torque-generation capacity of a given muscle can be more or less sensitive than that of 

others to changes either in the moment arm and length of the musculotendon units or in the 

MT parameters (Carbone et al., 2016). In light of these considerations and of the here 

observed intra-and inter- subject variability, it seems evident that personalisation should be 

pursued for muscle volumes and lengths.  

In the present study, we investigated the effects of both skeletal personalisation and different 

degrees of muscle personalisation. The interpretation of these results needs to be handled 

with care, due to the intrinsic limitation associated to using ideal hinge joints to represent the 

knee and the ankle, which might not account for their real movement (Siegler et al., 1988, 

Yamaguchi and Zajac, 1989). While this simplification is widely accepted in MSK modelling 

(Modenese et al., 2018), a more realistic representation, possibly including the patellofemoral 

joint and tendons, might change the sensitivity of the output to the model personalisation 

investigated here.  

Identifying the MT path from the centre line of the segmented muscle (HybSSpPath) did not 

significantly alter the estimates of JCFs with respect to a manual identification of the muscle 

points on the MRI (Hyb), except for lower peak values of the ankle JCF. The first procedure, 

however, allows the automation of the MT path identification, which would significantly 

reduce the operator time and favour repeatability. An intrinsic limitation of this approach, 

however, is associated to the fact that the MRI data were acquired in supine position, which 
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certainly affected the muscle centre line and moment arm estimation. Alternative 

technologies, allowing for standing imaging, might help to overcome this issue.  

The maximal force that a muscle can produce is highly affected by its PCSA (Fick, 2012). In our 

study, we calculated the PCSA dividing the MRI-measured VM by the lopt, with the latter being 

scaled from a generic model (gait2392 (Delp et al., 1990)) while maintaining the lopt/lMT ratio. 

The specific tension (k) of a muscle also contribute to the estimate of Fmax. Previous studies 

suggested that muscle weakening associated to aging may exceed the muscle mass loss, 

causing a decrease in the muscle specific tension (Davies et al., 1986), but contrasting findings 

disproved this hypothesis (Häkkinen and Häkkinen, 1991). The lack of consensus on this 

matter justified the choice of setting k to 61 N/cm2 for all the muscles, for consistency with 

previous literature (Arnold et al., 2010). Sensitivity of models to this parameter was previously 

tested by Valente et al. (2014) finding a moderate effect on the model output. In the effort of 

maximally personalising the muscle parameters, individual values for the specific tension 

should be obtained for different subjects and different muscles, however such a measure is 

not currently available in-vivo. The use of dynamometer could provide further insight in the 

specific tension of muscle groups and overcome this limitation.  

Our approach led to PCSA values in agreement with literature cadaveric data (Ward et al., 

2009). Further efforts in automated extraction of VM from the MRI would be needed for a 

broader implementation of this method, since muscle segmentation is indeed extremely 

time-consuming (10 hours per subject on average for this study). The dataset shared with this 

paper will likely foster advances in this field. 

The estimated Fmax were overall bigger when based on VM than when linearly scaled to lower-

limb mass, especially for the hip extensors (Gluteus maximus) and abductors (Gluteus medius 

and Tensor fasciae latae) and for the knee extensors (Vastii) and adductors (Adductor 

magnus). As a consequence of muscle strength and volumes loss associated with ageing 

(Brooks and Faulkner, 1994), a reduction of 20% of Fmax could be expected at an age of about 

seventy years (Thelen, 2003). This would have suggested smaller Fmax values for most muscles 

when using a SSp approach as opposed to scaling. Surprisingly, this was only true for the 

Iliopsoas, Hamstrings, Rectus femoris, Gracilis, Sartorius and Tibialis anterior. Nonetheless, 

this result somehow confirms previous literature suggesting that the linearly scaled 

approaches, such as the one implemented in Hyb, might only be appropriate for certain 
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muscles (De Groote et al., 2010). Further research would be needed to confirm this 

hypothesis.  

When looking at the JCFs, it was observed that HybSSpFmax provided significantly lower early 

stance hip peak, and early and late stance knee peaks, but significantly higher late stance hip 

peak than Hyb, where Fmax was linearly scaled from literature values. No differences were 

observed at the ankle. This partially contrasts with findings from a sensitivity study from 

Ackland et al. (2012), whose model output was not affected by either Fmax or muscle moment 

arm variations. However, in their study, a variation limited to +10% and −10% of the nominal 

value was imposed, whereas our data showed that Fmax might vary by up to 230%.  Model 

personalisation (SSp and Hyb) led on average to higher estimates of the JCFs than when using 

a generic (Gen) approach, particularly in correspondence of the peaks. Differences between 

the three models ranged between 0.0 BW and 2.5 BW and were not consistent for the two 

limbs of the same subjects. Additionally, maximum differences between the models tended 

to occur in different phases of the gait cycle. This result is easily explained by the anatomical 

variability observed in the cohort, which is only accounted for in the SSp model. In fact, it is 

well known that Fmax, lopt, and especially lST heavily impact the estimate of MSK models 

(Carbone et al., 2016, De Groote et al., 2010), and that a reduction in an individual muscle 

ability to produce force can be compensated by the action of other muscles (Carbone et al., 

2016). Nonetheless, a comprehensive understanding of these compensatory mechanisms 

would require a different modelling approach, accounting for muscle synergies (Lloyd and 

Besier, 2003).   

In all models, muscles were treated as ideal force generators (i.e. no force-length-velocity 

relationship was implemented). It has been shown that during normal gait, muscles operate 

close to their optimal length (Lichtwark et al., 2007, Rubenson et al., 2012) and in a generic 

model the effect of this assumption on JCFs can be considered as negligible (Anderson and 

Pandy, 2001). Moreover, since this modelling choice was consistent throughout all the 

simulations, we do not expect this limitation to have influenced our results. As expected, 

different values of Fmax calculated for the three models led to different muscle activation 

patterns, which in turn affected the muscle forces estimates. This was particularly evident 

when comparing SSp and Hyb, differing only for muscle geometry and MT parameters. Most 

evident compensatory activations emerged for the Tibialis anterior when contributing to the 
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dorsiflexion moment estimated during swing phase and the Rectus femoris and Iliopsoas 

when providing the required hip flexion moment during stance phase. The reduction in 

Gluteus medius and minimus activity in the SSp corresponded to higher Fmax in the abductor 

muscles. This suggests that the SSp model could be more suitable when dealing with large hip 

abduction moments, such those typical of stance phase. This was also observed for the Vasti 

in relation to the knee extension moment. Further analyses, however, would be needed to 

better investigate these aspects, which were not possible in this study due to the limited 

validation data.   

Overall the reported findings suggest that personalised estimates of muscle volumes and 

geometry and consequently of the maximal isometric force can be critical to the 

quantification of hip and knee peak contact forces. This could be of substantial relevance 

when these forces are used in clinical contexts, such as prediction of osteoporotic risk of 

fracture (Gallagher et al., 1994) and even more when asymmetries between limbs could be 

significant, such as in joint replacement (Jonkers et al., 2008) or  cerebral palsy (Kainz et al., 

2018). 
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8. General discussion and conclusions 

The research collected in this PhD thesis supported the achievement of the objectives listed 

in chapter 1 as a coherent body of work, which stemmed from the lack of a standard and 

reliable approach to musculoskeletal modelling and led to the development of a fully-

personalised, highly automated, robust procedure which can be easily implemented by other 

researchers.  

In details, chapter 3 presented an innovative methodology to improve the identification of 

tibiotalar and subtalar joint axes in in order to reduce the dependence on the location of the 

experimental markers (Montefiori et al., 2019a). Previous works highlighted how in-vivo 

tracking of the ankle joint kinematics can be complicated by the marker placement on such a 

small area with no visible superficial landmarks (Di Marco et al., 2016, Scott and Winter, 

1991). The location of joint axes based on these markers, although commonly adopted (Wu 

et al., 2002), is unavoidably affected by the same limitations (Prinold et al., 2016). As an 

alternative, a morphological fitting-based approach was used to automatically define the 

tibiotalar and subtalar joint centre and axis from the articular surface of the segmented bone. 

The anatomical consistency of the obtained axes was verified against ex-vivo measurements 

available in the literature (Isman et al., 1969).  

Chapter 4 allowed to identify the modelling steps generating the biggest intra- and inter-

operator errors when personalising MRI-based musculoskeletal models (MSKMs) of the foot 

and ankle complex. The most critical element was found to be the definition of muscle points, 

contributing to errors in the estimate of muscle and joint contact forces by up to 24% and 

64% of the peak values, respectively (Hannah et al., 2017). This finding promoted the 

development of alternative methods for the identification of muscles path, based on 

supervised atlas registration (Modenese et al., 2018, Montefiori et al., 2019b) and iterative 

closest point mapping, briefly described in chapter 5.  

The developed methodologies were further extended to the modelling of the whole lower-

limb and fully documented (Appendix I) in order to promote its adoption within the 

biomechanics community. Recommendations for the acquisition of the appropriate 

experimental data were also formulated in chapter 5.  
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The resulting MSKM was successfully applied to both juveniles (chapters 4 and 6) and elderly 

subjects (chapter 7) for the investigation of kinematics and kinetics, including muscle and joint 

contact forces. The application to Juvenile Idiopathic Arthritis (JIA) demonstrated the 

capability of MSKMs to track individual kinematics changes over time consistently with 

traditional gait analysis (Montefiori et al., 2019a) with the further potential of predicting 

disease progression and inform treatment planning thanks to the monitoring of JCFs 

(Montefiori et al., 2019b). Within the context of osteopenia in post-menopausal women, the 

MSKM was further personalised in order to account for individual muscle properties. The 

anatomical variability of muscles observed across individuals was significant.  Comparing the 

estimates of JCFs to those from generic-scaled models proved that muscle variability should 

not be neglected, especially in elderly populations where monitoring joint loading is crucial 

to the conservation of both bone and cartilage tissue. 

8.1. Limitations 

The limitation of the work carried out in the thesis have been detailed in the various chapters 

and will be now globally discussed.  

Inevitable errors associated to the experimental data collections directly translate into 

inaccuracies in the model estimates. Although recommendations for the minimisation of 

these errors were formulated, experimental variability, including human mistakes, is inherent 

in the adopted techniques, especially within clinical context. However, a quantification of 

these errors and of their impact has been carried on when possible, both for the gait analysis 

and the imaging data.  

Assessment of the model accuracy was hindered by practical and ethical limitations. For 

instance, fluoroscopy data were not collected due to the poisoning effect of X-ray radiations. 

MRI acquisition time, and hence image quality, was reduced to limit the burden to the 

patients. Aiming at minimising the ethical impact of the research, a control group was not 

enrolled in the paediatric study, not to expose healthy children to the potential distress of the 

clinical examination and experimental data collection.  

From a modelling perspective, one of the limitations of the work was that of neglecting the 

abduction/adduction movement of the knee. This was a reasonable simplification, especially 
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in the context of investigating the kinematics of the JIA population as previous gait analysis 

works only highlighted alterations in the sagittal plane. The same reasoning applied to the 

abduction/adduction joint moments. Conversely, when looking at the contact forces, the 

analysis of the medial and lateral knee forces acting on the medial and lateral condyle, 

respectively, could have provided a further insight on the disease and its progression 

mechanism. For example, the observation of compartmental loading proved to be particularly 

informative in understanding the onset of osteoarthritis (Andriacchi et al., 2004, Meireles et 

al., 2017), therefore the two knee force components should be considered when investigating 

the loading in elderly (i.e. post-menopausal women). Future work should aim at introducing 

more accurate and complex knee mechanisms in the lower-limb MSKM. Another important 

limitation is that the adopted model does not account for muscle physiology and activation-

contraction dynamics, which of course limits the range of possible clinical applications.  

Finally, a comprehensive validation of the muscle and joint contact forces estimated by the 

models is not currently feasible in-vivo. Measurements from subjects with instrumented 

implants can be used to validate the estimates of JCF in the hip, knee, and less frequently in 

the ankle. These measurements can be used as a reference to evaluate the models’ 

predictions in healthy populations. However, differences in the estimates should be expected 

due to geometrical and anatomical differences between the natural joint and the 

instrumented joint, with the latter most likely to record lower contact forces (Ding et al., 

2019). 

8.2. Critical appraisal of published work 

The anatomical models described in chapters 3, 4, 6, and 7 included the 3D geometry of the 

fibula; however, this bone was rigidly fixed to the tibia, neglecting its contribution to the 

stabilisation of the ankle. This simplification is common to most of the MSKMs available in the 

literature (Arnold et al., 2010, Carbone et al., 2015, Delp et al., 1990, Horsman et al., 2007, 

Malaquias et al., 2017, Modenese et al., 2018, Prinold et al., 2016, Saraswat et al., 2010, 

Valente et al., 2014), and therefore it is widely accepted. 

In all papers, when joint contact forces were presented, their value was scaled to body weight 

(BW) as common practice across the musculoskeletal community (Wannop et al., 2012). This 
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choice was dictated by the need for comparing curves across individuals, and against 

literature data, removing their dependence on body mass. On the other hand, when 

estimating the articular damage caused by the joint loading, one should consider the local 

pressure on the articular surface, therefore accounting for the absolute (non-normalised) 

force acting on the contacting area of the joint. Alternatively, more complex normalisation 

algorithm should be implemented, also accounting for how joint size scales with body size 

across individuals. 

In chapter 3, the representation of the tibiotalar and subtalar joints as purely 

plantar/dorsiflexion and inversion/eversion joints, respectively, had an impact on the 

understanding of the real movement of the ankle complex. However, this simplification is 

widely accepted in the musculoskeletal modelling community, especially for the investigation 

of in-vivo kinematics during walking tasks. More complicated representations are proposed 

within the context of ex-vivo studies under controlled movements, but these 

implementations go beyond the scope of this thesis.  

In chapter 4, a two-segment foot model was adopted. The ground reaction force collected by 

the force platforms was applied to either hindfoot or forefoot, depending on the location of 

the centre of pressure. This model provides an overestimate of the loading of the forefoot 

during the push-off phase when suddenly all the external force is applied to this segment, 

whereas in the reality the load gradually passes from hindfoot to forefoot during the forefoot 

rocker and the two segments share the force. Pressure measurements using pressure mats 

would allow more accurate distribution of the ground reaction force; however, in the context 

of studying the repeatability of the modelling procedure and assessing the sensitivity of the 

model to operator-dependent steps, this assumption had a negligible impact on the analysis. 

In the Discussion section of the same chapter it is also concluded that having access to medical 

images improves the repeatability of muscle points location. In this respect, the authors 

wanted to highlight that the availability of images and segmentations of bones only, despite 

proved to be valuable data for the location of muscle attachments (Ascani et al., 2015, Pal et 

al., 2007), guarantees less repeatability in the identification of muscle paths compared to 

when muscle images are available as well. The high sensitivity of the muscle forces to 

operator-dependent error reported in this work was mostly associated to the variability in 

the identification of joint reference systems and muscle paths, having an effect on the 
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resultant muscle moment arm. Interestingly, this had a limited impact on the estimated 

contact forces. In fact, altered moment arms affected the muscle recruitment strategies 

employed by the static optimisation tool. Despite this, the total muscle force acting on the 

ankle was similar, limiting the sensitivity of the joint contact forces to operator variability. 

In chapter 6, within the Statistical Analysis section, a non-parametric t test was used. By 

definition, a t test can be applied when the analysed sample follows a normal distribution. 

Alternatively, a Wilcoxon signed-rank test is used when the normality condition is not met. In 

this work, we referred to non-parametric “t test” to describe the test chosen to conduct the 

statistical analysis consistently with the name assigned to the relevant algorithm 

implemented in the MATLAB package SPM1D, based on the work by Nichols and Holmes 

(2002). Furthermore, the Discussion section of this chapter presents the observed 

compensation mechanisms as a possible indicator of disease progression. This hypothesis is 

not meant to discourage or prevent compensation, acknowledged here as an effective 

strategy to deal with disease and impairment. Conversely, we suggest that compensation 

should be quantified in order to recognise those individuals at risk of further developing 

alterations in the joints, potentially compromising the biomechanics of the healthy limb. 

8.3. Impact 

This PhD work contributed to the publication of five journal papers (two as a first author and 

three as a second author), one user guide and several repositories (available on Figshare) 

containing code and material for the implementation of MRI-based MSKMs and simulations 

of gait. Two further co-authored papers are currently under revision and one paper is 

currently being reviewed by other co-authors aiming at submission in October 2019.  

The modelling procedure and the newly developed tools and methods have now been shared 

with the research community together with a detailed documentation (explicitly written to 

limit operator errors) and associated models and datasets. Despite developed within the 

framework of OpenSim and MATLAB, the shared procedure can be easily adapted to different 

software and is suitable for wider modelling context, such as forward dynamics or EMG-driven 

modelling. 
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The application of the models to the investigation of the biomechanical characteristics of JIA 

allowed to complement and integrate the current knowledge of the disease, based on gait 

analysis. In fact, the model could estimate internal joint loading in the lower limb highlighting 

specific features of JIA, such as overloading of the knee during push off and existing 

compensatory mechanisms causing the overloading of the unimpaired limb in monolateral 

cases. The investigation of internal loads enabled for the first time to bridge the information 

about the local joint damage, gained from imaging techniques such as MRI and US, and the 

functional impairment observed through gait analysis. In fact, it is known that local cartilage 

or bone damage in the articular region is most likely to be caused and magnified by excessive 

or concentrated loading. The results reported in this thesis enhanced the potential benefits 

of applying MSK modelling to unsolved clinical questions where experimental measurements 

cannot provide enough information, whereas simulations can be valuable tools for evaluating 

and predicting disease progression and intervention outcomes. 

Furthermore, output parameters from MSKMs such as muscle forces and JCFs have the 

potential to inform finite element (FE) analysis providing the individual forces acting on single 

bone geometries in time during a certain locomotor task (Geier et al., 2019).  To this purpose 

MRI data, useful for the generation of the MSKM, need to be integrated with higher resolution 

data, i.e. CT images, in order to gain accurate information on the bone geometry and a 

description of its mechanical properties. Image registration techniques can be used to register 

data from the two imaging modalities and find the optimal transformation to translate the 

muscle forces and JCFs estimated with MRI-based MSKMs into input data for the CT-based FE 

models. The main advantage of this approach is that of enabling fully subject-specific analyses 

and predictions as opposed to more hybrid approaches where gait analysis data are combined 

with generic MSKMs available in the literature and generic estimates are used to feed FE 

models. This approach is currently being used within the multiscale framework of the 

MultiSim project for coupling body and organ simulations and predicting risk of fracture in 

elderly. 

Two projects have already been funded to further exploit the work done within this thesis, 

where I am a named investigator: ”MultiSim2 - Frontier Engineering Progression Grant”, 

funded by the UK EPSRC to develop new approaches for better imaging, characterisation and 

modelling of the muscles and of their interaction with the skeletal system;  and “Clinical 
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consequences of adult presenting hypophosphatasia with special focus on gait, bone 

microarchitecture and cognition: The PORTRAIT Study”, funded by Alexion Pharmaceuticals 

Inc. aiming at examining the risks associated to joint overloading in hypophosphatasia, an 

inherited condition which causes a defect in bone calcification, leading to weak bones. 

8.4. Future work 

Future work will focus on: 

• The validation of the proposed tibiotalar model through a collaboration with Dr 

Michele Conconi at the University of Bologna comparing the ankle kinematics 

estimated by the model to that resulting from a validated congruence-based approach 

developed by Conconi and Castelli (2014). The ultimate goal is to understand the 

anatomical consistency of different kinematic models commonly adopted within the 

OpenSim community. Preliminary results will be presented at the international 

conferences of the International Society of Biomechanics (ISB) in Calgary (CA) and at 

the International Symposium on Computer Methods in Biomechanics and Biomedical 

Engineering (CMBBE) in New York, NY. A more comprehensive analysis is planned to 

be completed within the next year to ultimately lead to a journal publication.  

• The exploitation of alternative techniques (i.e. Ultrasounds, US) for the acquisition of 

meaningful musculoskeletal information. Data have been collected and are currently 

being processed with the purpose of proving the feasibility of replacing MRI with US 

(Greatrex et al., 2017) synchronised to a motion capture system to estimate joint axes 

and muscle parameters. This will enable the development of US-based MSKMs with 

the advantage of reducing errors associated to data registration and enabling standing 

imaging acquisition. The use of US would also reduce imaging costs and time, making 

personalised modelling more sustainable within clinical contexts. 
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• The development of more advanced and automated techniques for image processing 

and segmentation. In this framework, preliminary work has been conducted using 

lower-limb MRI available within the Juvenile Idiopathic Arthritis study. The image 

registration toolkit ShIRT, developed in Sheffield, has been tested in order to assess 

the feasibility of using elastic registration to automate image segmentation. Further 

work will aim at producing a large database of segmented medical images to be used 

in the training of the automatic algorithm and ultimately develop a robust 

segmentation tool. 
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LICENSE 

This work is licensed under the Creative Commons Attribution-NonCommercial-ShareAlike 

4.0 International License. To view a copy of this license, visit 

http://creativecommons.org/licenses/by-nc-sa/4.0/ or send a letter to Creative Commons, PO 

Box 1866, Mountain View, CA 94042, USA. 

 

PERMISSION 

Use of the document is permitted provided that the following condition is met: use of the 

presented document and related scripts must be acknowledged in all publications, 

presentations, or documents using the document and accompanying scripts is used by citing 

the following work: Modenese, L., Montefiori, E., Wang, A., Wesarg, S., Viceconti, M., Mazzà, 

C., 2018. Investigation of the dependence of joint contact forces on musculotendon 

parameters using a codified workflow for image-based modelling. Journal of Biomechanics 

73, 108-118. 

 

DISCLAIMER 

This document is provided by the copyright holders and contributors "as is"; and any express 

or implied warranties, including, but not limited to, the implied warranties of merchantability 

and fitness for a particular purpose are disclaimed. In no event shall the copyright owner or 

contributors be liable for any direct, indirect, incidental, special, exemplary, or consequential 

damages (including, but not limited to, procurement of substitute goods or services; loss of 

use, data, or profits; or business interruption) however caused and on any theory of liability, 

whether in contract, strict liability, or tort (including negligence or otherwise) arising in any way 

out of the use of this software, even if advised of the possibility of such damage. 

 

CONDITIONS 

The use of this document is not for clinical purpose. 

 

If you use this pipeline for your published research, please cite:  

Modenese, L., Montefiori, E., Wang, A., Wesarg, S., Viceconti, M., Mazzà, C., 2018. 

Investigation of the dependence of joint contact forces on musculotendon parameters using a 

codified workflow for image-based modelling. Journal of Biomechanics 73, 108-118. 
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1 Required software 

For implementing the procedure described in this pipeline the 

following software packages are required:  

 Meshlab, (http://www.meshlab.net) [1] 

 NMSBuilder, (http://www.nmsbuilder.org) [2] 

 OpenSim, (https://simtk.org/projects/opensim) [3] 

 Netfabb, Autodesk Inc. (https://www.autodesk.com) 

 MATLABTM,The Mathworks Inc., USA 

(https://www.mathworks.com/products/matlab.html)  

2 Preprocessing 

 Dataset 

The procedure assumes that the following data is available: 

1) Full lower limb MRI/CT scans 

2) Skin segmentation (.stl files) 

3) Bone segmentation (.stl files): 

a. Iliacus and Sacrum 

b. Femur 

c. Tibia and Fibula 

d. Talus 

e. Cuboid, Navicular, Calcaneus and Cuneiformis 

f. Metatarsals  

g. Phalanges  

4) Gait Data (Marker Trajectories)  

5) Force Plate Data (Ground Reaction Forces) 

NB: in the following, when referred to ‘xxx_side’, it means that ‘_side’ must be replaced 

with either ‘_l’ or ‘_r’ if left or right side of the body. 

 Definition of model segments  

Meshlab is used for preparing the required limb and foot segments from the individual meshes 

by following these steps:  

1) Load all .stl files in Meshlab. [File > Import Mesh] 

2) Pelvis: Select as visible only the pelvis and save it as ‘pelvis.stl’. [File > Export Mesh 

As…].  Hide the mesh by selecting the eye icon. 

3) Femur: Select the femur as the only visible mesh and save the mesh as ‘femur_side’. 

Repeat the process for the other side. Hide the mesh by selecting the eye icon. 

4) Tibia, Fibula & Patella: Select as visible meshes only the tibia, fibula and patella from 

one side. Select Filters > Mesh Layer > Flatten Visible Layers. Save the resulting mesh 

as ‘tibia_side.stl’. Repeat for the other side. Hide the resulting mesh by reselecting the 

eye icon. 

Figure 1 – Soft tissue model 

segments and mesh cut lines 

(in orange). 

https://simtk.org/projects/opensim
https://www.autodesk.com/
https://www.mathworks.com/products/matlab.html
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5) Talus: Select as the visible mesh only the talus and save the mesh as ‘talus_side.stl’. 

Repeat for the other side. Hide the mesh by reselecting the eye icon. 

6) Phalanges: Select as visible meshes only the phalanges. Select Filters > Mesh Layer 

> Flatten Visible Layers. Save the resulting mesh as ‘toes_side.stl’. Repeat for the 

other side. Hide the resulting mesh by reselecting the eye icon. 

7) Calcaneus: Select as visible all the remaining meshes from one side. Select Filters > 

Mesh Layer > Flatten Visible Layers. Save the resulting mesh as ‘calcn_side.stl’.  

8) Repeat the operation for the soft tissue after cutting the different body segments 

following the lines according to Figure 1. 

9) Rename each body segment with the relevant name plus the suffix ‘ST’ (i.e. 

‘segment_sideST’). ‘ST’ stays for ‘soft tissue’. 

Bone .stl files are saved in folder 1_Meshlab_processing included in the “Folder Structure” 

template. 

Soft tissue .stl files produced here are saved in the 3_NetFabb_cuts folder included in the 

“Folder Structure” template 

 Definition of Joint Parameter  

Articular surfaces can be approximated using geometrical shapes that provide parameters for 

defining mechanical joints in NMSBuilder. The surfaces are selected in Meshlab and relevant 

MATLAB (available in “Matlab Functions/Fitting_functions”), scripts are provided for fitting the 

surfaces with analytical shapes (sphere and cylinder) using a ‘least-square’ algorithm-based 

approach. For Meshlab tutorials see:  

https://www.youtube.com/channel/UC70CKZQPj_ZAJ0Osrm6TyTg?nohtml5=False.  

 Hip Joint Surface 

1) Open Meshlab and load ‘femur_side.stl’ 

2) To select a surface, click on the ‘Select Faces in a rectangular region’ button ( ). 

3) Select the part of the femur head that could represent a sphere as shown in Figure 2. 

4) Select Filters > Selection > Invert Selection to select all the other faces (untick “invert 

vertices”) and delete them by clicking on the ‘Delete the current set of selected faces’ 

button ( ).  

5) Select Filters again, Selection > Select None. Inspect the surface and make sure that 

all the other faces have been successfully deleted. 

6) Export the geometry as ‘femur_head_side.stl’ in 

2_Meshlab_joint_surface_selection/Hip and repeat for the other side.  

 Knee Joint Surface 

1) Load ‘femur_side.stl’ in Meshlab again. 

https://www.youtube.com/channel/UC70CKZQPj_ZAJ0Osrm6TyTg?nohtml5=False
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2) Flip the geometry so that the knee side (the distal end) is directed upwards. Another 

way to select a surface is by using the ‘brush’ tool located on the toolbar. Click on the 

brush button (  ) and then which is for selecting (Figure 2). This is an easier 

method for selecting the ‘cylindrical’ knee surfaces as shown below. 

3) Repeat the process as above and save the geometry as ‘epicondyle_side.stl’ in 

2_Meshlab_joint_surface_selection/Knee and repeat for the other body side. 

 

 

 

 

 

 

 

 

 

 

 

 

 Ankle Joints Surfaces 

1) Load ‘talus_side.stl’ in Meshlab.  

2) Select the ‘cylindrical’ articular top surface of the talus as shown in Figure 3. Cut and 

save it as ‘talartrochlea’ in 2_Meshlab_joint_surface_selection/Ankle/Side. Repeat 

for the other side.  

3) Load ‘talus_side’ again and flip it vertically as to make the bottom side visible.  

4) Select the surface that closest represents a sphere on the calcaneal joint.  

5) Cut and save as ‘talocalcaneal’. Repeat for the other side.   

6) Load ‘calcaneus_side’ and zoom to better see the navicular bone.  

7) Select the surface that closest represents a sphere.  

8) Cut and save as ‘talonavicular’. Repeat for the other side.  

9) Separate all files into different folders for left and right. 

All the .stl files generated are saved in 2_Meshlab_joint_surface_selection (included in the 

“Folder Structure” template) under the specific folder (hip, knee, or ankle). 

Figure 2 – Selection of articular surfaces on femur 
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 Surface Fitting 

The provided MATLAB scripts are used for the generation of a corresponding geometry from 

the selected articular surfaces. For the hip joint use the script ‘DefineHipJointCentre.m’, 

‘DefineKneeJointAxis.m’ for the knee joint and ‘DefineAnkleJointAxis.m’ (available in the 

“Matlab Functions” folder) for the ankle joints axes.  

NB: the Least Squares Geometric Elements library MATLAB package (LSGE) needs to be 

downloaded at: 

http://www.eurometros.org/gen_report.php?category=distributions&pkey=14&subform=yes 

and corresponding functions need to be added to the MATLAB path.  

By running the scripts and selecting the containing folders of the corresponding geometries 

(STL files), the script will fit, using least square algorithms (Figure 4): 

1) A sphere to the femoral head, talocalcaneal and talonavicular joints 

2) A cylinder to the epicondyles and talar trochlea: 

-These geometries are saved alongside log files of the joint parameters and figures in 

2_Meshlab_joint_surface_selection under the specific folder (hip, knee, or ankle). 

 

Figure 3 – Selection of articular surfaces on talus and navicular bone 

http://www.eurometros.org/gen_report.php?category=distributions&pkey=14&subform=yes
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3 Anatomical model in NMSBuilder 

 Importing Data in NMSBuilder 

The musculoskeletal model is built using NMSBuilder. 

To import the required data for model preparation, follow 

these steps:  

1) Load the data tree template 

NMSBuilder_model_structure_template.msf into 

the software. [File > Import > MSF] 

2) Import each of the STL mesh segments (from 

folder 1_Meshlab_processing), under the 

appropriate group on the template tree (by 

clicking the folder before importing) and 

selecting [File > Import > Surfaces > STL]. To 

display segments (Figure 5), click View > 

Surface, then check the square box next to each 

segment.   

3) Follow the procedure to import the soft tissue 

and negative soft tissue segments under their 

appropriate bodies in NMSBuilder.  

4) Import subject MRI images. [File > Import > 

Images > DICOM]. To display images, click on 

View > Ortho Slice.  

*NOTE: To ensure bone geometries are aligned with 

MRI images, click to display the segments as well. 

Figure 5 – Example of visualisation of 

the anatomical model in NMSBuilder 

Figure 4 – Example of output of fitting procedure in Matlab.  
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 Joint parameters 

The next step is introducing the calculated joint parameters from MATLAB in NMSBuilder. The 

provided data tree already includes entries for the required geometries of each joint (defined 

as parametric surfaces in NMSBuilder). Assigning the radius of each parametric surface is a 

manual process and it is easily done: 

1) Select the required geometry from the data tree (taskbar on the right) in NMSBuilder, 

for example ‘ HJC_side’ for the femoral head. 

2) On the bottom part of the control panel select the ‘VME’ tab.  

3) Navigate to the appropriate shape (Sphere or Cylinder) and change the radius of the 

specific geometry according to the results from MATLAB. 

 

To assign the parametric surface’s coordinates: 

1) Select the bone geometry from the data tree that the surface is to be fitted on, for 

example for fitting the hip sphere, select ‘femur_side’.  

2) Select File > Import > Landmark. Navigate to the folder where the MATLAB log is 

located and select to import ‘Fitted_geometries’ or ‘Fitted_geometries_side’ from 

2_Meshlab_joint_surface_selection folder. On the next window press ok.  

3) In order to translate the centre of the geometry to the appropriate coordinates, select  

the parametric surface ( ) under the geometry in the data tree.  

4) Press Ctrl + T in order to enter the Transform Operations window.  

5) On the drop down menu under ‘Choose Reference System’ select ‘Relative’ and from 

the data tree that pops up select the fitted geometry you have just imported.  

6) The ‘Translations’ boxes indicate the distance of the object centre from the position 

defined by the fitted geometry. Zero the translation boxes and you will observe the 

sphere moving to the appropriate joint - the femoral head for example. Click ‘Ok’ to 

save the changes. 

Repeat the process above for all 10 joints and save the model.  

 Virtual Palpation 

Virtual palpation of landmarks is needed to describe bone geometries in order to register a 

landmark cloud of muscle points (from cadaveric studies) and define joint reference systems. 

By selecting an STL bone geometry in NMSBuilder and pressing Ctrl + A, a side window 

appears enabling virtual palpation of markers (Figure 6). By clicking on any location on the 

bone segment a marker is attached on to it. To help aid the process, a dictionary file 

(“Atlas_virtual_palpation.dic”, available in NMSBuilder_dictionaries) with the landmark names 

is provided and can be loaded by selecting ‘Load Dictionary’ on the bottom of the side window. 

A representation of the muscle attachments available in the atlas can me visualised in 

NMSBiuilder importing the .txt files in “NMSBuilder_gait2392_muscle_attachments (mm)” as 

landmarks cloud. These attachments come from the OpenSim model gait2392, therefore, 

importing the .vtp files of the bone geometries from that model a complete visualisation can 

help understanding the location of each muscle attachment on the specific body segment. A 

detailed description of the anatomical markers location can be find in 

“Description_virtual_palpation.xlsx” (available in NMSBuilder_dictionaries). Using the drop-
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down menu on the top of the side window the dictionary can be filtered as to show the 

landmarks concerning the specific segment. Additional information can be find in the book 

‘Color Atlas of Skeletal Landmark Definitions’ by Serge van Sint Jan (2007) [4]. 

A further cloud of virtually palpated markers is required for the definition of the ankle joint 

reference system (which will be described in the following section of the document). These 

markers are loaded as a dictionary file (“Ankle_joint_technical_markers.dic”, available in 

NMSBuilder_dictionaries) and palpated on the calcaneus segment. 

 Joint Axes Definition 

An orthogonal anatomical reference system (according to ISB [5, 6] recommendations) has to 

be assigned to every joint to define rotations and translations and link the segments. These 

reference systems are assigned by using the already fitted geometries and the virtually 

palpated landmarks. The appropriate reference systems exist in the provided data tree and 

they need to be defined to the specific model as such: 

 Pelvis Joint Axes 

1) Select the landmark cloud of the virtually palpated points on pelvis and copy and paste 

‘RIAS’ and ‘LIAS’ (using Ctrl + Shft + C and Ctrl + Shft + V) respectively.  

2) Create a new landmark cloud by selecting ‘pelvis’ bone geometry and pressing Ctrl + 

A. Click ‘Ok’ on the palpation window without palpating any markers.  

3) Reparent the copied landmarks from the original cloud to the newly created one by 

right-clicking on the landmarks, selecting ‘Reparent to…’ and then indicating the 

second cloud from the data tree on the pop-up menu.  

4) Select the new cloud and go to Operations > Create > Average Landmark. This will 

create a new landmark mid-distanced from the two.  

Figure 6 – NMS Builder interface. Virtual palpation of anatomical landmarks 



 
 
 
 
 

12 
 

5) Select the ‘ground_pelvis_child’ reference system under the pelvis folder in the data 

tree. Select the VME tab at the bottom of the Control Panel and change the Scale to 

100 so that the axes are visible. On the three options below select on ‘Select Plane’ 

and assign the following: 

 Origin: The average landmark you have just created 

 Point 1: RIAS from the virtually palpated landmarks (pelvis) 

 Point 2: RIPS from the virtually palpated landmarks (pelvis) 

6) Make sure to select ‘Normal’ again before proceeding to the next step. 

7) Click back on the ‘ground_pelvis_child’ reference system and press Ctrl + T to 

transform the axes according to ISB recommendations. Under ‘Reference System’ 

choose ‘VME Reference System’.  

8) By adjusting the rotations (in steps of ±90/180°), fix the axes so that the X-axis pointing 

forward, Y-axis pointong upwards and Z-axis resulting from the cross product. (For 

identifying the axes: RGB corresponds to XYZ). Click ‘Ok’ to save the changes.  

 Hip Joint Axes 

1) Copy and paste twice the newly defined ‘ground_pelvis_child’ under ‘pelvis’. Reparent 

one of these copied reference systems under ‘femur_side > hip_side’ for both sides.   

2) Rename the reference system as ‘hip_side_parent’ under the VME tab.  

3) Select ‘hip_side_parent’ and press Ctrl + T. On the operations window, under 

‘Reference Systems’ select ‘Relative’ from the drop down menu and select the 

imported geometry from MATLAB ‘Femur_Head_Sphere_C’. Again, zero the 

translations to move the centre of the axes to the hip joint centre. Repeat for both sides.  

4) Select ‘hip_side_child’ under ‘hip_side’. In the VME tab change the scale to 100, select 

‘Select plane’ and assign the following: 

 Origin: ‘Femur_Head_Sphere_C’  

 Point 1: ‘O_cylinder_side’ (fitted geometry under ‘tibia_side’)  from femur  

surface fitting 

 Point 2: ‘P_cylinder_side’ (fitted geometry under ‘tibia_side’)  from femur 

surface fitting 

5) Make sure to select ‘Normal’ again before proceeding to the next step. 

6) Select ‘hip_side_child’ and press Ctrl + T to enter operations. Select ‘VME Reference 

System’ under Reference Systems’ and fix the rotations as to follow the ISB 

recommendations. Click ‘Ok’ to save. Repeat for both sides.    

 Knee Joint Axes 

1) Select ‘knee_side_parent’ under ‘tibia_side > knee_side’.  

2) Select the VME tab at the bottom of the Control Panel and change the Scale to 100 so 

that the axes are visible. On the three options below select ‘Select Plane’ and assign 

the following: 

 Origin: ‘O_cylinder_side’  

 Point 1: ‘P_cylinder_side’ 

 Point 2: ‘Femur_Head_Sphere_C’  from femur surface fitting 
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Make sure to select ‘Normal’ again before proceeding to the next step. 

3) Select ‘knee_side_child under ‘tibia_side > knee_side’.  

4) Select the VME tab at the bottom of the Control Panel and change the Scale to 100 so 

that the axes are visible. On the three options below select on ‘Select Plane’ and assign 

the following: 

 Origin: ‘O_cylinder_side’  

 Point 1: ‘P_cylinder_side’ 

 Point 2: ‘O_cylinder_side’  from talus surface fitting 

Make sure to select ‘Normal’ again before proceeding to the next step. 

5) Transform both reference systems to ISB recommendations.  

 Foot Sole Axes 

1) Select the technical palpated landmarks under ‘calcn_side’. Create an average 

landmark named ‘Average’ for ‘IDHLX_side’ and ‘IDM5_side’.  

2) Select ‘foot_sole_ref_sys’ under ‘calcn_side >  foot_sole_ref_syst’.  

3) Select the VME tab at the bottom of the Control Panel and change the Scale to 100 so 

that the axes are visible. On the three options below select on ‘Select Plane’ and assign 

the following: 

 Origin: ‘calcn_floor_side’ 

 Point 1: ‘Average’  

 Point 2: ‘IDHLX_side’ 

Make sure to select ‘Normal’ again before proceeding to the next step. 

4) Transform the reference system to ISB recommendation and translate it relative to the 

talar cylinder’s centre ‘O_cylinder’.  

5) From the fitted geometries under the talus, select point ‘X_cylinder’ and press Ctrl + T 

to transform it. Translate it relative to ‘foot_sole_ref_sys’ on each side with the following 

translations: [x=100, y=0, z=0] – so that it is visible. This step is taken as to be able to 

assign the third line of action for the ankle child reference system later on.  

 Ankle Joint Axes 

1) Select ‘ankle_side_parent’ under ‘talus_side > ankle_side’.  

2) Select the VME tab at the bottom of the Control Panel and change the Scale to 100 so 

that the axes are visible. On the three options below select on ‘Select Plane’ and assign 

the following: 

 Origin: ‘O_cylinder_side’  

 Point 1: ‘P_cylinder_side’ 
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 Point 2: ‘O_cylinder_side’  from femur surface fitting 

Make sure to select ‘Normal’ again before proceeding to the next step. 

3) Select ‘ankle_side_child under ‘talus_side > ankle_side’.  

4) Select the VME tab on the bottom of the Control Panel and change the Scale to 100 

so that the axes are visible. On the three options below select on ‘Select Plane’ and 

assign the following: 

 Origin: ‘O_cylinder’  

 Point 1: ‘P_cylinder’ 

 Point 2: ‘X_cylinder’  

Make sure to select ‘Normal’ again before proceeding to the next step. 

5) Transform both reference systems to ISB recommendations.  

 Subtalar Joint Axes 

1) Select ‘subtalar_side’ under ‘calcn_side > subtalar_side’.  

2) Select the VME tab on the bottom of the Control Panel and change the Scale to 100 

so that the axes are visible. On the three options below select on ‘Select Plane’ and 

assign the following: 

 Origin: ‘Calc_Sphere_Centre’   from talus surface fitting 

 Point 1: ‘Navic_Sphere_Centre’  from talus surface fitting 

 Point 2: ‘O_cylinder_side’  from tibia surface fitting 

3) Make sure to select ‘Normal’ again before proceeding to the next step. 

4) Transform both reference systems via rotations of ±90/180° so that the ISB 

recommended orientation is rotated through by 90° about the y-axis (X-axis pointing 

forward, Y-axis pointong upwards and Z-axis resulting from the cross product). 

 Metatarso-phalangeal Joint Axis 

1) Select ‘mtp_side_ref_sys’ under ‘toes_side > mtp_side’.  

2) Select the VME tab at the bottom of the Control Panel and change the Scale to 100 so 

that the axes are visible. On the three options below select on ‘Select Plane’ and assign 

the following: 

 Origin: ‘JHLX_side  

 Point 1: ‘JMD5_side’ 

 Point 2: ‘calcn_floor_side’ 

3) Make sure to select ‘Normal’ again before proceeding to the next step. 

4) Transform both reference systems to ISB recommendations. 
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4 Surface Markers Palpation 

For successfully registering gait analysis data, i.e. marker trajectories, onto the computational 

model, correspondent markers are identified in the MRI images and virtually palpated so that 

gait simulation can be produced. This process takes place again in NMSBuilder.  

1) To import the MRI images, select the MRI folder from the data tree and click on File > 

Import > Images > DICOM. Locate and import the MRI folder.  

2) To view the MRI images, select View > Ortho Slice and check the circle next to the 

MRI folder. For better manipulating and viewing the images, right-click on the first 

quadrant and select ‘Maximize SubView’.  

3) Markers are identified by small white ‘circular spots’ on the periphery of the body (on 

the skin) and their location is illustrated below (Figure 7) along with a descriptive table 

(Table I). The list of markers to be palpated can be loaded in NMSBuilder as a 

dictionary (“MRI_visible_markers.dic”, available in NMSBuilder_dictionaries). 

4) Once palpated in the MRI VME, the markers need to be reparented to their specific 

group, under the ‘Surface Markers’ landmark loud by right clicking on each landmark 

point.  

Figure 7 – MRI visible surface markers  

Table I – List of surface markers and their description 
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NOTE: Some markers might be difficult to identify (such as PSI because the subject might 

be laying on them) therefore different MRI sequences might be needed. Even though it is 

preferred to use the same sequence used for segmentation, if other sequences are 

available it is preferable to use those rather than ‘guessing’ markers’ positions. 

5 Muscles Definition 

 Registering Landmark Clouds 

At the bottom of the NMSBuilder data tree is a collection of registration clouds that must firstly 

be registered to the manually palpated anatomical landmarks (see Section 3.3). These 

registered clouds are then exported to MATLAB: 

1) Firstly, navigate to the ‘registration_clouds’ folder in the template data tree and select 

one of the clouds corresponding to specific geometries.  

2) From the top menus select ‘Operations’ > ‘Modify’ > ‘Register Landmark Cloud’. 

3) Select ‘target’ and navigate the pop-up menu to the cloud of manually palpated 

landmarks corresponding to the same segment as the registration cloud. 

4) In the ‘reg. type’ drop-down menu select ‘affine’. 

5) Check that the ‘apply’ box is ticked and then click ‘ok’. 

6) Repeat this step for all registration clouds. 

 MATLAB Muscle Snapping 

The registered clouds that appear at the bottom of the data tree can now be exported to 

MATLAB: 

1) Select a registered muscle cloud and then ‘File’ > ‘Export’ > ‘Landmark’ to export the 

cloud as a .txt file and name the files by geometry, e.g. ‘femur_r.txt’. 

2) Once all clouds have been exported, open MATLAB and run the ‘snapLandmarks.m’ 

script available in Matlab Functions folder.  

3) Select the mesh (the .stl file corresponding to the cloud being fitted) from the MeshLab 

Processing folder. 

4) Select the exported cloud that is to be snapped. 

5) Repeat these steps for all the registered clouds. 

The output from the MATLAB script is a series of .txt files describing the positions of muscle 

landmarks which can now be imported back into NMSBuilder: 

Import each snapped muscle cloud under the corresponding bone geometry. Both the 

registered and unregistered muscle clouds at the bottom of the data tree can now be deleted, 

leaving just the snapped muscle clouds under their individual geometries.  
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 Toes muscles 

The flexors and extensors muscles inserting at the phalanges and hallux are easily identifiable 

at the level of the toes. In fact their paths are constrained by the shape of the bones they have 

to stick to. For this reason, a direct palpation of the distal via points and insertion points is 

recommended at this stage. The points to be defined are shown in Figure 8 and can be 

palpated by selecting the toe bone geometry in NMSBuilder and following the instraction as in 

section 3.3. To help aid the process, a dictionary file (“Toes_muscles_side.dic”, available in 

NMSBuilder_dictionaries) with the landmark names is provided. 

 

 

 Muscle Adjustments 

The muscle origin, via and insertion points calculated by MATLAB are approximations derived 

from a generic model after being transformed to match the manually palpated geometries of 

the subject-specific model. Because of this, the muscle locations in the model are often slightly 

different from the location in the subject’s MRI and so manual adjustment of the muscle points 

is needed to acquire a more accurate model.   

Adjustment is carried out by checking the calculated points in each body alongside the 

participant MRI data in NMSBuilder. By positioning the transverse slice of the MRI so it is level 

with the point being checked, the points can be adjusted to match the actual anatomy; often 

this involves moving the point to sit more in the centre of large muscles such as the Gluteus 

Maximus. 

Included in each of the following sections are the codes used in NMSBuilder and the muscles 

they correspond to, allowing them to be looked up in an Atlas of Cross-sectional Anatomy. 

 Pelvis  

The pelvis does not often require much adjustment. One common discrepancy that can occur 

in the muscle snapping is that origin points (often points related to the gluteus) can be snapped 

ext_dig_r via 5 

ext_dig_r via 4 

ext_dig_r ins 

ext_hal_r via 5 

ext_hal_r ins 

flex_dig_r via 6 

flex_dig_r ins 

flex_dig_r via 5 

flex_hal_r via 5 

flex_hal_r ins 

Figure 8 – Virtual palpation of the muscle attachments belonging to the toes segment, bottom view 

(Right) and top view (Left) 
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to the wrong side of the ilium (this is especially common if the segmentation of the iliac wall is 

particularly thin).   

The only point which should on the medial 

surface of the ilium should be the iliacus origin 

(Figure 9). To move mislocated points onto the 

correct surface and keep the relative position, 

the opacity of the geometry can be changed by 

selecting the geometry from the data tree and 

then the ‘Visual props’ tab. Select the material 

icon and then adjust the opacity slider down to 

around 85-90%. When editing the muscle point 

it is then easier to move the point straight 

through to the correct side.  

 Femur 

Points to be checked in the femur often include 

the quadriceps muscle group (comprised of the 

rectus femoris and the three vastus muscles: the vastus medialis, vastus intermedius and 

vastus lateralis). These points often require adjustment to the centre of their muscle cross-

section (Figure 10).  

Points to be checked in Femur: 

 vas_med_side via 1  Vastus Medialis 

 vas_int_side via 1  Vastus Intermedius 

 vas_lat_side via 1 Vastus Lateralis 

 sar_side via 1  Sartorius 

 tfl_side via 1  Tensor Fasciae Latae 

 glut_max_side(1,2&3) via 2  Gluteus 

Maximus  

 med_gas_side via 1  Gastrocnemius (Medial 

Head) 

 lat_gas_side via 1  Gastrocnemius (Lateral 

Head) 

 Tibia 

Points to be checked in tibia: 

 semimem_side via 1  Semimembranosus 

 semiten_side (via 1, 2 & 3)  Semitendinosus 

Figure 10 – Vastus lateralis via point 

shifted from wrong location (blue) 

according to the MRI to match centre of 

the muscle cross section (red) 

iliacus_side (Iliacus) 

Figure 9 - Pelvis muscle origin locations 
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 bifemlh_side via 1  Biceps 

Femoris (Long Head) 

 bifemsh_side via 1  Biceps 

Femoris (Short Head) 

 sar_side (via 2 & 3)  Sartorius  

 grac_side (via 1 & 2)  Gracilis 

 tib_post_side via 1  Tibialis 

Posterior 

 flex_dig_side via 1  Flexor 

Digitorum 

 flex_hal_side via 1  Flexor 

Hallucis 

 

The via points for the muscle paths of the tibialis posterior, flexor digitorum and flexor hallucis 

must be located on the posterior surface of the tibia (Figure 11) in a specific order. The tibialis 

posterior should be the most medial and the flexor hallucis the most lateral, with flexor 

digitorum between them. 

 

 tib_ant_side via 1  Tibialis 

Anterior  

 ext_hal_side via 1  Extensor 

Hallucis 

 ext_dig_side via 1  Extensor 

Digitorum 

 

As with the posterior via points, the 

anterior points must also be ordered. 

Facing in the anterior view, the tibialis 

anterior should be the most medial and the 

extensor digitorum should be the most 

lateral with the extensor hallucis between 

them (Figure 12). 

 

 per_brev_side (via 1 & 2)  Peroneus Brevis 

 per_long_side (via 1 & 2)  Peroneus Longus 

 

flex_dig_r via 1 

 

flex_hal_r via 1 

 

tib_post_r via 1 

Figure 11 - Right tibia, posterior view 

tib_ant_r via 1 

ext_dig_r via 1 

 

ext_hal_r via 1 

Figure 12 - Right tibia, anterior view 
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The Peroneus Brevis (red) and 

Peroneus Longus (green) need to 

be arranged correctly on the fibula. 

In real anatomy, the two tendons 

run down the distal apex of the 

fibula and then cross each other 

(Figure 13). 

 

 rect_fem_r   Rectus 

Femoris 

 vas_int_r ins  Vastus 

Intermedius 

 vas_lat_r ins  Vastus 

Lateralis  

 vas_med_r ins  Vastus Medialis 

The Vastus mucles, which model the 

quadriceps group minus the Rectus 

Femoralis, insert onto the Patella and then 

transfer their force via the Patella tendon. As 

the patella is fixed with respect to the Tibia in 

this model, the Patella tendon is not modeled 

and the three muscles simply insert unpon 

the Patella in the order shown in the Figure 

14. 

 Calcaneus 

Points to be checked in calcaneus: 

 med_gas_side ins  Medial 

Gastrocnemius 

 lat_gas_side ins  Lateral 

Gastrocnemius 

 soleus_side ins  Soleus 

The insertion points for the triceps surae are 

distributed on the cross section of the Achilles’ 

tendon as shown in Figure 15.  

 tib_post_side via 2  Tibialis Posterior 

 flex_dig_side (via 2 & 3)  Flexor 

Digitorum 

vas_int_r ins 

vas_lat_r ins 

vas_med_r ins 

Figure 14– Right patella, anterior view 

rect_fem_r ins 

per_brev_r via 1 

per_long_r via 1 

per_long_r via 2 

per_brev_r via 2 

Figure 13 - Right tibia/fibula, posterior view 

med_gas_r ins 

lat_gas_r ins 

soleus_r ins 

Figure 15 - Right Calcaneus, posterior view 
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 flex_hal_side (via 2 & 3)  Flexor Hallucis 

 per_brev_side via 3  Peroneus Brevis 

 per_long_side (via 3, 4 & 5)  Peroneus Longus 

 ext_dig_side via 2  Extensor Digitorum 

 ext_hal_side via 2  Extensor Hallucis  

6 Creating an OpenSim Model 

 Bodies 

1) To create an OpenSim model, select the following icon from the top toolbar in 

NMSBuilder: . 

2) A new blank branch will now be created at the base of the data tree. To add bodies to 

the model select the ‘OpenSim Model’ branch and then the ‘Create Body’ ( ) icon 

from the toolbar and select the folder for the desired body section from the pop-up 

menu. 

 Inertial properties 

For building the dynamic model, it is important that inertial properties are computed. This is 

done by incorporating two different ‘densities’ in the model, one for soft tissue (muscles, 

tendons, fat, skin etc…) and one for bones. By selecting each body of the ‘OpenSim Model’ 

tree, the ‘VME’ tab in the control panel can be used to edit each segment density according 

to the values in Table II. 

Table II – Values of the tissue density as reported in White et al., 1989 [7]     

 

 

 

 

 Joints 

1) Select the ‘pelvis Body’ section from the OpenSim data tree and then the ’Create Joint’ 

( ) icon from the OpenSim toolbar.  

2) Select ‘Type’ > ‘Custom Joint’ from the top drop-down menu. 

3) Tick the ‘Use ground as parent’ option. 

4) Select ‘Child Body’ option and then ‘pelvis Body’ body from the OpenSim tree in the 

pop-up menu. 

 
Density 

TISSUE MALE FEMALE 

Bone 1.42E-06 1.42E-06 

Soft tissue 1.03E-06 1.02E-06 

Negative soft tissue -1.03E-06 -1.02E-06 
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5) Set the ‘Ref. Sys. In Child option to ‘ground_pelvis_child’ under the ‘ground_pelvis’ 

reference system file in the main data tree. 

6) Select ‘Ok’  

Repeat this process for each OpenSim body on both sides with the options in Table III for 

each joint. 

 

 

 Surface Markers 

1) Select ‘pelvis Body’ from the OpenSim data tree and then ‘Create MarkerSet’ ( ) icon 

from the toolbar. 

2) Select ‘Landmark Cloud’ and navigate to the Surface Markers landmark cloud for the 

pelvis geometry. 

3) Make sure the ‘Marker Set Body’ is set to the correct body (e.g. ‘pelvis’). 

4) Select ‘Ok’. 

Repeat this process for each OpenSim Body except the ‘Talus Body’ (as there is no specific 

surface marker set for this body), selecting the surface marker landmark cloud that 

corresponds to that body.  

 Muscles 

1) Navigate through ‘Operations’ > ‘Create’ > ‘OpenSim’ > ‘Auto Create Muscles’. 

2) Wait for the OpenSim muscles to automatically be created and then visually inspect 

the results before exporting the OpenSim model. 

 Exporting the OpenSim Model 

The OpenSim model can now be exported from NMSBuilder by selecting the ‘OpenSim Model’ 

root in the data tree and then selecting the ‘Export OpenSim Model’ ( ) icon from the toolbar.  

Save the model with an appropriate name in the ‘5_OpenSim’ folder.  

Table III – Definition of lower limb joints in the OpenSim model   

 hip knee ankle subtalar mtp 

Type Ball Joint Pin Joint Pin Joint Pin Joint Pin Joint 

Parent Body pelvis femur_side tibia_side  talus_side  calcn_side  

Ref. Sys. In Child hip_side_parent knee_side_parent ankle_side_parent subtalar_side mtp_side 

Child Body femur_side  tibia_side  talus_side  calcn_side  toes_side  

Ref. Sys. In Child hip_side_child knee_side_child ankle_side_child subtalar_side mtp_side 
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 Update of joint coordinates name and rotations order 

The model exported from NMSBuilder, depending on the version of the software, may include 

automatically generated names for joints and joint coordinates. Moreover, the default rotation 

order will be XYZ, which for our modelling conventions would be ab/adduction, 

internal/external rotation, flexion/extension. It is common practice in biomechanics to use a 

ZXY rotation order (flexion/extension, ab/adduction, internal/external rotation) to describe 

three-dimensional joint rotations. The MATLAB script “upd_model_coords.m” (located in 

“Matlab Functions” folder) allows to modify the names of the joint coordinates, their range of 

motion and the order of the rotations so that they match the coordinate nomenclature of the 

OpenSim model gait2392 and the kinematic recommendations of the International Society of 

Biomechanics.  

7 Definition of conditional via points in OpenSim  

Depending on the bone geometries and bone definitions, sometimes it will be necessary to 

define, in the muscle actuators included in the OpenSim model, conditional via points. 

Conditional via points are like normal via points used in musculoskeletal models, but they are 

active only within ranges of values of a specified generalized coordinate. They are useful to 

avoid penetration between muscle paths and bone geometries but often they need to be 

manually defined. 

In the lower limb models, we often included via points in the definition of the following muscles: 

1) Gastrocnemius lateralis and gastrocnemius medialis: to avoid compenetration with 

the proximal tibia and the calcaneus  

2) Vastii: to avoid compenetration with the patellar groove 

3) Hamstrings: to implement a muscle path similar to gait2392 for increasing knee 

flexion. 

4) Iliacus and psoas: to avoid underestimation of muscle moment arms at high hip flexion 

angles. 

8 Quality check 

 Experimental data 

1) Medical images: all the bones, soft tissue and muscles tissue must be visible and in 

the field of view to allow correct segmentation and definition of muscles paths; gait 

markers must be visible in the images to allow the correct registration of the images 

with gait data 

2) Gait analysis data must be evaluated based on objective criteria, e.g. number of visible 

markers in the frames of interest and trajectories noise level, by an experienced 

operator; 

If quality tests are not passed, the model cannot be built, however an incomplete dataset 

can be adapted if the minimum requirements are met. 
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 Post processing 

Geometries fitting:  

1) After the fitting algorithm has been run, residuals are calculated to evaluate the 

goodness of the fit. 

2) The fitted analytical shapes are imported into NMSBuilder and a visual checks ensure 

good agreement with the fitted bones geometries. 

 

 Model building 

Muscles paths: 

1) A visual check is performed to assess the quality of the supervised atlas registration 

superimposing the muscles paths (defined as active lines in NMSBuilder) onto the 

medical images. If good match is not achieved, then muscles attachments and via 

points are updated to follow the subject’s individual muscle shape. 

2) A further comparison with anatomical atlases and the generic model gait2392, enables 

muscle paths being not visible in the MRI imaging to be identified. 

 Dynamic simulations 

Inverse kinematics: 

1) Tracking errors computed from the OpenSim IK tool are evaluated against error limits 

recommended in simulation best practices by Hicks et al., 2015 [8] 

 
Static optimization: 

1) Predicted muscle forces are checked for unrealistic tetanic activations. 

2) Coordinate actuator contributions are quantified and verified to stay within the limits 

indicated in simulation best practices by Hicks et al., 2015 [8] 

NB: Additional checks on the simulation quality, e.g. pelvis residual analysis to test the model 

dynamic consistency, are not applicable to the mono-lateral models employed in this study.  

 

9 Feedback – help us improving 

Please report any inaccuracy or imprecision in this document to:  

- Erica Montefiori: e.montefiori@sheffield.ac.uk 
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Table AII- 1 - Inter-operator repeatability of muscle segmentation for three subjects enrolled in the study. Individual muscle values have been reported 
for each subject and each operator with corresponding mean, standard deviation (SD) and coefficient of variation (CoV). Root mean square error across 

the three subjects was calculated as well. 

 Subj1 volumes [cm2]    Subj2 volumes [cm2]    Subj3 volumes [cm2]     

Muscles OP1 OP2 OP3 Mean SD CoV OP1 OP2 OP3 Mean SD CoV OP1 OP2 OP3 Mean SD CoV RMSE 

Adductor brevis          65.5 48.3 55.4 56.4 8.6 15.3 48.2 59.6 56.0 54.6 5.8 10.6 61.4 79.1 50.3 63.6 14.5 22.8 9.6 

Adductor longus 75.9 95.6 108.7 93.4 16.5 17.7 66.8 78.7 71.7 72.4 6.0 8.3 81.1 91.6 77.6 83.4 7.3 8.8 9.9 

Adductor magnus       291.2 316.1 294.7 300.7 13.5 4.5 313.3 329.4 352.3 331.7 19.6 5.9 322.2 352.2 346.8 340.4 16.0 4.7 16.3 

Biceps femoris caput breve 51.5 42.2 46.9 46.9 4.6 9.9 87.2 82.7 84.9 84.9 2.2 2.6 61.9 60.5 61.2 61.2 0.7 1.2 2.5 

Biceps femoris caput longum 131.7 143.7 143.2 139.5 6.8 4.8 119.6 135.0 124.8 126.5 7.8 6.2 110.7 120.8 104.0 111.9 8.5 7.6 7.7 

Gluteus maximus       561.4 617.1 592.2 590.2 27.9 4.7 409.1 447.4 469.9 442.1 30.7 6.9 574.1 559.7 577.3 570.4 9.4 1.6 22.7 

Gluteus medius          236.8 257.8 271.7 255.4 17.6 6.9 208.7 220.1 255.1 228.0 24.2 10.6 256.7 293.9 262.7 271.1 20.0 7.4 20.6 

Gluteus minimus            62.1 75.3 67.1 68.2 6.7 9.8 56.9 64.5 75.9 65.7 9.6 14.6 33.6 42.9 37.3 37.9 4.7 12.3 7.0 

Gracilis    48.1 52.7 57.3 52.7 4.6 8.7 40.6 40.4 39.3 40.1 0.7 1.7 43.3 52.5 38.2 44.7 7.2 16.1 4.2 

Iliacus                     109.0 119.5 123.7 117.4 7.6 6.4 123.4 119.2 138.4 127.0 10.1 8.0 117.1 112.1 125.6 118.3 6.8 5.8 8.2 

Psoas                        97.1 108.6 99.4 101.7 6.1 6.0 70.1 78.7 76.1 75.0 4.4 5.9 51.6 57.6 49.7 53.0 4.1 7.7 4.9 

Rectus femoris               103.7 101.1 110.1 105.0 4.6 4.4 123.6 135.7 138.8 132.7 8.1 6.1 132.3 152.2 144.4 143.0 10.0 7.0 7.6 

Sartorius                    77.7 90.2 95.1 87.7 8.9 10.2 69.0 77.2 71.7 72.6 4.2 5.7 96.9 98.5 88.9 94.8 5.1 5.4 6.1 

Semimembranosus              165.2 163.8 167.0 165.3 1.6 1.0 157.0 167.4 163.1 162.5 5.2 3.2 88.2 108.5 94.5 97.1 10.4 10.7 5.7 

Semitendinosus               81.8 92.5 87.9 87.4 5.4 6.1 118.5 130.6 120.0 123.0 6.6 5.4 109.4 119.5 104.5 111.2 7.6 6.9 6.5 

Tensor fasciae latae         33.9 43.2 41.4 39.5 4.9 12.4 28.9 32.5 33.3 31.5 2.3 7.4 41.3 48.5 45.1 45.0 3.6 7.9 3.6 

Vastus intermedius           251.6 266.3 272.4 263.4 10.7 4.1 233.9 250.2 233.9 239.3 9.4 3.9 199.6 223.5 225.1 216.0 14.3 6.6 11.5 

Vastus lateralis             321.1 326.0 326.4 324.5 2.9 0.9 286.4 348.2 328.3 321.0 31.5 9.8 303.0 335.4 339.2 325.8 19.9 6.1 18.1 

Vastus medialis              182.0 195.9 196.2 191.3 8.1 4.2 208.1 206.8 206.5 207.1 0.8 0.4 205.6 207.0 201.2 204.6 3.0 1.5 4.0 

Extensor digitorum longus    32.9 44.6 50.5 42.7 8.9 21.0 33.3 41.5 24.9 33.2 8.3 25.0 36.4 53.1 34.1 41.2 10.4 25.3 9.2 

Extensor hallucis longus     25.9 36.8 29.2 30.6 5.6 18.4 46.1 19.3 15.3 26.9 16.8 62.4 33.0 24.5 34.2 30.6 5.3 17.3 9.2 

Flexor digitorum longus      24.9 26.2 16.6 22.6 5.2 23.0 23.7 17.2 11.0 17.3 6.4 36.7 21.7 28.0 20.6 23.4 4.0 17.0 5.2 

Flexor hallucis longus       54.9 64.0 63.1 60.7 5.0 8.2 61.6 40.9 40.8 47.7 12.0 25.2 59.6 51.2 61.3 57.4 5.4 9.4 7.5 

Gastrocnemius lateralis      96.5 99.5 95.8 97.2 2.0 2.0 59.9 60.3 65.0 61.7 2.8 4.6 97.8 102.8 99.4 100.0 2.5 2.5 2.4 

Gastrocnemius medialis       179.0 187.7 184.5 183.7 4.4 2.4 139.2 146.5 149.2 145.0 5.1 3.5 147.5 158.0 160.6 155.4 6.9 4.5 5.5 

Peroneus brevis              18.6 20.8 43.3 27.6 13.6 49.4 32.7 29.9 31.8 31.5 1.4 4.4 33.6 42.8 55.4 43.9 11.0 25.0 8.7 

Peroneus longus              37.6 42.9 14.3 31.6 15.2 48.2 25.4 24.0 21.5 23.6 2.0 8.3 39.4 36.4 23.2 33.0 8.6 26.1 8.6 

Soleus                       346.3 373.0 369.0 362.8 14.4 4.0 297.3 345.1 347.9 330.1 28.4 8.6 338.1 341.0 347.1 342.1 4.6 1.3 15.8 

Tibialis anterior            110.6 100.6 116.6 109.3 8.1 7.4 82.2 120.9 138.5 113.9 28.8 25.3 83.1 119.1 88.6 96.9 19.4 20.0 18.8 

Tibialis posterior           76.2 70.9 81.4 76.2 5.2 6.9 60.9 72.4 77.4 70.2 8.5 12.1 65.8 81.1 68.4 71.7 8.2 11.4 7.3 
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Table AII- 2 – Individual muscle volumes for right limb of the eleven subjects enrolled in the study  

 
Right volumes [cm2]  

Subj1 Subj2 Subj3 Subj4 Subj5 Subj6 Subj7 Subj8 Subj9 Subj10 Subj11 
Gluteus maximus       606.1 786.2 653.7 474.1 646.3 469.2 405.6 514.9 617.7 593.2 777.0 
Gluteus medius          250.8 257.1 284.0 195.9 237.2 232.6 196.8 183.0 251.3 285.1 419.0 
Gluteus minimus            36.3 52.3 80.1 42.4 48.0 66.1 45.8 55.3 80.9 40.9 75.0 
Adductor brevis          61.2 61.8 77.8 46.7 58.5 69.4 58.4 38.6 56.8 54.2 70.7 
Adductor longus 69.6 83.4 59.7 72.1 69.0 117.2 66.2 69.9 79.0 91.7 89.7 
Adductor magnus       447.7 396.2 378.6 317.2 323.6 370.4 324.0 294.2 335.6 281.5 498.4 
Iliacus                     81.8 127.0 107.4 101.1 110.0 110.8 127.4 104.8 118.2 124.1 164.6 
Biceps femoris caput longum 127.7 123.0 121.7 92.9 78.2 96.5 119.1 89.8 135.3 95.3 140.5 
Biceps femoris caput breve 52.2 40.9 73.2 31.5 50.7 60.4 80.7 34.6 57.1 68.6 77.1 
Semimembranosus              122.0 151.2 126.2 103.8 97.7 107.8 153.7 107.1 154.5 98.9 125.1 
Semitendinosus               71.6 142.1 92.6 94.7 102.2 140.4 101.3 63.1 88.8 88.5 136.6 
Rectus femoris               114.7 68.7 111.7 94.0 113.3 151.0 127.2 141.3 113.3 125.3 156.8 
Vastus intermedius           221.6 352.6 295.4 255.8 257.9 283.5 277.2 255.8 272.3 229.8 329.0 
Vastus lateralis             303.5 392.6 351.8 293.1 245.1 306.6 326.8 259.9 349.6 328.3 499.2 
Vastus medialis              167.4 207.9 267.9 223.9 202.9 241.2 225.7 220.2 208.9 178.2 266.8 
Gracilis    36.2 76.1 43.2 16.9 44.7 53.6 47.8 34.2 47.6 37.6 67.5 
Sartorius                    60.0 93.2 105.3 64.0 84.7 90.7 63.1 50.9 85.8 101.7 165.7 
Tensor fasciae latae         46.3 52.9 49.5 17.4 34.4 33.2 36.1 57.8 36.0 57.9 45.6 
Gastrocnemius lateralis      87.2 85.3 80.3 67.3 47.9 63.7 63.7 86.3 68.9 81.4 96.9 
Gastrocnemius medialis       141.1 185.0 175.8 131.8 131.2 134.4 156.9 143.4 188.4 122.9 225.7 
Soleus                       306.0 401.0 405.9 323.4 257.7 285.7 304.7 266.9 360.4 328.1 502.6 
Tibialis anterior            82.7 103.7 94.2 78.8 89.0 78.2 74.4 110.6 109.9 88.9 135.5 
Extensor digitorum longus    21.5 33.9 54.6 44.2 20.8 14.9 30.1 36.9 42.8 31.4 40.6 
Extensor hallucis longus     26.1 34.5 37.3 13.0 18.8 30.0 49.1 32.6 32.9 29.8 41.3 
Flexor digitorum longus      18.4 25.6 24.9 20.1 14.3 22.9 17.9 28.9 19.7 15.2 26.3 
Flexor hallucis longus       29.4 45.6 51.7 64.0 43.3 82.3 53.2 48.6 65.3 39.3 51.9 
Peroneus brevis              40.1 41.2 41.6 33.7 29.4 33.0 38.8 33.6 24.6 40.9 38.6 
Peroneus longus              34.3 39.7 59.0 34.0 36.4 29.8 25.7 29.5 39.2 35.1 53.4 
Tibialis posterior    65.8 87.2 90.6 89.0 57.7 73.2 56.3 86.5 68.4 72.7 109.1 
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Table AII- 3 – Individual muscle volumes for the left limb of the eleven subjects enrolled in the study 

 
Left volumes [cm2]  

Subj1 Subj2 Subj3 Subj4 Subj5 Subj6 Subj7 Subj8 Subj9 Subj10 Subj11 
Gluteus maximus       583.4 736.2 606.5 434.5 586.5 454.0 409.1 441.1 561.4 574.1 749.8 
Gluteus medius          198.0 256.6 297.4 200.6 188.2 268.0 208.7 165.9 236.8 256.7 345.8 
Gluteus minimus            53.2 68.6 79.5 47.9 28.3 62.3 56.9 39.2 62.1 33.6 90.4 
Adductor brevis          58.5 50.4 74.6 48.5 52.8 72.3 48.2 41.9 65.5 61.4 67.0 
Adductor longus 62.2 84.4 79.9 70.3 76.3 101.1 66.8 72.9 75.9 81.1 88.0 
Adductor magnus       449.2 336.1 349.3 318.2 320.6 296.8 313.3 228.8 291.2 322.2 402.1 
Iliacus                     94.9 129.8 108.6 106.4 105.1 102.1 123.4 94.7 109.0 117.1 136.3 
Biceps femoris caput longum 116.4 132.9 133.7 84.7 55.3 104.0 119.6 85.9 131.7 110.7 136.2 
Biceps femoris caput breve 42.8 37.0 69.6 39.8 68.4 52.0 87.2 39.9 51.5 61.9 58.0 
Semimembranosus              124.4 148.8 149.1 116.1 86.3 115.4 157.0 104.0 165.2 88.2 122.7 
Semitendinosus               87.2 154.5 82.5 103.2 84.1 126.3 118.5 57.2 81.8 109.4 128.8 
Rectus femoris               115.9 128.0 115.5 102.6 101.3 157.6 123.6 117.7 103.7 132.3 131.0 
Vastus intermedius           237.2 342.1 305.5 257.8 263.6 242.9 233.9 251.5 251.6 199.6 255.3 
Vastus lateralis             293.8 365.0 308.7 286.2 256.8 295.8 286.4 227.6 321.1 303.0 393.6 
Vastus medialis              171.9 182.7 242.6 259.6 232.4 223.1 208.1 187.4 182.0 205.6 198.2 
Gracilis    37.3 58.1 55.0 31.9 28.3 52.7 40.6 26.7 48.1 43.3 68.0 
Sartorius                    51.7 76.1 72.3 53.6 78.6 82.4 69.0 50.5 77.7 96.9 152.2 
Tensor fasciae latae         34.4 52.5 51.7 21.9 31.5 32.3 28.9 68.6 33.9 41.3 52.2 
Gastrocnemius lateralis      80.7 66.1 55.8 61.6 60.6 67.6 59.9 83.2 96.5 97.8 100.1 
Gastrocnemius medialis       146.4 177.8 188.8 159.7 145.5 144.2 139.2 139.7 179.0 147.5 227.9 
Soleus                       285.5 368.6 375.9 367.9 277.0 291.2 297.3 264.3 346.3 338.1 516.0 
Tibialis anterior            99.7 96.1 101.6 88.1 85.3 75.9 82.2 100.1 110.6 83.1 114.1 
Extensor digitorum longus    34.5 25.9 50.0 46.3 28.5 21.6 33.3 25.9 32.9 36.4 59.4 
Extensor hallucis longus     21.6 37.4 32.1 11.4 19.3 27.0 46.1 31.0 25.9 33.0 44.6 
Flexor digitorum longus      20.4 28.9 23.1 20.9 21.6 20.8 23.7 31.7 24.9 21.7 32.1 
Flexor hallucis longus       36.0 44.8 45.0 40.2 48.6 82.0 61.6 40.8 54.9 59.6 63.1 
Peroneus brevis              29.7 35.7 36.5 56.9 27.5 41.8 32.7 23.9 18.6 33.6 34.3 
Peroneus longus              24.5 37.7 47.7 34.3 48.0 24.2 25.4 24.4 37.6 39.4 56.4 
Tibialis posterior    72.2 80.8 84.2 84.3 57.3 75.8 60.9 77.7 76.2 65.8 111.1 
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Figure AII- 1 - Mean±SD of the tendon slack length for the left and right muscles personalised in 
the SSp model and percentage difference between Hyb and SSp (* p<0.05, **p<0.01). Individual 
percentage difference is reported as a bar plot where each bar represents a participant: green 
positive (orange negative) values show that the tendon slack length in the Hyb model is bigger 

(smaller). DFs and PFs stand for dorsi and plantar flexors, respectively. 
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Figure AII- 2 - Mean±SD of the optimal fibre length for the left and right muscles personalised in 
the SSp model and percentage difference between Hyb and SSp (* p<0.05, **p<0.01). Individual 
percentage difference is reported as a bar plot where each bar represents a participant: green 
positive (orange negative) values show that the optimal fibre length in the Hyb model is bigger 

(smaller). DFs and PFs stand for dorsi and plantar flexors, respectively. 
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